
Ideal para todos aqueles que utilizam computadores Macintosh.
Linguagem imples e Clara. Mais de 280 ilustrações.

    

O 1º Manual do Macintosh em português
com suporte na Internet

Abrange os Sistemas 8 a 9
Notas Quentíssimas Sobre o Mac OS X

Misael Batista do Nascimento

Manual do Pokaprática

Um guia simples
e completo do Mac OS



Misael Batista do Nascimento

Manual do Pokaprática
UUUmmm   GGGuuuiiiaaa    SSSiiimmmppp llleeesss   eee

CCCooommmppp llleeetttooo   ddd ooo   MMMaaa ccc    OOOSSS

O 1º Manual de Macintosh em português
Com suporte na Internet

(http://macmanual.ushs.com)
— Abrange os Sistemas 888 e 999 —

Inclui Notas Quentíssimas
Sobre o MMMaaaccc   OOOSSS   XXX



Dedicatória
A João e Roberta, meus queridos.
A Mirian, Ana Carolina e Bruna;

eternamente amadas.
Soli Deo Gloria.



SUMÁRIO — V

Sumário
Prefácio 1
Introdução 3

Capítulo 01: Conhecendo o Básico 5
O Sistema Operacional 5
Inicialização, Reinicialização e Desligamento do
Macintosh

5

O Finder 7
Arquivos e Ícones 7
Aliases ou Réplicas 9
Clicando, Arrastando e Soltando com o Mouse 10
O Verdadeiro Sistema de Janelas 11
Janelas Pop-Up 15
Pastas Automáticas 16

Capítulo 02: Conhecendo a Mesa do Macintosh 19
A Tela Básica do Macintosh 19
A Barra de Menus 20
Disco Rígido Fácil 20
A Lixeira do Mac 21
O Control Strip 23

Capítulo 03: Conhecendo o Apple Menu 25
About This Computer 25
Apple System Profiler 26
AppleCD Audio Player 27
Automated Tasks 28
Ferramentas de Cálculo 28
Jigsaw Puzzle 28
Recent Applications e Recent Documents 28
O Chooser 29
Key Caps 30
Ferramentas de Anotações 30
Scrapbook 32
SimpleSound 32
Control Panels 33
Favorites 33
Internet Access 33
Network Browser 33
Remote Access Status 34
O Sherlock 34

Capítulo 04: Conhecendo o Menu File 39
Atalhos do Menu File 39
Criando Novas Pastas 39
Abrindo Pastas e Lançando Aplicativos 41
Impressão Rápida 41
Movendo Arquivos Para o Lixo 42
Fechando Janelas 42
Utilizando o Get Info 42
Duplicando Arquivos 49
Criando Réplicas 49
Adicionando Itens à Pasta Favorites 49
Retornando Objetos da Lixeira 50
Protegendo Arquivos dos “Curiosos” 50



VI — MANUAL DO POKAPRÁTICA

Procurando Coisas 51
Procurando Coisas… Na Internet 51
Localizando Originais 51
Configurando Páginas Para Impressão 51
Imprimindo a Mesa ou o Conteúdo de Janelas 51

Capítulo 05: Conhecendo o Menu Edit 55
Atalhos do Menu Edit 56
Copiando e Colando 56
Armazenando Conteúdos na Área de Transferência 57
Desfazendo Ações 57
A Função Clear 58
Alterando Preferências do Finder 59
Selecionar Tudo 61

Capítulo 06: Conhecendo o Menu View 63
Usando o Menu Contextual 63
Organizando Janelas 64
Visualizando como Ícones 66
Visualizando como Botões 66
Visualizando como Lista 67
Alterando Formas de Ordenação e Colunas 67
Reset Column Positions 69
Criando e Desativando Janelas Pop-Up 70

Capítulo 07: Conhecendo Outros Menus 71
O Menu Special 71
O Menu Help 74
Menu de Teclados 76
Menu Aplicativos 76
A Palete Application Switcher 77

Capítulo 08: Trabalhando com Aplicativos 79
Lançando Aplicativos 79
Criando Documentos 81
Salvando Documentos 82
Editando Documentos 84
Imprimindo Documentos 85
Fechando Documentos 87
Fazendo Backup de Documentos 88

Capítulo 09: Preparando-se Para a Internet 93
Algumas Informações Básicas Sobre a Internet 93
Configurando o Sistema Para a Web 94
Configure o Remote Access 97
Configure o Painel Internet 98
Configure os Navegadores 98
Configure os Programas de E-mail 102

Capítulo 10: Os Painéis de Controle e as Extensões do Macintosh 105
Informações Preliminares 105
Alguns Painéis Importantes 106
Algumas Extensões Importantes 107
Configurando Alguns Painéis 108
Painéis e Extensões Diferentes 114
Os Conflitos de Extensões 114
Trabalhando com Definições 115
Alguns Cuidados Necessários 117

Capítulo 11: Algumas Coisas Úteis 119
Instalando e Desinstalando Programas 119



SUMÁRIO — VII

Fotografando o Macintosh 120
Formatando o Disco Rígido 121
Personalizando o Macintosh 122
Reconstruindo o Desktop 125
Lançamentos Automáticos 126

Capítulo 12: Alguns Problemas e Soluções 127
Consertando Réplicas 127
Erros de Aplicativos 128
Congelamentos de Tela 130
Leia os Manuais 132

Capítulo 13: Breve Vocabulário 133
Lista de Termos Relevantes 133
Índice Remissivo 137
Bibliografia 143



PREFÁCIO — 1

Prefácio
omo usuário do Mac OS desde 1996, tenho experimentado na pele a dificuldade de acesso
a informações em português sobre este Sistema. Fui forçado a adquirir livros de versões
antigas, coletar dados da Internet, ler e traduzir textos de outros autores e tutoriais da

própria Apple e ainda buscar socorro nos amigos, todas as vezes em que surgiam problemas —
só para compreender, mesmo que um pouquinho, a máquina que eu havia adquirido. E tudo isso
debaixo da pressão do universo Windows/PC, que oferecia tudo — tudinho mesmo em
português, ali na loja da esquina, a preço de banana.

Mas eu permaneci firme, e hoje já estou no meu quinto Mac, satisfeito toda vida.

Loucura? Fanatismo? Por quê um usuário Macintosh se submete a tudo isso? O quê nos leva
a utilizar uma plataforma minoritária (se bem que essa “minoria” hoje soma quase 70 milhões de
usuários em todo o mundo), enfrentando todos os desgastes de maiores custos de hardware,
software e limitação de suporte?

Várias argumentações técnicas podem ser feitas — todas com excelente embasamento
teórico, mostrando que o Mac OS é superior a outros sistemas operacionais de uso doméstico. A
leitura de periódicos de informática, revistas especializadas ou páginas da Internet é suficiente
para que armazenemos dezenas de análises e testes que comprovam essa afirmação.

No entanto, existe outra razão , muito mais subjetiva, para o uso do Macintosh. Trata-se de
paixão. A relação dos usuários de Macs com seus computadores é visceral a tal ponto, que eles
são chamados de macmaníacos. São pessoas especiais, que assumem suas preferências sem estar
presas às grandes tendências do mercado. Gente criativa, intuitiva e inteligente. Seres humanos
que pensam diferente.

Para tais pessoas, escrevi o Manual do Pokaprática, o primeiro livro sobre o Mac OS em
português, feito por um brasuca com cara de índio e tudo.

“Pokaprática” é o termo utilizado para designar os novos ou inexperientes usuários do
Macintosh. “Profiça” é o usuário avançado, conhecedor de todas (ou quase todas) as manhas do
Sistema Operacional do Mac. Meu objetivo é auxiliar você a iniciar sua jornada, cruzando os
limites do “pokaprática” rumo ao incrível universo do macmaníaco “profiça”. É possível. É fácil.
E sobretudo, é muito divertido.

Agradeço primeiramente a Deus, que criou as maçãs, o pessoal da Apple e me capacitou
para essa tarefa. Depois, à incrível equipe que publica a Macmania, excelente revista brasileira.
Eu não teria chegado até aqui sem seus artigos preciosos e as dicas úteis de diversos leitores. Sem
eles talvez esse livro tivesse uma cinco páginas, e olhe lá…

O Rubem Amorese e o Adalmyr Morais Borges, amigos macmaníacos, me ajudaram muito,
compartilhando dicas e informações.

Agradeço também à minha família, que me deu o maior incentivo, e à Lucineide Gonçalves,
usuária pokaprática que testou todos os exercícios desse livro, e disse que gostou!

A todos vocês, minha sincera gratidão.

O autor.

C
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Introdução
ste livro se destina a todos os usuários domésticos de computadores Macintosh,
principalmente aqueles que possuem máquinas rodando os sistemas 8.5, 8.6 e 9. Os donos
de equipamentos com o Mac OS 8, também serão beneficiados com a leitura deste manual

e poderão ser estimulados a atualizar seus computadores para desfrutar dos novos recursos.

Os macmaníacos medianos e até avançados irão obter aqui alguma coisa útil, nem que seja
relembrar truques do “arco da velha”. E além disso eu preciso vender o livro… Por isso,
macmaníacos brasileiros, “uni-vos e comprai!”.

O Manual do Pokaprática é um livro sobre o Sistema. Publicações sobre softwares
aplicativos existem no mercado. Outros livros virão. Quem sabe um Manual do AppleWorks e
coisas assim (quem viver, verá).

Você tem em mãos um livro diferente em termos de metodologia. Ele explica todos os
aspectos básicos de uso do Sistema utilizando uma abordagem via menus. Quando comprei meu
primeiro Mac, ficava “fuçando” os menus tentando descobrir “pra que serve isso?”. As respostas
encontram-se no Manual do Pokaprática.

Pelo que sei, esse é o primeiro manual em português sobre o Mac OS escrito por um
brasileiro. Espero estar contribuindo para a popularização da plataforma da maçã em terras
tupiniquins.

Quando um índio caeté resolve escrever sobre um sistema operacional desenvolvido nos
Estados Unidos, encontra um obstáculo difícil de transpor: a ausência de uma versão na língua
brasileira, amplamente divulgada e eficiente. E mesmo com o lançamento do OS 9 em português,
muitos ainda optam por usar o Sistema em inglês. Isso gera algumas pequenas dificuldades de
linguagem. Tive de tomar decisões difíceis, arbitrando possíveis traduções ou trabalhando com
duas identificações. Eu deveria falar de aliases ou réplicas? Desktop ou Mesa? Janelas pop-up ou
janelas locais? Control Strip ou Barra de Controle? Submenus ou Menus Hierárquicos? Chooser
ou Seletor? Labels ou Etiquetas? Isso foi demais para meu cérebro de iogurte desnatado. Mas
acho que consegui escrever um texto claro. O leitor é quem vai julgar.

Existem muitos recursos comuns a todos os sistemas, enquanto outros
são exclusivos de determinada versão. Faço questão de alertar para essas
diferenças introduzindo figuras junto ao fluxo do texto, tal como no
exemplo ao lado. Além disso, os capítulos estão salpicados de referências
ao Mac OS X, baseado no Darwin, o novo kernel revolucionário da Apple.

Evitei citar as pequenas atualizações do Sistema. Isso quer dizer que as explicações sobre o
Mac OS 8, abrangem o update 8.1. Notas sobre o Mac OS 8.5 abrangem as versões 8.5.1 e 8.6
(apesar desta última ter introduzido alterações significativas no microkernel do Macintosh).

Ao comentar os recursos do Mac OS X, escrevi no início do segundo semestre de 2000,
sobre um produto ainda não lançado. Algumas das inovações anunciadas para o Sistema podem
não fazer parte da versão final. Por favor, não me culpem por isso. Além disso, o OS X pode
definir algumas alterações na forma de operação do Mac que não estão listadas no Manual do
Pokaprática. A próxima edição, com certeza, atualizará todas as informações.

Utilize o suporte gratuito pela Internet. Você conta com o apoio do site do Manual do
Pokaprática (http://macmanual.ushs.com), onde encontra o texto integral nos formatos PDF e
HTML, downloads de programas, dicas de sites e tira-dúvidas gratuito. Preencha o cartão de
registro e envie pelo correio (ou cadastre-se na seção “Registro”, do site do Manual). Escreva
solicitando informações, dando dicas ou mesmo criticando aspectos do material que precisam ser
revisados ou melhorados. Numa próxima edição, citarei os nomes dos colaboradores e enviarei,
por e-mail, as atualizações dos capítulos aos leitores cadastrados.

E



4 — MANUAL DO POKAPRÁTICA

Caso você tenha dúvidas sobre o significado de alguma palavra, consulte o Capítulo 13 do
livro, que contém uma lista de alguns termos relevantes. Não é nenhum dicionário de
informática, mas quebra um galho. Outras consultas poderão ser feitas via e-mail
(misael@macmanual.ushs.com). Eu responderei com prazer.

Eu sei que poderia ter aprofundado alguns temas tais como a criação e uso de AppleScripts
e configuração e uso do Mac em rede. Espero fazer isso em outra obra, talvez já abordando o
Mac OS X, quem sabe em 2001. O usuário doméstico dificilmente trabalhará com scripts ou
redes. No momento, entendo que com o Manual do Pokaprática estou atendendo às maiores
necessidades (em termos de informação sobre o Sistema) dos novos usuários de Macintosh do
Brasil.

Saudações macmaníacas.
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01
Conhecendo o Básico

objetivo deste capítulo é fornecer algumas informações essenciais, sem as quais você
poderá sentir-se meio perdido no trato com seu computador. Um dos méritos do
Macintosh é a sua facilidade de uso, mas isso decorre da absorção de alguns conceitos

fundamentais do funcionamento e modo de operação do Sistema.

O Sistema Operacional
Mac OS é a abreviação de Macintosh Operational System ou Sistema Operacional do

Macintosh. Todo computador usa um sistema operacional, que é um conjunto de programas que,
operando ao mesmo tempo, gerencia as memórias, discos rígidos e periféricos tais como
impressoras, scanners e unidades de CD/DVDs. É o Sistema Operacional que torna possível a
utilização dos softwares, programas aplicativos com os quais você realiza tarefas no computador.

Inicialização, Reinicialização e Desligamento do Macintosh
Além de ligar e desligar, você precisa de vez em quando reinicializar o Sistema (isso

também é chamado de “restartar” ou “dar um restart” no Mac).

Ligando o Macintosh
Para ligar o computador, aperte o botão Power (veja figuras abaixo). O Macintosh emitirá

um som indicando o início de sua atividade.

Dica: Os botões de ligar e desligar (Power) são representados por figuras diferentes nos
Macs antigos e nos iMacs ou iBooks.

Botão Power (iMacs ou iBooks): Situado no canto inferior direito do monitor do iMac, ou
canto superior direito do teclado do iBook.

Botão Power (outros Macs): Situado no canto superior direito do teclado do Macintosh.

Assim que o computador é ligado, o Sistema lhe dá as boas-vindas e você vê o
carregamento das Extensões e Painéis de Controle (aqueles ícones que vão surgindo no rodapé da
tela, abaixo do quadro com o logo sorridente do Mac OS). Extensões e Painéis de Controle são
programas ativados junto com o Sistema Operacional, responsáveis pela forma como sua
máquina trabalha. No Capítulo 10 você aprenderá mais sobre eles.

No Sistema 9, após o carregamento das Extensões e Painéis, surge
uma tela de login, solicitando a identificação do usuário, que além do
nome, é representado por um ícone. Após a seleção, o Sistema exige que
seja digitada uma senha de acesso (password).

O interessante é que várias pessoas podem usar a mesma máquina,
sem que uma interfira nas configurações e documentos da outra. Até mesmo as crianças poderão
usar o Macintosh utilizando o perfil de usuário de painéis. No Capítulo 11, você aprenderá como
configurar o computador para múltiplos usuários.

O
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A tela de login do Mac OS 9. Sem Senha, “ocê num” entra.

Desligando o Macintosh
Se você deseja manter em boa forma os seus arquivos, bem como o próprio Sistema

Operacional, é necessário aprender a desligar o computador corretamente. Isso pode ser feito de
duas formas:

1 Vá até o Menu Special e Selecione Shut Down.

2 Com o computador ligado, pressione o botão Power. Aparece um quadro de diálogo com
algumas opções de tarefas. Clique no botão Shut Down ou simplesmente aperte a tecla return. O
Mac é desligado.

Esse é o quadro de diálogo exibido quando você pressiona o botão Power.

Quando o computador é desligado desta forma, os programas ativos são correta e
automaticamente fechados. Caso hajam documentos abertos e não gravados, surgem quadros de
diálogos perguntando se você deseja salvá-los, antes que a máquina seja desligada. Além disso,
os discos que estiverem inseridos nos diversos drives são ejetados.

Reinicializando o Macintosh
Algumas vezes é necessário restartar o Macintosh. Isso pode acontecer, por exemplo, após a

instalação de um programa. Normalmente um quadro de diálogo do próprio instalador pergunta
se a reinicialização pode ser feita. Basta dar um OK, aguardar o reinício do Sistema e passar a
usar o novo software (veja mais informações sobre isso no Capítulo 11).
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Outras vezes, você tem que reinicializar a máquina devido a um conflito de Extensões (você
entenderá o que é isso no Capítulo 10), estrangulamento de memória ou erro de algum aplicativo
(mais detalhes sobre tais problemas e suas soluções serão discutidos no Capítulo 12). Em tais
casos, o Macintosh providencia janelas de aviso perguntando se você concorda com o restart.
Clique escolhendo restartar a máquina, para que o problema seja regularizado.

Para Restartar o Macintosh:

1 Selecione Menu Special › Restart.

2 Uma segunda forma é pressionar o botão Power. Na caixa de diálogo que surgir, clique no
botão Restart.

É possível que o problema gere o travamento de sua máquina. Ocorre então o congelamento
da tela. Essa é uma situação especial, que exige maneiras diferentes de reinicializar o
computador. Uma lista de algumas soluções está registrada no Capítulo 12.

O Finder
A alma do Mac OS é um programa chamado Finder, que implementa a maioria das tarefas

executadas: os diferentes modos de visualização, o tratamento com os diversos tipos de objetos,
os lançamentos de aplicativos, a impressão e muitas outras coisas.

O ícone do Finder na Pasta de Sistema

Ao ligar o Macintosh, o Finder é ativado automaticamente, aguardando seus comandos. No
Menu Aplicativos, situado no canto superior direito da Mesa, ele é percebido pelo ícone do Mac
OS feliz. Ao solicitar o desligamento da máquina, é o Finder quem providencia para que tudo
ocorra bem no processo de finalização das tarefas pendentes.

O Finder ativo, no Menu Aplicativos

As ações de arrastar e soltar, copiar e colar; a manutenção de diversos programas abertos ao
mesmo tempo; a gravação de arquivos, bem como todo o trabalho com a Lixeira ocorrem através
do Finder.

Essa atuação em background do Finder é tão eficaz que é comum falarmos do Finder e da
Mesa ou Desktop como sendo sinônimos (veja mais informações sobre a Mesa no Capítulo 02).

Esteja atento para as referências que serão feitas ao Finder, em todo o livro. Entenda-o como
o seu amigo de todas as horas.

Arquivos e Ícones
Cada item que você utiliza diariamente no Macintosh é um arquivo, guardado dentro do

disco rígido. Cada arquivo é representado por uma figura, também chamada de ícone. Os ícones
podem ser de três tipos: pastas, documentos ou programas.

Ícone de Pasta. Clique duas vezes sobre ele e a pasta se abre, revelando seu conteúdo.
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Ícone de documento. Clique duas vezes sobre ele e o documento se abre no aplicativo de origem,
possibilitando sua leitura, edição e impressão.

Ícone de programa. Clique duas vezes sobre ele e o aplicativo é lançado no Desktop, permitindo a criação
de novos documentos ou a abertura de documentos já existentes.

No Mac OS X, as imagens terão qualidade infinitamente superior!

Algumas pastas e componentes do Mac OS podem ser facilmente reconhecidos mediante os
ícones. As pastas System Folder, Apple Extras e Internet, por exemplo, são vistas mais ou menos
assim, na maioria das versões do Sistema.

Ícone da Pasta de Sistema

Ícone da Pasta Apple Extras

Ícone da Pasta Internet

Os ícones podem ser alterados de acordo com suas preferências. Você aprenderá como fazer
isso nos Capítulos 04 e 11 deste livro. O conjunto de tudo o que aparece na tela — os ícones e
conteúdos do Finder — é chamado de “interface gráfica”. Através dela você pode fazer
praticamente tudo com o Mac, utilizando os recursos de clicar, arrastar e soltar.

As pastas do Mac OS funcionam como pastas de um arquivo comum. Você as utiliza para
guardar tudo o que quiser, organizando o disco rígido. Você pode criá-las, ordená-las, movê-las e
apagá-las, de acordo com as suas necessidades. Obtenha mais informações sobre como fazer isso
no Capítulo 04.

Arquivos de programas são todas as seções de dados correspondentes a aplicativos. Existem
arquivos de aplicativos de editoração, suítes (conjuntos) de programas tais como o AppleWorks
ou o Microsoft Office, editores de HTML, navegadores de Internet e diversos outros utilitários.
Existem ainda programas Utilitários tais como reparadores de disco, compressores de arquivos e
descansos de tela que otimizam algumas funções do Sistema. Eis alguns exemplos de aplicativos.

QuarkXPress™ (editoração eletrônica).

AppleWorks (Suíte de programas da Apple).

XXMac OS
Aguarde noAguarde no
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Microsoft Excel (planilha de cálculos).

Macromedia Dreamweaver (Editor de HTML).

Arquivos de documentos são aqueles produzidos pelos aplicativos, por exemplo, um layout
de página do QuarkXPress™, uma carta escrita no AppleWorks, uma planilha do Microsoft
Excel ou um Web Site construído no Dreamweaver.

Aliases ou Réplicas
Para acessar documentos, programas ou pastas, basta dar um clique duplo sobre seus ícones.

Isso parece fácil, mas exige que você os localize no disco rígido. Isso implica em dar um clique
duplo no ícone do disco e procurar entre os seus diversos itens; clicar nas pasta onde estão
guardados os itens, localizá-los e acioná-los através de outro clique duplo.

Ufa, que trabalheira!

Para facilitar isso, o Mac OS criou os aliases ou réplicas, que são arquivos de atalhos que
você coloca onde quiser. Clicando no alias, você abre o item original.

Ícone da réplica de uma pasta.

Os ícones dos aliases são muito parecidos com os dos arquivos originais, com alguns
diferenciais: o nome em itálico, a pequena seta no canto inferior esquerdo e a palavra “alias”
depois do nome original.

Réplicas ocupam pouquíssimo espaço em disco. Você pode criá-las em vários lugares, de
acordo com o seu estilo de trabalho, para facilitar o acesso aos itens mais usados.

Outro aspecto interessante em réplicas é que elas podem ser jogadas fora sem prejuízo aos
itens originais (no Capítulo 02 você aprenderá a enviar coisas para a Lixeira do Mac).

Aliases são usados no Apple Menu e podem ser colocados em no Desktop. Eles também
podem ser danificados, quando você altera a posição do item original (sobre problemas com
réplicas, leia o Capítulo 12).

Para Fazer Réplicas:

1 Selecione com o mouse o item do qual você deseja fazer um alias.

2 Vá ao menu File e escolha a opção Make Alias ou aperte simultaneamente as teclas z +
M. O alias surgirá ao lado do arquivo original.

3 Mova o alias para onde desejar: seu Desktop ou a pasta Apple Menu Items, dentro da
pasta de Sistema (System Folder) em seu HD.

Movendo a réplica para a pasta Apple Menu Items, o item passa a fazer parte do Apple
Menu (leia mais sobre esse menu no Capítulo 03). Deixando-a em seu Desktop, ela pode ser
acessada com um clique duplo.

Outra forma de fazer um alias é control-clicando (clicar segurando a tecla Control) um item.
Surge um menu contextual dando-lhe a opção de gerar um alias.
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Clicando, Arrastando e Soltando com o Mouse
O Macintosh foi o primeiro computador a introduzir o uso do mouse para facilitar a vida dos

usuários. É o mouse que direciona a seta que surge na tela enquanto você realiza suas tarefas.
Essa seta é chamada de cursor ou ponteiro e serve para indicar qual item você deseja selecionar.

Ao digitar um texto num aplicativo processador de textos, o cursor se transforma num ponto
de inserção, uma barra vertical (“|”) que fica piscando na página, indicando o local aonde os
próximos caracteres serão digitados.

A maioria dos mouses se movimenta sobre uma pequena esfera de borracha, que possibilita
o seu deslizamento sobre qualquer superfície plana. Você trabalha melhor quando utiliza um
“mouse pad”, um acessório de tecido emborrachado, encontrado em diversos padrões em
qualquer loja de suprimentos de informática. O mouse pad dá mais segurança ao mouse,
otimizando o seu uso.

Terminologia do Mouse
Em todo esse livro você será convidado a trabalhar com o mouse do computador. Para evitar

problemas, é necessário que os significados de alguns termos sejam desde agora esclarecidos.

" Apontar: Mover o mouse de modo que o cursor esteja sobre o objeto desejado.

" Selecionar: Com a seta do mouse sobre o objeto, dar um clique simples.

" Clique Simples: Apertar uma vez o botão do mouse.

" Clique Duplo: Apertar o botão do mouse duas vezes, consecutivamente.

" Clique Duplo Longo: Clicar duas vezes, segurando o botão do mouse na segunda
clicada.

" Control-Clique: Clicar uma vez segurando a tecla Control.

" Arrastar: Clicar sobre um objeto e, com o botão do mouse apertado, movê-lo até o
lugar desejado.

" Soltar: Após arrastar o objeto até o ponto desejado, soltar o botão do mouse.

Alguns Recursos Interessantes
Você pode fazer muitas coisas úteis utilizando o recurso de clicar, arrastar e soltar do Mac

OS. Veja alguns exemplos:

" Após selecionar com o cursor um item, clique uma vez e arraste para criar uma cópia.

" Selecione qualquer coisa apertando a tecla Control e dando um clique longo (clique
uma vez mantendo apertado o botão do mouse). Surge um menu contextual.

" Selecione um item apertando as teclas z + Option. Arraste-o para obter um alias ou
réplica.

Cuidados Básicos com o Mouse
Esteja atento para os cuidados básicos com o seu mouse. Mouses sujos tornam-se pesados e

deixam de obedecer aos direcionamentos da mão, gerando cansaço desnecessário. Siga as
orientações do manual de seu computador, limpando periodicamente a parte interna do mouse
com uma haste flexível com ponta de algodão.
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Caso você não consiga se adaptar ao modelo do mouse do iMac, adquira outro, adequado ao
tamanho de sua mão. Alguns fabricantes disponibilizam acessórios que se encaixam nos novos
mouses da Apple, aumentando o conforto do usuário.

Selecionando Coisas
O mouse pode ser usado para selecionar uma ou mais coisas. Para selecionar apenas um

item, aponte para ele e dê um clique simples. Ele se torna de uma cor diferente, indicando a
seleção.

É possível selecionar vários objetos ao mesmo tempo, simplesmente clicando uma vez em
cada um deles, enquanto segura a tecla Shift.

Outra forma de selecionar muitas coisas ao mesmo tempo é usando o recurso de arrastar do
Mac OS. No exemplo abaixo, três arquivos foram destacados arrastando o ponteiro do mouse da
esquerda para a direita, de cima para baixo, até ver alterada as cores dos itens desejados,
indicando a seleção.

Isso funciona para qualquer janela do Finder, independentemente da forma de visualização
(ícones, botões ou listas — sobre estes modos de visualizar janelas, leia o Capítulo 06).

O Verdadeiro Sistema de Janelas
“Uma janela é uma caixa, retangular ou quadrada, que aparece na tela de seu computador”

(Borman e Abs, 1997, p. 127).  Brilhante definição!

Para quem trabalha com qualquer computador que usa interface gráfica, as janelas fazem
parte da rotina diária. No Macintosh elas estão presentes, elegantes, eficientes e organizadas,
desde 1984.

Janelas surgem quando você dá um clique duplo em pastas, discos rígidos ou mídias de
armazenamento tais como disquetes, cartuchos Zip Drive, CDs ou DVDs.
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Outras vezes surgirão janelas com mensagens de erro ou alerta, ou que solicitam um retorno
através de digitação de dados, marcação de botões de rádio, caixas de seleção ou clique em
botões. Estas últimas são chamadas de quadros ou caixas de diálogo.

Uma caixa de diálogo do Aplicativo Adobe® PageMaker®.

Uma caixa de diálogo do OS 9. Além de mais elegante, ela não exige que você pare tudo o que está
fazendo para pressionar o botão OK.

Existem também as chamadas janelas de aplicativos. Cada programa gera uma janela
específica (uma página de texto no Microsoft Word, uma página de arte no Macromedia
FreeHand, uma planilha de cálculo do AppleWorks e assim por diante).

As janelas de aplicativos possuem semelhanças com as janelas de pastas e discos, mas
comportam-se de modo diferenciado, de acordo com as características de cada programa de
origem.

Informações Básicas de Janelas do Mac OS

Na Barra de Título das janelas do Finder você encontra o nome e ícone da pasta aberta.
Mais abaixo, na Barra de Informações, pode ser verificada a quantidade de itens existentes na
janela, bem como o espaço disponível no disco rígido ou mídia de armazenamento (disquete,
cartucho Zip Drive, SuperDisk, CD etc).

O canto esquerdo da Barra de Informações é reservado para os ícones de status, que revelam
se a pasta (ou disco) está trancada ou organizada segundo critérios predefinidos.

99Mac OS
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Ícone de pasta (ou disco) travada, não podendo ser alterada.

Este ícone na Barra de Informações indica que a pasta (ou disco) está organizada de acordo com critérios
estabelecidos pelo usuário.

Os usuários do Mac OS X contarão com uma nova interface,
denominada Aqua, que faz uso da tecnologia Quartz para 2D, baseada
no PDF, um formato híbrido de arquivo criado pela Adobe.

As janelas do novo Sistema manterão os elementos básicos do OS
tradicional. No entanto, terão uma aparência sensacional, cheias de

transparências e sombreamentos. Além disso, será utilizado um novo sistema de navegação, que
permitirá a localização de arquivos com muito mais eficiência e rapidez.

As novas janelas do Mac OS X. Elegância e funcionalidade a serviço do Mac Usuário.

Movendo Janelas

À medida em que você for realizando suas tarefas, irá redimensionar, mover e recolher
temporariamente as janelas abertas em sua Mesa.

Para Mover Janelas:

1 Clique uma vez em sua barra de título e segure o botão do mouse. As bordas da janela
ficarão pontilhadas.

2 Arraste a janela com o mouse para a posição que desejar.

Às vezes você terá várias janelas abertas em sua Mesa e precisará mover-se entre elas. Para
fazer isso, basta clicar na janela desejada. Ela virá para a frente, pronta para uso.

Redimensionando e Recolhendo Janelas

As janelas podem ser redimensionadas manual ou automaticamente. Também podem ser
recolhidas, de modo semelhante a persianas, o que é muito útil quando você precisa de espaço
vazio na Mesa.

Para Redimensionar Janelas:

1 Clique na Caixa de Zoom, no canto superior direito das janelas, para redimensioná-las.

XXMac OS
Aguarde noAguarde no



MANUAL DO POKAPRÁTICA — 14

2 As janelas assim dimensionadas assumirão tamanhos diferentes, de acordo com seus
conteúdos e modos de visualização. Algumas vezes será necessário um ajuste manual no tamanho
das janelas.

Para Redimensionar Janelas Manualmente:

1 De um clique na Caixa Redimensionar, no canto inferior direito da janela. A borda da
janela se tornará pontilhada.

2 Arraste a borda para baixo e para a direita para expandi-la, ou para cima e para a esquerda
para diminuí-la.

Para Recolher Janelas:
1 Clique no Botão de Recolhimento, no canto superior direito das janelas. Elas se recolherão

como persianas horizontais.

2 A janela ficará recolhida, semelhantemente a uma persiana horizontal. Assim ela não
ocupa muito espaço e pode ser reativada de acordo com a sua necessidade, bastando para isso dar
um novo clique no Botão de Recolhimento.

Você pode ainda configurar o recolhimento das janelas selecionando Menu Maçã › Control
Panels › Appearance. Na guia Options, marque a caixa de seleção Double-click title bar to
collapse windows. Dessa forma, as janelas se recolherão apenas com um clique duplo na barra de
títulos.

Outra dica: ao recolher uma janela segurando a tecla Option, todas as outras são também
recolhidas.

Visualizando Conteúdos de Janelas

Os objetos guardados dentro de uma janela podem ser visualizados no Finder de três
maneiras:  como ícones, lista ou botões. Cada uma delas atende a necessidades específicas. Sobre
esses modos de visualização, consulte o Capítulo 06.

No Mac OS X, a visualização por botões será retirada. O usuário
terá a opção de visualização por colunas (uma adaptação do Sistema

OpenStep, desenvolvido pela NeXT, que
pertenceu ao guru Steve Jobs).

As opções de visualização de janelas, no Finder do
OS X: Colunas, Ícones e Listas. Na opção “Colunas”,
clicando no ícone de uma pasta, surge
automaticamente uma coluna à direita, mostrando o
seu conteúdo, sem que sejam necessárias novas
janelas abertas no Desktop.

XXMac OS
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Navegação nas Janelas

Janelas possuem caixas e barras de rolagem, bem como setas de navegação. Elas
possibilitam navegar até que localizemos aquilo de que precisamos.

As caixas de rolagem padrão (chamados, por alguns, de “elevadores” de barras de rolagem
— argh!) são pequenos quadrados que exigem que você os arraste para chegar até o objeto
desejado na janela. É possível configurar seu Mac para exibir caixas de rolagem otimizadas ou
proporcionais. Elas são mais compridas, ocupando um espaço maior na barra de rolagem. Esse
pequeno detalhe facilita inacreditavelmente sua tarefa de busca.

Uma caixa de rolagem proporcional do Mac OS.

Para Obter Caixas de Rolagem Proporcionais:

1 Selecione Menu Maçã › Control Panels › Appearance.

2 Na guia Options, marque a caixa de seleção Smart Scrolling.

Suas janelas exibirão caixas e barras de rolagem proporcionais. Fácil e rápido. Coisa de
Mac.

As setas de navegação otimizadas servem para que você percorra a janela em suas extensões
vertical e horizontal. O Sistema as dispõe bem juntas, todas no canto inferior direito das janelas,
com o objetivo de facilitar a navegação (você pode percorrer toda a janela com o mínimo esforço
do antebraço e da mão no mouse.

As setas de navegação otimizadas das janelas do Mac OS.

Usuários do Sistema 8 não têm acesso às barras de rolagem
proporcionais nem às setas de navegação otimizadas. Elas foram
implementadas a partir do Mac OS 8.5. No entanto, existem sharewares
disponíveis na Internet, tais como o Smart Scroll
(http://www.shareware.com) que incrementam o Os 8, concedendo-lhe tais

recursos — é claro, a um pequeno custo.

Mais Dicas de Navegação:

" “Fazer um scroll numa janela do Finder” é o termo usado pelos usuários Mac para
indicar a navegação pelas janelas. Na versão em português do OS 9, scroll é
simplesmente “rolamento”.

" Ao fazer uma busca numa janela, digite a primeira letra do conteúdo procurado. O
Finder automaticamente mostrará os arquivos iniciados por aquela letra. Tente. Funciona
mesmo!

" Aperte a tecla _ enquanto arrasta o cursor pela janela, inclusive na diagonal. O cursor se
transforma numa mãozinha, facilitando a navegação.

Janelas Pop-Up
Outro recurso inteligente do Mac OS são as janelas pop-up (Janela Local, no sistema em

português). Elas facilitam a vida de quem precisa voltar sempre às mesmas pastas enquanto
realiza determinadas tarefas. Alojadas no rodapé do Desktop, as janelas pop-up permitem acesso
aos seus conteúdos com um simples clique na aba com seu nome.

88Mac OS
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Uma janela pop-up, alojada como gaveta no rodapé do Desktop.

Para Criar uma Janela Pop-up:

1 Dimensione a janela, configurando as opções de visualização, observando os passos
indicados nas seções anteriores.

2 Arraste-a para a parte inferior de seu Desktop. Ela se transformará numa abinha com
nome.

Uma janela pop-up aberta. Para fechá-la, clique na aba com o ícone e nome da janela.

3 Para acessar a pasta, clique uma vez na aba. Ela se abrirá dando acesso ao seu conteúdo.

4 Para fechar a janela pop-up, dê um segundo clique na aba.

5 Para desativar a janela pop-up, transformando-a numa janela comum, feche-a
normalmente, clicando no botão de fechamento, em seu canto superior esquerdo, ou pressionando
z + W. Ela retornará ao seu lugar de origem.

Podem ser criadas tantas janelas pop-up quanto couber no espaço horizontal do rodapé de
seu monitor. Você pode organizá-las na ordem que quiser, bastando arrastá-las para os lados com
o mouse.

No Capítulo 06 há algumas outras dicas interessantes sobre modos de visualização de
janelas que vão auxiliar muito o seu trabalho.

No Mac OS X, a parte inferior da tela será ocupada pelo Dock,
que poderá conter inclusive janelas abertas. Você poderá armazenar o
que desejar no Dock, até mesmo filmes em andamento, bastando
arrastar o item com o mouse até o rodapé do seu Desktop.

O Dock do OS X pode conter até
128 itens diferentes,
proporcionando acesso rápido a
qualquer coisa. Trata-se de uma
evolução das Janelas Pop-Up.

Pastas Automáticas
Outro recurso facilitador são as Pastas Automáticas, que quando ativadas possibilitam

algumas ações interessantes. Por exemplo:

" Ao arrastar qualquer coisa para cima de uma pasta, mantendo apertado o botão do
mouse por alguns segundos, esta se abre instantaneamente. Ao mover o item para fora da
janela, ela se fecha sozinha, e você pode continuar fazendo o mesmo, com cada pasta de
seu disco rígido, até encontrar aquela onde deseje guardar o seu arquivo.

XXMac OS
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" Ao dar um clique duplo numa pasta mantendo pressionado o botão do mouse no
segundo clique, o cursor se transforma numa lupa com a qual você checa os conteúdos
de todos os seus discos e pastas. Sensacional.

Por padrão, as pastas automáticas já estão ativadas quando você liga pela primeira vez o seu
computador. Caso elas não estejam funcionando é necessário ativá-las manualmente.

Para Ativar as Pastas Automáticas:

1 Vá até a barra de menus da Mesa ou Desktop e selecione Menu Edit › Preferences.

2 Surgirá a janela de preferências do Finder, mostrando a guia General. Marque a caixa de
seleção Spring-loaded folders.

3 Um botão deslizante proporciona opções de tempo de abertura das pastas: curto, médio ou
longo. Por padrão, o sistema define esse tempo como longo (o que para mim atende
perfeitamente as necessidades do usuário). Se desejar, altere essa definição, testando várias
opções.

A guia General, da Janela Preferences. Marque a opção Spring-loaded folders para ativar as Pastas
Automáticas.
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02
Conhecendo a Mesa do Macintosh

este capítulo você vai conhecer a tela básica do seu Macintosh, mais conhecida como
Desktop ou Mesa.

O Desktop do Mac OS nos Sistemas 8 a 9.

O Desktop do Mac OS X. Mudanças sutis e poderosas.

A Tela Básica do Macintosh
A tela básica do seu Mac foi projetada com o objetivo de facilitar o seu trabalho. Aliás, esse

é um conceito fundamental das máquinas fabricadas pela Apple: o usuário deve usar o
computador de forma simples e intuitiva.

O fundo sobre o qual você desenvolve suas atividades é chamado de Mesa (Desktop). Você
trabalha ou se diverte (ou faz as duas coisas juntas!) com o seu Macintosh dispondo documentos,
pastas e objetos sobre a Mesa, tomando o cuidado de mantê-la sempre organizada. Essa
“organização” é bastante personalizada. Alguns gostam dela vazia — preferem visualizar um
ambiente totalmente limpo, como na figura acima. Outros colocam “coisas” sobre a Mesa, desde
utilitários  para facilitar o trabalho até “tranqueiras” para brincar, fotografias ou objetos
meramente decorativos. Você verá no Capítulo 11 como deixar o Mac com a sua “cara”,
organizando-o do “seu jeito”.

Usuários que tenham migrado do Windows verificarão que existem semelhanças entre o
Desktop do Mac e a chamada “área de trabalho” daquele sistema. A diferença entre os dois
sistemas é que o Desktop do Mac, usado desde os anos 80, é melhor implementado, projetado

N
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desde o início para a utilização do computador baseada em ambiente gráfico, por meio do mouse,
com seus recursos de selecionar, clicar, arrastar e soltar.

Vamos conhecer a Mesa do Mac analisando seus componentes no sentido horário: Barra de
Menus, HD, Lixeira e Control Strip.

A Barra de Menus
Na parte superior da tela você encontra a Barra de Menus. A partir do sistema 8, pequenas

(mas úteis e agradáveis) alterações foram acrescentadas. Os menus são listas de comandos que
você usa constantemente em suas operações no Finder.

A Barra de Menus do Mac possui nove elementos. Cada um deles merecerá um capítulo
próprio nesse livro. No entanto, vale a pena obter, desde agora, uma visão geral desses menus.

" Apple Menu: permite acessar aos seus programas, pastas, documentos e ferramentas
de Sistema favoritos.

" Menu File: Com ele você cria pastas; abre a janela do disco rígido; imprime a imagem
de pastas ou da Mesa; move itens para a Lixeira; fecha janelas; solicita informações de
pastas, arquivos e programas; define cores de etiquetas; duplica objetos; cria réplicas e
localiza seus arquivos originais; retorna objetos da Lixeira aos seus locais de origem;
procura arquivos e configura páginas para impressão. Nos próximos capítulos você
aprenderá como desenvolver essas tarefas em seu computador.

" Menu Edit: Com ele você pode desfaz ações; recorta, copia, cola ou limpa; seleciona;
mostra a Área de Transferência (ou Clipboard) e edita as preferências do Finder.

" Menu View: Define o padrão de visualização e organização da Mesa ou das janelas do
Finder.

" Menu Special: É aqui que você realiza algumas das operações mais rotineiras do seu
Mac, tais como limpar a Lixeira, ejetar e formatar discos, colocar o computador no
modo de repouso e reinicializar ou desligar sua máquina.

" Menu Help: Usado para acionar o Help Center e habilitar os balões de ajuda.

" Relógio: Mostra a hora local. Um clique no relógio faz com que o mostrador seja
alterado, exibindo a data atualizada.

" Menu de Teclado: Usado para selecionar opções de teclado (padrão brasileiro,
americano, espanhol etc.).

" Menu Aplicativos: mostra os programas que estão ativos, possibilitando a alternância
entre eles.

A partir do Mac OS X, pela primeira vez em praticamente 20
anos, a barra de menus sofrerá uma alteração substancial: da esquerda
para a direita constarão os Menus Aplicativos, File, Edit, View, Go,
Special, Help e Apple Menu. Com exceção do Menu Go, que
implementa novas opções de navegação no Finder, as funções básicas

de cada menu permanecem praticamente as mesmas. Isso significa que nenhum usuário precisa se
preocupar com a curva de aprendizado na hora de atualizar o Sistema.

Disco Rígido Fácil
No canto superior direito, encontra-se o ícone do HD (hard disk). Trata-se

do disco rígido do computador, onde estão armazenados todos os programas,
documentos e a pasta do Sistema do Mac.

XXMac OS
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No Macintosh, para acessar ao disco não é necessário utilizar programas de exploração, ou
digitar comandos complicados. Clique no ícone do HD e pronto. Eis a máquina por dentro: pastas
de aplicativos, pasta do Sistema, pastas de documentos — e tudo visível, passível de organização
e reorganização simplesmente mediante ações de clicar, arrastar e soltar.

Você pode personalizar o disco rígido colocando seu nome nele:

1 Marque o ícone do HD com o mouse. O nome do HD ficará em destaque.

2 Digite um novo nome: No exemplo acima, o disco foi renomeado para “Misael HD”.

E como você deve organizar os arquivos do seu HD? A resposta é: como quiser! Eu, por
exemplo, gosto de separar tudo em três pastas gerais: Sistema, Aplicativos e Documentos (veja
exemplo abaixo).

A pasta do Sistema não deve ser removida para o Lixo ou indevidamente alterada. O
computador precisa dela para iniciar as atividades todas as manhãs.

Na pasta de aplicativos eu guardo todos os meus programas. Se você for meio Nerd (como
eu) irá ainda criar subpastas tais como “Utilitários”, “Programas de Texto/ Editoração”, “Imagem
e Som” etc, etc., classificando os lugares onde armazenará seus programinhas. É claro que na
pasta documentos eu guardo todos os arquivos gerados, em categorias também predefinidas por
mim mesmo: “Trabalho”, “Faculdades”, “Minha Casa” etc.

É possível que você seja um macmaníaco “pós-moderno”, do tipo que deixa tudo “zoado”,
dentro do seu HD, numa (des) ordem que só você consegue entender (e às vezes nem você!).
Tudo bem. O importante é ser feliz com seu Mac.

A Lixeira do Mac
No canto inferior direito encontra-se a Lixeira (Trash). Você pode enviar objetos para a

Lixeira simplesmente arrastando-os, ou utilizando o comando Move To Trash… através do Menu
File do Finder, do menu contextual (selecionando o objetivo enquanto aperta a tecla Control) ou
do atalho de teclado (selecionando o objeto e teclando z + Background Delete).

Ícones da Lixeira do Mac. À esquerda, a lixeira vazia (sinal de boa organização
do usuário) e cheia, nos Sistemas 8 a 9. À direita a Lixeira no Mac OS X.

Após enviar objetos para a Lixeira, é importante esvaziá-la periodicamente. Você faz isso
selecionando Menu Special › Empty Trash… Isso não apenas é uma evidência de organização
pessoal, mas também libera espaço no disco rígido.

Você Tem Certeza de que Deseja Esvaziar a Lixeira?
Ao esvaziar a Lixeira, você perde os itens que jogou fora. Existem programas, tais como o

Norton Utilities, da Symantec, o MacMedic (versão demo disponível em www.recallusa.com) e o



MANUAL DO POKAPRÁTICA — 22

Data Rescue (disponível em www.wildbits.com/rescue), que prometem recuperar tais arquivos.
No entanto, a prática demonstra que nem tudo pode ser recuperado.

É por isso que todas as vezes em que você decide limpar a Lixeira, o Mac mostra uma caixa
de alerta perguntando se você tem certeza de que deseja se livrar definitivamente dos elementos
nela contidos.

Existem, no entanto, macmaníacos
apressados, que se irritam com tais
lembretes. Para evitar esta mensagem

1 Pressione a tecla Option enquanto
solicita o esvaziamento da Lixeira. Isso
desabilita o aviso, mas tem de ser

repetido a cada nova tarefa de “limpeza”.

2 Desabilite definitivamente os avisos. É preciso selecionar o ícone da Lixeira em seu
Desktop, solicitar informações (opção Get Info no menu File, ou através do menu contextual) e
desligar a caixa Warn before empty, situada no canto inferior esquerdo da janela.

Como Jogar Fora Arquivos Travados
Você também não pode jogar fora objetos que estejam travados. O computador exibe uma

caixa de diálogos informando que a Lixeira não foi esvaziada porque seu conteúdo está em uso
ou trancado.

Arquivos trancados não podem ser editados ou eliminados, e são facilmente reconhecíveis,
por exibirem um ícone de cadeado, tal como no exemplo abaixo.

Travar um arquivo é útil para proteger coisas importantes, que você não deseja que seu
“santo irmãozinho pokaprática” jogue fora acidentalmente, enquanto brinca com seu Macintosh.

Para Jogar Fora um Arquivo Trancado:

1 Marque o item e selecione Menu File › Get Info, ou use o menu contextual (marque o
arquivo e dê control-clique).

2 Na janela do Get Info, desmarque a caixa de seleção Locked, situada no canto inferior
esquerdo.

3 Arraste o arquivo para a Lixeira ou marque-o com o mouse e pressione as teclas z +
Background Delete.

4 Solicite o esvaziamento da Lixeira (Menu Special › Empty Trash...).

Outra ação possível é não destrancar o arquivo e solicitar o esvaziamento segurando a tecla
Option. Isso é chamado de esvaziamento forçado da Lixeira.

Se você pedir para seu computador jogar fora um arquivo que esteja em uso, o Macintosh
exige que o documento seja fechado antes de se livrar dele.

Para Jogar Fora um Arquivo em Uso:

1 Feche o arquivo no aplicativo de origem.

2 Arraste-o para a Lixeira ou marque-o com o mouse, pressionando as teclas z +
Background Delete.

3 Solicite o esvaziamento da Lixeira (Menu Special › Empty Trash...).
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Retornando Objetos da Lixeira
Para cancelar a eliminação de um objeto, arraste-o para fora da Lixeira e guarde-o

novamente em sua pasta. No entanto, isso se pode ser cansativo quando se tem muitos arquivos,
de diferentes pastas, a serem recuperados e guardados. O Finder faz isso de forma rápida e eficaz,
bastando marcar os itens a serem guardados e selecionar Menu File › Put Away ou usar o menu
contextual. Você pode ainda ganhar tempo usando o atalho de teclado, pressionando z + Y.

O Control Strip
No canto inferior esquerdo encontra-se o Control Strip, também chamado de Barra de

Controle, que é uma mão na roda para facilitar o acesso a alguns Painéis de Controle. O Control
Strip foi usado primeiramente em PowerBooks, e hoje é um utilitário amado por quase todos os
usuários do Macintosh.

O Control Strip é literalmente uma tirinha que é acionada quando clicamos a aba em forma
de ponteira, conforme o exemplo abaixo. Diversos painéis de controle são colocados à
disposição, de uma forma mais rápida do que o acesso via Apple Menu.

Ao ligar pela primeira vez o computador, a barra do Control Strip estará posicionada no
canto inferior esquerdo de sua Mesa, mas é possível colocá-la aonde você achar melhor. Ao
selecioná-la com o mouse, apertando a tecla Option, surge uma mãozinha com a qual você pode
movimentá-la, arrastando-a de modo a posicioná-la conforme sua preferência. A finalidade
básica desse utilitário é dar acesso rápido aos Painéis de Controle mais utilizados.

Cada painel constante no Control Strip é chamado de módulo, e fica arquivado numa pasta
do System Folder denominada Control Strip Modules. Você pode inserir ou retirar módulos do
Control Strip.

Para Inserir Módulos:

1 Arraste o novo módulo para dentro da pasta do Sistema (System Folder).

2 Uma caixa de diálogo lhe pergunta se deseja inserir o novo módulo na pasta Control Strip
Modules. Clique em Ok e reinicialize o computador.

Outra maneira mais prática é arrastar o módulo diretamente para o Control Strip. O novo
módulo aparece instantaneamente na tira, e pode ser usado imediatamente, sem necessidade de
restartar a máquina.

Para Retirar Módulos:

1 Vá até o System Folder e localize a pasta Control Strip Modules.

2 Selecione os módulos que deseja desativar e arraste-os para a Mesa.

3 Reinicialize o Macintosh. Note que, após o restart, sua Barra de Controle não mais contém
os módulos retirados.

Não jogue fora os módulos retirados da pasta Control Strip Modules. O melhor é guardá-los
em uma pasta do disco rígido, pois no futuro você poderá reutilizá-los.

Como obter novos módulos do Control Strip? Eles são fornecidos em CD-ROMs anexados
em revistas de usuários Macintosh ou podem ser obtidos pela Internet. Outra opção é trocar
módulos de Control Strip com os amigos, através de e-mail ou disquetes.
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Para Copiar Módulos de Control Strip:

1 Insira um disquete ou qualquer outra mídia de armazenamento no computador.

2 Vá até a pasta Control Strip Modules, que situa-se dentro do System Folder e selecione o
módulo que deseja copiar.

3 Arraste o módulo selecionado para o disquete (ou Cartucho Zip, etc).

É possível ainda copiar módulos sem precisar abrir a pasta Control Strip Modules:
Simplesmente arraste o ícone da aba do Control Strip para a Mesa. Depois, arraste o módulo
copiado para um disquete.
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03
Conhecendo o Apple Menu

ocê precisa lançar rapidamente aquelas coisas que mais usa (seu processador de textos
favorito, a pasta onde costuma guardar seus trabalhos escolares, o toca-discos CD ou o
navegador de Internet, por exemplo)? O Apple Menu existe para isso. Conhecê-lo é um

dos passos iniciais para o domínio do Macintosh.

Na barra de menus, escolha o Apple Menu. Aparece a lista de itens a serem acionados.

Como veremos adiante, existem diversas outras maneiras de inicializar programas, realizar
tarefas e abrir documentos ou pastas. Você vai utilizar a que lhe parecer mais prática e agradável.
Ou talvez, assim como eu, você aprenda a gostar de todas, transformando seu Mac num “samba
do crioulo doido”, cheio de trilhas diferentes para se chegar aos mesmos lugares — trilhas essas
que são acessadas de acordo com o seu humor, situação financeira, cor do sapato ou previsão
meteorológica.

Uma importante característica do Apple Menu é que ele pode ser configurado de acordo
com o seu estilo e necessidades pessoais. Normalmente, assim que você tira o seu Mac da caixa
(ô felicidade!) e o liga pela primeira vez, a tela principal já aparece tal qual mostrada no início do
Capítulo 02. E lá está o Apple Menu com os seus itens básicos, que podem mudar de acordo com
a versão do Sistema. Nesse capítulo irei tratar de alguns deles: About This Computer, Apple
System Profiler, Apple CD Audio Player, Automatic Tasks, Calculator, Chooser, Control Panels,
Favorites, Graphing Calculator, Internet Access, Jigsaw Puzzle, Key Caps, Network Browser,
Note Pad, Recent Applications, Recent Documents, Remote Access Status, Scrapbook,
SimpleSound, Stickies e Sherlock.

 À medida em que usa seu computador, você altera o Apple Menu, retirando os itens que
não são muito utilizados, e adicionando outros mais necessários.

Você aciona os itens do Apple Menu de maneira simples e rápida. Basta selecionar o item
desejado posicionando o cursor do mouse sobre ele (a cor de fundo é alterada indicando a
seleção), e dar um clique. A ação correspondente é imediatamente executada, seja o lançamento
de um programa, realização de uma tarefa ou abertura de pastas ou documentos.

Vamos dar uma rápida olhada nos itens do Menu:

About This Computer
" Situação nº 01: Muitos aplicativos estão acionados ao mesmo tempo, ocupando muita

memória RAM, e a performance da máquina foi comprometida (esse é o modo

V
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“técnico” de dizer que o seu Mac, de uma hora pra outra, ficou leeennto – nunca tanto
quanto um PC, é claro!).

" Situação nº 02: Você está todo feliz colando sua 28ª figura em seu “discreto” trabalho
de literatura, usando o processador de textos, e surge uma “tenebrosa” mensagem em
sua tela (principalmente se você estiver usando “aquele” processador de textos da
Microsoft) informando que, para inserir aquela foto do Machado de Assis, o programa
em uso exige “mais memória” disponível.

" Situação nº 03: Você quer saber qual programa de acesso à Internet ocupa mais
memória: o Netscape Communicator ou o Explorer. “E agora, quem poderá lhe
defender?”.

" Situação nº 04: Você está em dúvidas se a memória virtual do Mac está acionada, ou
deseja saber quanto dela foi ativada.

" Situação nº 05: Você precisa tomar a decisão sobre quais programas devem ser
desligados e quais devem permanecer em uso, enquanto você executa uma tarefa que
demanda mais memória livre.

" Situação nº 06: Você está só namorando a tela do Mac e decide casualmente: “Deixe
eu ver a tela do About This Computer, porque ela é “bonitinha pra caramba”.

Em todos esses casos, a consulta a este recurso é útil. O About é uma janela de informações
gerais sobre o computador que lhe ajuda a tomar decisões gerais sobre uso de aplicativos e
configuração de memória do Sistema.

Quando selecionado, o About informa qual a versão do Sistema e quantidade de RAM
instalada, se a memória virtual está ligada, quanto de memória RAM existe disponível, quais os
programas que estão ativos, quanto de memória está alocada para cada um deles e quanto
efetivamente está sendo utilizado dessa “reserva”.

Ao utilizar qualquer aplicativo e selecionar About This... (ou “Sobre o ...”, no caso de
softwares em português) no Apple Menu, você verá uma Splash Screen, uma janela com
informações sobre o programa ativo.

Para acionar uma proteção de tela com os nomes dos desenvolvedores do Sistema, pressione
ao mesmo tempo as teclas Control + Option + z e selecione Apple Menu › About Mac OS 8.5
Team.

Apple System Profiler
O Apple System Profiler é um acessório da Mesa que informa sobre toda a estrutura do

computador. Ao ser selecionado, é aberto um menu composto de diversas guias. Na primeira
delas, System Profile, os itens mais importantes são os que tratam do Sistema instalado, memória
(até aqui nada muito diferente do About This...), hardware (modelo do seu Macintosh, tipo de
teclado e de processador), aparato de rede (útil se você usa seu Mac em rede) e impressoras
instaladas.
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A guia Devices and Volumes informa sobre os discos rígidos, dispositivos SCSI (CD ROM,
Zip Drive, scanners etc.), placas de vídeo e drives de discos.

As guias Control Panels, Extensions e Applications mostram os Painéis de Controle,
aplicativos e Extensões instalados, indicando seus fabricantes e suas funções. A guia System
Folders lista os sistemas instalados nas diversas partições de disco (sim, você pode ter mais de
um sistema operando em seu Mac, inclusive Linux e o Windows — este último rodando através
de um emulador).

Como você vê, o Apple System Profiler é uma ferramenta poderosa de informações, útil
para obtenção de dados mais específicos de sua máquina.

AppleCD Audio Player
O AppleCD é um programinha leve e eficiente para tocar os seus CDs preferidos. O uso é

intuitivo, e você altera como quiser as cores de janelas e indicadores. Atende bem a nós, simples
mortais que não precisamos daquelas “tralhas” cheias de botões deslizantes dos kits de CD-ROM
pecezistas1.

A simpática janela do AppleCD Audio Player

Além da interface, é possível definir a ordem em que as faixas serão tocadas, além de outras
preferências.

Para Alterar a Aparência do AppleCD:

1 Selecione Options › Window Color › uma das seis cores disponíveis no menu (Dark Gray,
Green, Blue, Purple, Red ou Gold).

2 Selecione Indicator Color e faça o mesmo com as cores dos indicadores (as cores são
Magenta, Green, Blue, Gray, Yellow e Red).

É ainda possível configurar preferências de som e driver de CD de inicialização (você
provavelmente não vai precisar dessa opção).

                                                
1 “Pecezista”: Termo normalmente utilizado para usuários de computadores que usam o sistema
operacional Windows — aqueles que usam PCs.
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Automated Tasks
Esta opção aciona algumas tarefas automáticas (scripts), que facilitam, por exemplo, a

criação de réplicas que são automaticamente anexadas no Apple Menu. Basta selecionar o item, ir
com o cursor do mouse ao Automated Tasks, clicando uma vez na opção Add Alias To Apple
Menu. Uma mensagem aparece em sua tela informando que o item foi adicionado ao menu.

Uma rápida checada no Apple Menu revela que o objeto selecionado foi incluído no mesmo,
de forma a poder ser acessado mais rapidamente. Tal procedimento pode ser repetido
indefinidamente, conforme suas necessidades e preferências.

Tome cuidado para não anexar coisas demais. Um menu inflado pode dificultar mais do que
facilitar sua vida. O ideal é incluir no máximo 20 ou 25 itens (só aquelas ferramentas
imprescindíveis). Outras opções do Automated Tasks são úteis apenas se você utiliza o Mac em
rede.

Ferramentas de Cálculo
O Apple Menu disponibiliza duas ferramentas de cálculo, a Calculator, uma calculadora

simples que realiza as quatro operações básicas, e a Graphing Calculator, para realização de
cálculos gráficos.

Jigsaw Puzzle
O Mac traz ainda um quebra-cabeças que é um clássico, ideal para aqueles momentos em

que você precisa realizar elucubrações imaginativas profundas e transcendentais (ou seja, pura e
gostosa enrolação). A criançada (de 3 a 130 anos) gosta de montar o mapa-múndi, utilizando os
três níveis de dificuldade propostos pelo aplicativo.

Recent Applications e Recent Documents
Revelação surpreendente: estes itens fazem o que os nomes sugerem: listam os últimos

programas e documentos abertos. É uma mão na roda para quando precisamos voltar a um
documento no qual trabalhamos há pouco tempo.

Por padrão, o Mac OS define a mostragem dos últimos dez aplicativos e documentos
utilizados. Mas é possível aumentar essa configuração. Para fazer isso é necessário alterar as
definições do Painel de Controle Apple Menu Options.

Para Alterar as Opções do Apple Menu:

1 Selecione Apple Menu › Control Panels › Apple Menu Options.



CONHECENDO O APPLE MENU — 29

2 Surge o Painel de Controle Apple Menu Options. Certifique-se de que a caixa de seleção
Remember recently used items esteja marcada. Depois vá ao campo Documents e digite o
número de últimos documentos utilizados que você deseja ver listados no item Recent
Documents, do Apple Menu.

3 No campo Applications, digite o número de últimos programas aplicativos utilizados que
você deseja ver listados no item Recent Applications, do Apple Menu.

4 Feche a janela do Painel de Controle e reinicialize o computador. O seu Apple Menu passa
a listar a quantidade configurada de últimos programas e documentos utilizados.

O Painel de Controle Apple Menu Options define ainda o funcionamento dos Submenus ou
Menus Hierárquicos. Mantê-los ativados agiliza bastante o seu serviço. A opção Servers é usada
apenas para usuários em rede.

O Chooser
O Chooser ou seletor é um acessório da Mesa que permite a seleção das impressoras e

scanners instalados no Macintosh.

Na instalação do Sistema diversos drivers de impressoras são armazenados automaticamente
na pasta Extensions, que pode ser encontrada dentro do System Folder. Esses drivers são também
conhecidos como “documentos Chooser” ou Chooser Extensions. É claro que você não utilizará
todos eles. É recomendável desabilitar as Extensões das impressoras não utilizadas, para dar mais
agilidade ao Mac (veja mais sobre isso no capítulo 10). No caso de adquirir uma impressora não
fabricada pela Apple, é necessário instalar o novo driver, seguindo as instruções do fabricante do
equipamento.

Ao abrir o Chooser você vê, na janela à esquerda, o ícone (ou os ícones, no caso de você
utilizar vários equipamentos) da impressora instalada. Para imprimir, selecione a impressora e
clique na porta de impressão desejada. O computador pode imprimir utilizando uma porta serial
de impressora (printer port — porta de impressora) ou rede (ícone do telefone, na janela direita
— porta de modem). Para acionar uma impressora local, desabilite o AppleTalk (opção inactive,
no canto inferior direito do painel).
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É possível ainda definir a impressão em segundo plano (background), que permite a
continuação do trabalho enquanto o Mac estiver imprimindo. Com o background desativado,
você tem de aguardar a finalização dos trabalhos de impressão, sem poder utilizar nenhum outro
aplicativo. O problema do background é que, estando ativo, ele faz com que a impressão fique
um pouco mais lenta. É claro que o grau de lentidão depende do tipo de impressora utilizada,
bem como do poder de processamento e quantidade de RAM do Macintosh.

Em todo trabalho de impressão é necessário selecionar a impressora no Chooser? Sim, se for
alterado o equipamento utilizado. No caso de continuar com a impressora anterior, isso não é
preciso. Se sua impressora não responder no momento da impressão, exigindo a seleção no
Chooser cada vez que o Sistema é iniciado, é sinal de que o driver está desatualizado. A solução é
baixar uma atualização, no site do fabricante.

Key Caps
O que fazer quando você precisa digitar caracteres pouco usados, tais como © ou ®? No

Macintosh, isso é possível utilizando combinações das teclas Shift, Option e z.

O Key Caps é um acessório que lhe permite visualizar estas combinações. Basta selecioná-
lo no Apple Menu. Surge a figura de um teclado na Mesa, ao mesmo tempo em que é alterada a
Barra de Menus.

Na nova barra, selecione a fonte a ser pesquisada e depois teste as diferentes combinações
das teclas Shift, Option e z, para obter os caracteres desejados.

No caso de precisar digitar medidas ou outros valores que exijam caracteres subescritos ou
sobrescritos (m2, por exemplo), utilize os recursos de estilos dos próprios processadores de texto
tais como o NisusWriter, AppleWorks ou Microsoft Word.

Ferramentas de Anotações
Para fazer anotações rápidas, nas quais não seja necessária formatação especial, você pode

usar o Note Pad. Para escrever pequenos lembretes que ficam “grudados” em sua tela, use o
Stikies.

Note Pad
O Note Pad é um bloco de notas que vem com oito páginas para anotações diversas. Cada

página suporta uma quantidade grande de texto (para você ter a idéia, todo esse capítulo, depois
de digitado, foi colado no Note Pad, que continuou funcionando com a mesma rapidez.
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Outro aspecto interessante desse utilitário é a facilidade de navegação pelas páginas, que
pode ser feita clicando com o mouse na aba situada no canto inferior esquerdo do bloco, ou
selecionando File › Go To Note... na barra de menus do aplicativo.

Outras Dicas de Navegação:

" Clique no número de página da nota. Surge uma janela na qual você digita o número da
página para onde deseja ir.

" Utilize as combinações de z + setas de navegação do teclado do Mac: z + → – vai
para a próxima página; z + ← - volta para página anterior; z + ↑ - volta ao início do
texto; z + ↓ - avança até o fim do texto.

É possível inserir uma nova página de nota selecionando, no menu do programa ( File › New
Note). Notas podem ser deletadas e ainda são possíveis definições de configuração de tamanho
de página e impressão.

O Note Pad só não permite formatação especial. Para isso você precisará usar um
processador de textos ou um programa de editoração tal como o Adobe® PageMaker®, Adobe
InDesign® ou QuarkXPress™.

Stikies
O Stikies é um programa que permite fazer lembretes de diversas

cores, que ficam grudados na tela do seu computador, tal como as
etiquetas muito utilizadas nos escritórios.

Para Criar Novos Lembretes:

1 Acione o Stikies selecionando Apple Menu › Stikies.

2 Na barra de menus do aplicativo, selecione File › New Note.
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3 Na nova nota, digite o que quiser. Todas as vezes em que o Stikies estiver ativado, essa
nota aparece na tela do Macintosh. A janelinha do Stikies pode ser redimensionada, arrastando o
seu canto inferior direito.

Para Alterar as Cores dos Lembretes:

1 Selecione, com um clique simples, o lembrete que deseja alterar.

2 Vá ao menu Color e selecione a cor desejada. A cor do lembrete é mudada conforme a sua
opção.

Se você quiser que o Mac apresente na tela os lembretes do Stikies todas as vezes em que
for ligado, proceda da seguinte forma:

1 Faça a nota no Stikies, seguindo as orientações listadas acima.

2 Vá até a barra de menus do aplicativo e selecione Edit › Preferences. Será aberta a janela
de preferências do Stikies.

3 Selecione a opção Launch at system startup › in the background e reinicialize o
computador. É incluída uma réplica do Stikies na pasta Startup Itens, na pasta System. Com isso,
todas as vezes que o computador for ligado, esse aplicativo é automaticamente lançado.

Se você quiser eliminar o acionamento automático do Stikies na inicialização do Mac OS,
basta ir até a pasta System, abrir a pasta Startup Itens, localizar a réplica do Stikies e jogá-la no
lixo.

Scrapbook
O Scrapbook é um acessório da Mesa que funciona literalmente como um álbum de

recortes, onde você guarda imagens (em formato PICT), gráficos e sons. Basta arrastar um item
para a janela do álbum para que ele fique disponível para utilizações posteriores. Depois, é só
fazer o contrário, arrastando do Scrapbook para o trabalho em andamento. Os conteúdos são
colados instantaneamente.

SimpleSound
O SimpleSound é um aplicativo que lhe permite gravar seus próprios sons, de modo a

personalizar o Mac. Com ele você adiciona sons de alerta, ou mesmo grava sons mais longos,
com diferentes níveis de qualidade de áudio. A gravação pode ser feita diretamente do microfone,
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que deve estar plugado na entrada de áudio do Macintosh. A interface do programa é
inteiramente intuitiva. É abrir e ir usando (e brincando, é claro J). Veja mais sobre como utilizar
sons para personalizar seu computador no Capítulo 11.

Control Panels
A opção Control Panels no Apple Menu, dá acesso aos Painéis de Controle ativos no

Macintosh. Através dela você altera diversas configurações de sua máquina, de acordo com suas
necessidades. Você poderá obter mais informações sobre como fazer isso no Capítulo 10.

Favorites
Favorites é uma boa novidade que surgiu a partir do Sistema 8.5, para facilitar ainda mais a

vida dos macmaníacos. Trata-se de uma pasta onde ficam acumuladas as réplicas de todos os
programas, documentos ou pastas prediletas, criando uma opção de acesso rápido no Apple
Menu.

Para Adicionar um Item na Pasta Favorites:

1 Depois de selecionar o objeto com o mouse, vá até o Menu File do Finder e selecione Add
To Favorites.

2 Se você quiser utilizar o menu contextual, clique no objeto segurando a tecla Control e
selecione a opção Add To Favorites.

Ao selecionar Favorites no Apple Menu, o objeto selecionado está lá, pronto para uso.

Internet Access
Através do Internet Access você aciona os aplicativos de correio eletrônico e navegação na

Internet.

A opção Browse the Internet lança o
navegador, que busca o endereço
registrado nas preferências de Internet. A
opção Connect To... abre um painel no

qual você digita um endereço de Internet, que é buscado pelo navegador. A opção Internet Setup
Assistant abre o assistente de configuração de Internet, sempre que você desejar alterá-la. A
opção Mail lança o programa cliente de correio eletrônico.

No Mac OS 9, esta opção deixa de constar no Apple Menu. Para
acessar rapidamente a rede, o usuário dessa versão do Sistema pode
colocar réplicas dos programas de navegação e correio eletrônico no
Apple Menu. O Capítulo 09 contém mais informações sobre como
configurar o Macintosh para a Internet.

Network Browser
O Network Browser, presente no Mac OS a partir da versão 8.5, é um aplicativo que

dificilmente será usado pelos pokapráticas, uma vez que se destina ao gerenciamento de redes.

99Mac OS
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Trata-se de um programa que permite visualizar a rede como uma janela de lista do Finder e
acessar qualquer máquina vinculada.

Remote Access Status
O Remote Access Status informa como está a sua conexão de Internet. Pode ser usado para

acionar a conexão ou simplesmente verificar há quanto tempo você está navegando na rede.

O Sherlock
O Sherlock é utilizado para encontrar “coisas” que estão guardadas (ou perdidas L!) no

computador. Com a ferramenta Find File, você localiza arquivos, pastas ou programas, utilizando
os seus nomes como parâmetro de busca.

Além disso, selecionando a guia Find By Content, é possível fazer buscas em arquivos por
seus conteúdos. Por exemplo, o Sherlock pode procurar todos os arquivos que contenham a
palavra “sorumbático” (se você tiver muitos arquivos com esta palavra, provavelmente você
precisa de um “loongo” período de “descanso” em um instituto de tratamento mental J).

A janela do Sherlock mostrando a guia Find by Content. Estabeleça os critérios de busca, digite uma
palavra relacionada ao arquivo desejado e clique em Find ou na tecla Return. O Sherlock lista todos os
arquivos nos quais exista essa palavra.

Isso funciona em arquivos de texto (Microsoft Word, AppleWorks, SimpleText, Nisus),
HTML, PDF (somente a partir do Sistema 8.6) e também em documentos de programas tais
como QuarkXPress™, Adobe® PageMaker® e até em bancos de dados.

Para que a busca por conteúdo funcione, o Mac OS cria um índice dos arquivos do disco
rígido. Essa indexação é bastante demorada na primeira vez em que é feita. No entanto, nas
atualizações o processo é bem mais rápido, devido à menor quantidade de itens a serem
indexados. É possível ainda agendar esta tarefa para períodos noturnos.

Para Agendar a Indexação do Disco Rígido:

1 No Sherlock, selecione a guia Find by Content.

2 Clique no botão Index Volumes..., situado no canto inferior esquerdo da guia Find by
Content. Surge a janela Index Volumes.

3 Na janela Index Volumes, marque os botões de seleções referentes aos discos que deseja
indexar (infelizmente o Sherlock não indexa CD-ROMs).

4 Depois de selecionar os discos a indexar, clique no botão Schedule... no canto inferior
esquerdo da janela Index Volumes. Surgirá a caixa de diálogo Schedule.
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A caixa de diálogo Schedule. Marque a caixa de seleção referente ao dia em que deseja indexar seus
discos. No menu pop-up, defina o horário para a indexação.

5 No caixa de diálogo Schedule, acerte o dia e horário em que deseja que seu Macintosh
realize a indexação. Eu mesmo faço isso todas as madrugadas das sextas-feiras.

Para que tudo isso funcione, é necessário ainda configurar o Painel de Controle Energy
Saver, é responsável por ligar o computador no dia e horário predefinidos. Veja como fazer isso
no Capítulo 10.

Mais dicas para aceleração da indexação dos discos:

" Localize o arquivo Find by Content Indexing, na pasta System Folder › Extensions ›
Find.

" Solicite informações do arquivo, selecionando-o com o mouse e dando um Get Info
(opção Get Info no Menu File ou z + I).

" Na janela do Get Info , selecione a opção Memory na janela Show, situada logo abaixo
do nome do arquivo.

" Aumente a memória alocada para o aplicativo para 4000 K.

Outro dispositivo interessante do Sherlock é a ferramenta de pesquisa na Internet (Search
Internet), que permite buscas na rede sem sair do Mac OS, utilizando ferramentas tais como
AltaVista, Yahoo e os brasileiros Aonde, Surf etc.

A janela do Sherlock mostrando a guia Search Internet. Estabeleça os critérios de busca, marcando nas
caixas de seleção das ferramentas de busca relevantes, digite uma palavra-chave e clique em Search ou
na tecla Return. O Sherlock lista todos os sites nos quais consta a palavra pesquisada, em ordem de
importância.
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Você digita uma palavra-chave no campo Words da guia Search Internet e clica no botão
Search. O Mac OS entra na rede e fornece uma lista de sites em ordem de relevância, diretamente
na janela do Sherlock.

Clique nos ícones dos sites e leia suas referências (normalmente os meta-names description
e keywords das páginas HTML ou os sumários de cadastramento dos sites de busca). Achando
um site interessante, clique duas vezes em seu ícone ou em seu endereço listado na janela do
Sherlock e pronto. O navegador do computador é lançado e você navega no site.

Para que isso funcione assim, os sites de busca desenvolvem plug-ins especificamente para
o Sherlock. Até o momento, somente umas poucas ferramentas brasileiras disponibilizam esse
recurso. Com a expansão dos usuários Macintosh no Brasil, a tendência é aumentar o número de
serviços de busca que ofereçam plug-ins para o Sherlock.

O Mac OS 9 possui a versão 2 do Sherlock que, além dos recursos
citados acima, possibilita a criação e organização de canais de busca:
Internet, People, Shopping, News, Apple, Reference e My Channel. Todas
as buscas, inclusive de arquivos locais, são feitas numa mesma janela.

O Sherlock 2: Aparência de aço escovado e
consultas em uma única janela.

Cada canal é representado por um
ícone, sendo que o primeiro à esquerda
direciona a busca aos discos rígidos
locais.

O canal Internet aciona pesquisas
na rede, baseada nos plug-ins fornecidos
pelos serviços de busca.

O canal People possibilita a troca
de nomes, e-mails e telefones entre
pessoas que estejam catalogadas em
servidores LDAP (Lightweight Directory
Access Protocol — uma espécie de

banco de dados utilizado pelo Bigfoot, Four11 e Yahoo). Você provavelmente não vai utilizar
esse recurso, ao menos por enquanto.

O canal Shopping lista alguns plug-ins de sites de compras.

O canal News possui plug-ins de sites de notícias.

O canal Apple coloca à disposição plug-ins para o site da Apple.

No canal Reference estão os plug-ins educativos, tais como o Dictionary.com, e
Encyclopedia.com. Quem sabe um dia teremos diversos sites educativos produzindo plug-ins
para o Sherlock…

O canal My Channel é para seu uso. Jogue aqui todos os plug-ins de endereços legais,
organizando-os por categorias.
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O Sherlock 2 é capaz de fazer buscas utilizando mais de um critério, como nomes e
conteúdos de arquivos. Você configura a pesquisa preenchendo os campos da janela More Search
Options, conforme a necessidade.

Quem Não Tem Sherlock, Caça Com Find File…
Os usuários do Mac OS 8 não possuem o Sherlock. Mesmo assim,

eles podem usar uma ferramenta muito eficiente, que inclusive foi
absorvida pelo Sherlock: o Find File. O único inconveniente é não poder
fazer consultas diretamente na Internet, nem por conteúdos dos arquivos.

Para Acionar o Find File:

1 Selecione Apple Menu › Find File.

2 Digite a palavra-chave e defina os critérios de busca. O utilitário localiza rapidamente os
arquivos desejados.

88Mac OS
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04
Conhecendo o Menu File

maioria dos procedimentos de organização do Macintosh depende do Menu File
(Arquivo). Com ele você cria, abre e move pastas — assim como outros itens — para a
Lixeira, abre janelas, solicita informações, organiza arquivos com cores, duplica,

adiciona coisas à pasta Favorites e desenvolve muitas outras tarefas.

Na Barra de Menus, escolha o Menu File (Arquivo). Aparece a lista de itens a  serem acionados. No Mac
OS 9, algumas novas funções são agregadas ao Menu: Encrypt e Search Internet.

Atalhos do Menu File
Atalhos são conjuntos de teclas que acionam tarefas no computador. Conhecê-los e usá-los

faz com que você aumente sua produtividade. Praticamente todos os programas para o Macintosh
oferecem opções de atalhos. As combinações de teclado para os atalhos podem ser visualizadas
nas barras de ferramentas dos diversos aplicativos.

Clique e arraste o mouse sobre o Menu File e note que são mostradas as opções de trabalho
com seus respectivos atalhos.

Muitos atalhos utilizam as teclas Command (z) e Option (U). Alguns programas usam as
teclas F1 a F15 e as teclas de navegação (diversos tipos de seta situadas próximas ao teclado
numérico do Mac).

Normalmente demora um pouco até conseguir memorizar as combinações de teclas de
atalhos, mas vale a pena tentar, pois o ganho de tempo é significativo quando estamos
desenvolvendo trabalhos de maior porte.

Criando Novas Pastas
Se você migrou do  Windows, entenda que as pastas do Mac são a mesma coisa que os

“diretórios” daquele sistema. Nelas são guardadas todas as coisas do computador.

Caso você decida criar uma nova pasta, vá até o Menu File e escolha New Folder, ou aperte
as teclas z + N. É possível fazer isso ainda usando o menu contextual. Basta clicar em qualquer
ponto da Mesa pressionando a tecla Control. Surge o menu com a opção de criação de nova
pasta.

A
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Uma nova pasta, denominada “untitled folder” (pasta sem título), aparece na Mesa.

 Você pode dar um nome a ela, tal como “Preciosidades”. Como padrão, a tarja onde está
escrito “untitled folder” já está em destaque, aguardando a digitação do novo nome. Digite o que
quiser e aperte a tecla Return ou clique com o mouse em qualquer ponto da Mesa.

Pronto. Você terminou de criar uma pasta para guardar o que desejar.

É possível ainda criar pastas dentro de pastas. Por exemplo, você pode criar dentro dessa
pasta de preciosidades, outras pastas tais como “Figurinhas Legais”, “Cartas Importantes”,
“Física Quântica” etc. E o processo pode repetir-se ad infinitum, como você desejar.

Para Criar Pastas dentro de Pastas:

1 Marque a pasta “Preciosidades” com o mouse e selecione Menu File › Open. Ou então
digite o atalho z + O. Uma outra forma de fazer a mesma coisa é clicando duas vezes sobre a
pasta. Aparece na tela uma janela aberta, mostrando o conteúdo da pasta “Preciosidades”.

2 Clique dentro da janela aberta. Com isso você está dizendo ao Mac que deseja fazer algo
dentro da pasta marcada. Agora é hora de solicitar ao computador que crie uma nova pasta,
dentro da pasta “Preciosidades”.

3 Vá até o Menu File e escolha New Folder, ou aperte as teclas z + N. É possível fazer isso
ainda usando o menu contextual, clicando em qualquer ponto da janela aberta pressionando a
tecla Control.

4 Uma nova pasta, denominada “untitled folder” (pasta sem título), surge na janela. Proceda
da forma acima para dar um nome à nova pasta.
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Abrindo Pastas e Lançando Aplicativos
A opção Open abre documentos e pastas, podendo ainda ser usada para lançar programas.

Vá até a pasta que você criou na Mesa e marque-a com o ponteiro do mouse. Depois escolha
File › Open ou aperte as teclas z + 0. A pasta é aberta mostrando o seu conteúdo. Caso o item
selecionado seja um documento, este será aberto em seu aplicativo de origem.

Outro modo de abrir rapidamente qualquer coisa, é dar um clique duplo no objeto. Se for
uma pasta, ela será aberta. Se for um aplicativo ele será lançado. Se for um documento, ele será
aberto no aplicativo de origem.

Clique duas vezes no ícone de um aplicativo…

… para lançá-lo rapidamente.

É possível ainda abrir qualquer documento simplesmente arrastando-o para o ícone do
programa (pode ser o ícone original ou uma réplica). Experimente arrastar um documento do
AppleWorks sobre o ícone deste aplicativo e veja o que acontece: o AppleWorks é lançado e o
documento é aberto na tela de seu computador.

Impressão Rápida
A opção Menu File › Print (Imprimir) não funciona para pastas ou aplicativos. Só se mostra

disponível quando você seleciona um “documento”.

Vamos imaginar que você tenha digitado um trabalho utilizando o processador de textos do
AppleWorks. Você está com pressa e precisa imprimir rapidamente o arquivo. Para imprimir da
forma tradicional, você tem que dar seis passos:

1 Selecionar a impressora no Chooser.

2 Abrir o aplicativo.

3 Dentro do AppleWorks, abrir o documento (os passos 2 e 3 podem ser reduzidos para uma
só ação, se você clicar duas vezes no documento ou usar o recurso de arrastar, conforme
explicado acima).

4 Configurar o documento para a impressão (acertar margens e tamanho do papel).
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5 Solicitar a impressão (no Painel de Controle da impressora, definir qualidade, se a
impressão será colorida etc.).

6 Após a impressão, fechar o AppleWorks.

Ainda bem que você trabalha com um Macintosh! Utilizando o comando Print do Menu
File, você reduz o seu trabalho significativamente.

Para Imprimir Usando o Menu Print:

1 Marque o documento com o mouse.

2 Selecione a opção Print (ou use o atalho z + P). O documento é aberto e surge o painel da
impressora em sua tela, para que você defina os valores da impressão (qualidade, cor etc.).

O computador automaticamente lança o programa que criou o documento, encaminha o
arquivo para impressão e fecha o aplicativo. Tudo numa fração de segundos (documentos mais
longos levam “duas frações de segundos”).

Para que isso funcione assim, é preciso manter atualizado o driver da impressora. A cada
atualização do Sistema, normalmente é necessário que você vá até o endereço do fabricante do
equipamento, na Internet, para baixar uma nova versão do software. Drivers desatualizados
provocam problemas no funcionamento de seu equipamento.

Movendo Arquivos Para o Lixo
A opção Move To Trash envia os objetos selecionados para a Lixeira. Nós já vimos como

isso pode ser feito na seção “A Lixeira do Mac”, no Capítulo 02.

Use o comando Menu File › Move To Trash ou o atalho z + Background Delete para enviar itens para a
Lixeira do Mac.

Fechando Janelas
Esta opção fecha as janelas selecionadas. No primeiro capítulo desse livro, na seção “O

Verdadeiro Sistema de Janelas”, você aprendeu como redimensionar e navegar dentro de janelas.
Espero que você se lembre que qualquer janela pode ser fechada simplesmente clicando-se no
pequeno quadrado situado em seu canto superior esquerdo.

O Botão de Fechamento das Janelas do Mac.

Outra forma de fechar uma janela é selecioná-la com o mouse e acionar Menu File › Close
Window, ou recorrer ao atalho z + W. É possível fechar todas as janelas abertas na Mesa
pressionando as teclas Option + z + W.

Utilizando o Get Info
O Get Info (Obter Informações) é uma das mais importantes opções do Menu File, e pode

ser utilizado para:
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" Obter informações sobre qualquer item.

" Trancar ou destrancar documentos ou aplicativos.

" Gerar gabaritos (formulários padronizados).

" Colorir arquivos.

" Localizar os originais de réplicas.

" Personalizar a alocação de memória para programas.

" Personalizar os ícones do computador.

Obtendo Informações e Gerando Gabaritos
As informações obtidas pelo Get Info podem ser de dois tipos: gerais (General Information

— arquivos que estão guardados dentro do disco rígido do computador) ou de rede (Sharing —
arquivos compartilhados entre diversos usuários).

Para obter informações de qualquer item, marque-o com o mouse e “dê um Get Info” (o termo é esquisito,
mas é isso mesmo). Acione a tarefa solicitando Menu File › Get Info ou use o atalho z + I.

Como esse livro não destina-se a informar sobre uso do Mac em rede, analisaremos apenas
as informações obtidas mediante a opção General Information.

Para obter dados de objetos, basta selecioná-los e solicitar Menu File › Get Info ou utilizar o
atalho z + I. Basicamente existem quatro tipos de itens que podem ser consultados, quais sejam,
documentos, pastas, programas e réplicas.

Get Info de Documentos

Ao solicitar informações de um documento, é lançada uma janela com o ícone do arquivo,
programa de origem, tamanho, localização, datas de criação e modificação, versão, cor de
etiqueta e comentários pessoais.

Você pode alterar o nome do documento, simplesmente apagando o nome atual e digitando
outro. Além disso, é possível fazer anotações na janela Comments. Estas notas poderão ser úteis
na identificação posterior do arquivo.

No rodapé da janela você encontra dois botões de seleção: o botão Locked (“travado”)
tranca o arquivo, de modo que o mesmo não poderá ser jogado fora por algum “usuário incauto”
(veja como esvaziar a Lixeira com arquivos travados, no Capítulo 02).

Criando Gabaritos

O botão Stationery Pad (Bloco de Gabaritos) gera um gabarito, que é usado para definir o
padrão de layout de papéis timbrados, envelopes, capas de trabalhos e outros documentos. Ao dar
um duplo-clique num gabarito, é lançado o programa aplicativo de origem com uma janela de
documento sem nome, contendo todas as características do modelo, tais como configuração de
páginas e logotipos.
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A Janela Get Info mostrando informações sobre um documento criado no processador de textos Nisus
Writer. Podem ser verificados o nome do aplicativo de origem, o tamanho do documento, sua localização
no disco rígido, datas de criação e modificação, versão do software gerador, cor de etiqueta, comentários e
caixas de seleção de travamento e bloco de gabaritos.

Alguns aplicativos têm a capacidade de gerar gabaritos. No Microsoft Word eles são
chamados de Templates (modelos) e no AppleWorks eles são Stationery (Impressos). Mas nem
todos os programas conseguem criá-los.

Graças à funcionalidade do Mac OS, qualquer documento, feito em qualquer aplicativo
pode ser transformado num gabarito. Vejamos como isso pode ser útil na prática.

Imaginemos que você criou, no AppleWorks, um documento sensacional — uma capa de
trabalho belíssima para a sua pesquisa sobre “Elucubrações Psicodélicas de Freud”. Você gostou
tanto dessa capa que gostaria de usar o mesmo layout em todas as outras monografias que for
escrever. Uma opção é, dentro do AppleWorks, salvar o trabalho como Stationery. Esse é o modo
como normalmente são criados formulários, de “dentro” dos aplicativos.

A caixa Open/Save do AppleWorks. Ao marcar o botão de
rádio da direita, você cria um documento Stationery — um
gabarito que gera documentos padronizados em branco.

Outra opção é, no Finder, transformar o
documento em um gabarito.

Para Criar um Gabarito no Mac OS:

1 Selecione o item com o mouse e dê um Get
Info (Menu File › Get Info — atalho z + I ou control-
clicando para gerar um menu contextual).

2 Na janela do Get Info, marque a caixa de seleção Stationery Pad. Observe como o ícone
do documento é alterado, indicando a mudança no tipo de arquivo.

Ícones do mesmo documento; à esquerda, em seu estado comum —
no caso a capa do trabalho que você gostou e deseja usar como
padrão. À direita, o documento como gabarito. Observe a sutil
alteração: uma folha em branco aparece por detrás do ícone anterior.

Você criou um formulário padronizado. Experimente clicar no novo ícone. O AppleWorks é
lançado e surge um documento sem nome, pronto para ser editado, tendo como base a formatação
do arquivo de origem. Caso você queira transformar seu gabarito novamente em arquivo comum,
basta dar outro Get Info e desmarcar o botão Stationery Pad.
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Get Info de Pastas

As informações de pastas não disponibilizam os botões de Locked e Stationery Pad. As
pastas do Sistema e Aplicativos, podem ser trancadas, mas para isso será necessário usar o Painel
de Controle General Controls. Fica claro que a função Stationery Pad só se aplica a documentos,
como vimos acima.

Você pode digitar notas no campo Comments, o que se revela muito útil para quando é
necessário lembrar de conteúdos de pastas com nomes obscuros. Dando um Get Info naquela
velha pasta “Abobrinhas”, guardada há anos no fundo de seu HD, é possível relembrar, pelos
Comments, que se trata de uma série de poemas escritos nas madrugadas secas do inverno de
1997, em Brasília.

Get Info de Programas

Quando você dá um Get Info de um aplicativo, o menu Show, da janela Get Info, apresenta
as opções General Information, Sharing (que não será tratada neste livro) e Memory. Mais
adiante, neste mesmo capítulo, você obterá informações sobre como personalizar a memória
alocada para os programas.

Get Info de Réplicas

Ao solicitar informações de réplicas é mostrada a localização do arquivo original. Caso este
tenha sido mudado de pasta, ou haja o interesse de vincular a réplica a outro programa,
documento ou pasta, é possível acionar o recurso Select New Original… e definir o novo vínculo.

Analisaremos a opção Label mais adiante, neste mesmo capítulo. Por ora basta enfatizar que
as cores dos itens podem ser definidas na própria janela Get Info. Isso gera um ganho de
produtividade significativo para aqueles que classificam seus arquivos por cores.

À esquerda, Get Info de programa aplicativo — no caso, o QuickTime. Veja que não há a opção de
Stationery Pad, que é disponível somente para documentos. Por outro lado, surge um menu pop-up através
do qual você pode buscar informações gerais, de rede ou de memória do aplicativo. À direita, Get Info de
uma réplica.

Personalizando a Memória dos Programas
Para rodar o Sistema e outros programas, o computador utiliza memória RAM (Random

Access Memory — Memória de Acesso Aleatório). Todos os documentos não gravados também
encontram-se nessa memória até serem devidamente salvos no disco rígido. Ao desligar o
aplicativo, é liberada a quantidade de RAM que o mesmo estava utilizando. Moral da história:
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Quanto mais memória RAM instalada no computador, mais programas podem estar abertos ao
mesmo tempo.

Quando você instala um aplicativo, é configurada automaticamente a quantidade de
memória que o mesmo vai utilizar cada vez em que for lançado. Algumas vezes, no entanto, será
preciso alterar essa configuração. Isso porque um mesmo programa apresenta diferentes
exigências de memória, considerando os tipos de arquivos que estão abertos ou sendo
trabalhados. Um documento com cinco linhas de texto exige pouca memória. Um documento
com 200 páginas e várias figuras exige mais RAM para ser editado ou mesmo permanecer aberto.

Para obter informações ou editar configurações de memória, marque o aplicativo com o
mouse e selecione Menu File › Get Info › Show Memory. O campo Suggested Size mostra a
quantidade de memória sugerida pelo fabricante do programa.

Os campos de informação e ajuste de memória RAM para o aplicativo. Ajuste a memória a ser
disponibilizada pelo Sistema para cada programa, de acordo com as suas necessidades.

O campo Minimum Size mostra a exigência mínima de memória para que o aplicativo seja
utilizado. Para reduzir a quantidade de RAM alocada, digite o valor mínimo requerido no campo
Preferred Size. A partir daí o programa funciona usando menos memória.

O problema com essa opção é que pouca RAM disponível gera lentidão, congelamentos e
quedas freqüentes (leia mais sobre isso no Capítulo 12). Daí, meu conselho é que você só use
essa configuração de memória mínima em casos muito drásticos (eu mesmo nunca a utilizei — e
não perdi nada com isso).

O campo Preferred Size é um campo de edição livre, onde você define a quantidade que
quiser (e puder) de RAM para o programa. Principalmente os aplicativos gráficos ou de criação e
edição de som e imagem vão exigir memória extra.

Os requisitos preferenciais de RAM serão menores se a memória virtual estiver ativada. A
janela Get Info exibe uma nota que indica essas mudanças de exigência de memória.

Mac OS X, Multitarefa Preemptiva e Memória Protegida

Até a versão 9, o Mac OS tem a capacidade de executar vários
programas ao mesmo tempo, através de um sistema chamado
multitarefa cooperativa. Cada aplicativo, ao ser lançado, ocupa um
pedaço da memória RAM. Quanto uma tarefa é finalizada ou o
aplicativo é fechado, essa memória é devolvida.

Os aplicativos, no entanto, às vezes cometem erros, ao não devolver a memória utilizada ou
ao tentar usar uma parte da memória que está destinada a outros programas ativos. O resultado
disso são os quits inesperados (o programa simplesmente some da tela e surge uma mensagem de
erro do aplicativo), o travamento do Sistema e os terríveis restarts forçados (falarei mais sobre
isso no Capítulo 12).

Espera-se que o Mac OS X resolva esse problema. A estrutura do novo Sistema se baseia no
Darwin, um kernel que possui serviços padrão BSD Unix 4.4. O Darwin terá a capacidade de
oferecer serviços de “alocação de memória virtual permanente, controle de tarefas preemptivas e
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dispositivos periféricos, vários sistemas de arquivos e protocolos de redes” (Brockerhoff, 2000, p.
56).

Multitarefa Preemptiva

No Mac OS X, as tarefas do Sistema terão prioridade sobre os aplicativos. Cada programa
receberá automaticamente os recursos de que necessita e, caso um deles apresente um problema,
as tarefas do Sistema não serão afetadas por isso. Isso reduzirá drasticamente os travamentos
ocasionados por falhas nos aplicativos.

Memória Protegida

O gerenciamento de memória no Mac OS X será tremendamente otimizado. Não será mais
necessária a alocação manual de memória para os aplicativos. O próprio Sistema providenciará
isso quando necessário e cada programa utilizará a quantidade de memória exata de que precisa
para funcionar com excelência — nem mais, nem menos.

Além disso, um aplicativo não poderá mais “roubar” memória de outro, uma vez que o
Darwin isolará os espaços de memória destinados a cada programa ativo. No caso de problemas,
o Sistema simplesmente fechará o processo que “estiver atrapalhando o andamento dos demais
aplicativos, permitindo que o trabalho seja continuado sem interrupção” (Proença, 2000, 7).

Todas essas novidades são mais do que suficientes para fazer com que os usuários de Macs
aguardem com ansiedade a chegada do OS X.

Personalizando Ícones
No Capítulo 01 eu mostrei que o Mac OS é um Sistema no qual você trabalha utilizando

uma interface gráfica. Ao compartilhar arquivos com amigos, navegar na Internet ou mesmo
adquirir CD-ROMs de revistas para Macintosh, você encontra diversas novas figuras que podem
ser usadas para personalizar o computador, dando uma “cara nova” a suas pastas, documentos e
aplicativos.

Os ícones são personalizados facilmente utilizando os recursos de copiar e colar do Finder.

Para Alterar o Ícone de um Item:

1 Localize o item cujo ícone você deseja copiar e marque-o com o mouse.

2 Dê um Get Info (Menu File › Get Info ou o atalho z + I).

3 Na janela Get Info, marque a figura com o mouse e clique uma vez sobre ela. Surge uma
moldura, indicando sua seleção.

Um ícone selecionado de um CD. Na janela Get Info, clique sobre ele para selecioná-lo. Suas bordas se
tornam visíveis, revelando que ele está pronto para ser copiado.

4 No menu Edit, solicite a cópia da figura: Edit › Copy ou z + C.

5 Localize agora a pasta ou documento cujo ícone você deseja alterar. Repita os passos 2 e
3.
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6 No menu Edit, solicite “colar” (Paste ou z + V).

O ícone do objeto anterior é colado na nova pasta ou documento. Você pode repetir o
procedimento alterando os ícones de pastas, arquivos e programas.

A pasta com o novo ícone. Nova vida para os itens do Finder.

Caso você queira que o item retome o ícone padronizado do Sistema, dê um novo Get Info,
selecione a figura e pressione uma das teclas Delete.

Organizando Objetos Por Cores
A opção Label (Etiqueta) possibilita a identificação de arquivos utilizando cores. Alguns

documentos podem ser etiquetados de vermelho, e classificados, por exemplo, como “Projetos
em Andamento”. Arquivos de uso comum entre dois ou mais usuários podem ser etiquetados na
cor verde, representando que foram “compartilhados”, e assim por diante.

Alguns usuários usam Labels apenas para colorir ícones. Tudo bem. Você altera as cores
dos itens de acordo com o seu estilo de trabalho.

O submenu de cores de labels, acionado quando você seleciona Menu File › Label.

Para Colorir Objetos:

1 Clique uma vez no objeto com o mouse.

2 Selecione Menu File › Label › Opção de Cor. O documento, pasta ou aplicativo
selecionado é colorido com a cor escolhida, sendo que cada cor corresponde a uma legenda
específica.

Para Alterar Legendas de Cores:

1 No Finder, selecione Menu Edit › Preferences. É aberta uma janela de preferências.

2 Na janela de preferências, selecione a guia Labels e nomeie as cores como lhe parecer
melhor.
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Outra grande utilidade das Etiquetas é a organização de Painéis de Controle e Extensões,
principalmente nos momentos de instalação de novos programas. Você aprenderá como fazer isso
no Capítulo 12.

Duplicando arquivos
Documentos, pastas ou programas podem ser duplicados instantaneamente. Ao fazer isso, a

cópia permanece no mesmo lugar onde se encontra o original, com o mesmo nome do arquivo,
seguido de “.copy”. Diferentemente da réplica, o arquivo duplicado é idêntico ao original,
ocupando a mesma quantidade de memória de disco. Para economizar espaço, procure não
manter arquivos duplicados no mesmo disco rígido.

Para duplicar um arquivo, marque-o com o mouse e selecione Menu File › Duplicate ou z +
D. Outra forma de realizar essa tarefa rapidamente é clicar sobre o item e arrastá-lo, mantendo
apertada a tecla Option.

A duplicação de itens é bastante útil, principalmente quando você deseja editar um arquivo
com segurança, criando uma duplicata e trabalhando nela, preservando o original intacto.

Criando Réplicas
As réplicas ou aliases já foram explicadas no Capítulo 01. A opção Menu File › Make Alias

(ou z + M) produz uma réplica que pode ser afixada na Mesa, agilizando o acesso a pastas,
documentos ou programas.

Outra maneira de fazer rapidamente um alias: selecione o item, aperte simultaneamente as
teclas z + Option e arraste com o mouse.

Adicionando Itens à Pasta Favorites
No Capítulo 03 eu falei sobre como usar a opção Add To Favorites para incluir itens à pasta

Favorites, que é uma das novidades do Mac OS a partir do Sistema 8.5.
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99Mac OS

Retornando Objetos da Lixeira
O comando Put Away (z + Y, “Dispensar”, no OS 9 em português) retorna itens da Lixeira.

Você pode obter informações sobre como fazer isso na seção “A Lixeira do Mac”, no Capítulo
02.

Protegendo Arquivos dos “Curiosos”
O recurso Encrypt, presente a partir do OS 9, permite que você

tranque seus arquivos, de tal forma que ninguém possa abri-los. Um
arquivo encriptado só pode ser aberto através de uma senha predefinida.

Isso é possível graças a um programa denominado Apple File Security, que transforma os dados
dos arquivos em um algoritmo — uma espécie de linguagem matemática secreta.

Ao encriptar um arquivo, o Sistema elimina o original, ficando com uma cópia comprimida.
Isso quer dizer que, além de você ficar com seus arquivos protegidos, estes ocupam menos
espaço no disco rígido. Sensacional.

Como Encriptar um Arquivo:

1 Selecione o arquivo desejado.

2 No Menu File, escolha a opção Encrypt. Surge a caixa de diálogo Apple File Security. Nas
duas primeiras janelas, digite sua senha. Marque a caixa de seleção Add to Keychain, caso deseje
que sua senha seja guardada no “Chaveiro” do Mac OS (você obterá mais informações acerca do
Keychain no Capítulo 10). Clique no botão Encrypt. Outra forma de fazer isso é dar um control-
clique no arquivo e utilizar o menu contextual.

3 Surge uma janela que mostra o andamento da tarefa. Logo depois, o ícone do arquivo
passa a exibir uma pequena chave, indicando a encriptação.

Ao clicar sobre um arquivo encriptado, surge uma caixa de diálogo solicitando a senha do
usuário. Entenda que isso não é sinônimo de proteção perfeita. Existem hackers que passam o
tempo arranjando formas para destrancar arquivos criptografados.
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Um detalhe importante: Não é possível encriptar pastas ou discos. Uma forma de contornar
essa limitação é comprimir a pasta ou disco utilizando uma ferramenta de compactação (veja
como fazer isso no Capítulo 08). O arquivo comprimido poderá ser facilmente encriptado.

Procurando Coisas
A opção Menu File › Find (z + F) aciona o Sherlock (Find File, no OS 8), uma poderosa

ferramenta de busca, que lhe permite localizar qualquer coisa no computador, utilizando diversos
critérios de busca. No Capítulo 03 dediquei uma seção ao Sherlock.

Procurando Coisas … na Internet
A partir do Mac OS 9, surge a opção Menu File › Search Internet…

(z + H), que lança o Sherlock, acionando os plug-ins de busca na Internet.
Veja como isso funciona no Capítulo 03.

Localizando Originais
Para localizar o original de uma réplica, dê um Get Info, conforme explicado acima, ou

selecione Menu File › Show Original (z + R). A diferença é que, com o Get Info será obtida
apenas a informação da localização do original. Através do Show Original, o Sistema abre
automaticamente a pasta onde o original está guardado, dispondo-a na Mesa para seu uso.

Configurando Página Para Impressão
A opção Page Setup... possibilita configurar um tamanho de página para imprimir a Mesa ou

uma janela ativa. Selecione Menu File › Page Setup... para abrir o painel de configuração. Defina
o tamanho do papel utilizado para imprimir dentro das margens configuradas na impressora
instalada.

Imprimindo a Mesa ou o Conteúdo de Janelas
O usuário Macintosh conta com um recurso não disponível para os usuários Windows (pelo

menos até a versão Windows 98), que é a impressão da Mesa ou de uma janela.

Para imprimir a Mesa:

1 Selecione Menu File › Print Desktop.

2 Ajuste o modo de impressão na caixa de diálogo de sua impressora.
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3 Solicite “imprimir”.

Para Imprimir o Conteúdo de Pastas:

1 Abra a pasta cujo conteúdo você deseja imprimir.

2 Defina a forma de visualização dos itens da pasta selecionando Menu View › View as
Icons, Buttons ou List (obtenha mais informações sobre esses modos de visualização no Capítulo
06).

3 Note que ocorre uma mudança no menu. Em lugar de Print Desktop você encontra Print
Window. Selecione Menu File › Print Window.

4 Ajuste o modo de impressão na caixa de diálogo de sua impressora.

5 Solicite “imprimir”.

Ainda Tem Mais
Vimos que o Menu File é importantíssimo para a execução de diversas tarefas com o

computador. Você notou, além disso, que um tempo significativo é ganho quando memorizamos
os diversos atalhos de teclados, todos disponíveis no próprio menu, normalmente iniciados com a
tecla Command (z).

Parabéns por chegar até aqui! Sinto que você está levando a sério o seu aprendizado.
Continue firme, pois a perseverança conduz à excelência. Vá até a cozinha, prepare um sanduíche
e um suco de laranja. Depois lanche, descanse no sofá e... tudo bem, você não conseguirá resistir
mesmo. Volte logo para seu Mac e abra no capítulo seguinte, para conhecer as “manhas” do
Menu Edit do Macintosh.
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05
Conhecendo o Menu Edit

e você já utilizou um programa de processamento de textos, de certa forma está
familiarizado com ferramentas de edição. Elas são usadas para desfazer uma ação, além de
recortar, copiar, colar, apagar e selecionar coisas. O menu Edit presta-se a tais tarefas.

Além disso, é através dele que você checa o conteúdo da Área de Transferência (Clipboard) e
altera algumas configurações de visualização e funcionamento do Finder.

Na barra de menus, escolha o Menu Edit (Editar). Aparece a lista de itens a serem acionados.

Observe as figuras abaixo, que mostram menus de edição dos programas AppleWorks e
Simple Text

À esquerda, Menu Edit do AppleWorks. À direita, Menu Edit do Simple Text. Cada programa possui
recursos diferenciados. No entanto, as funções clássicas de undo (desfazer), recortar, copiar, colar, limpar,
selecionar e mostrar Área de Transferência (Clipboard) estarão normalmente presentes.

A maioria dos programas para Macintosh utiliza um menu de edição semelhante ao do
Finder, o que facilita tremendamente o uso desses aplicativos, devido à similaridade de

S



54 — MANUAL DO POKAPRÁTICA

interfaces. Ao conhecer as funções de edição do Finder, você terá mais facilidade para lidar com
os menus de edição de praticamente todos os programas de seu Mac!

Atalhos do Menu Edit
Os atalhos do menu Edit podem ser visualizados facilmente. Clique sobre o menu com o

mouse, e note que são mostradas as opções de trabalho com seus respectivos atalhos.

Copiando e Colando
As quatro primeiras opções do Menu Edit prestam-se, principalmente, a ações relacionadas

a transferência de conteúdos entre arquivos ou aplicativos. Você pode, por exemplo, copiar um
texto feito no Microsoft Word e colá-lo no AppleWorks, no Adobe® PageMaker® ou mesmo no
Adobe® Illustrator®, que é um programa de desenho vetorial. Você pode copiar uma imagem de
um trabalho de ciências feito no AppleWorks e aplicá-la numa página de apresentação do
Microsoft PowerPoint. E assim indefinidamente.

De certo modo isso já foi mostrado no Capítulo 4, na seção “Personalizando Ícones”. O
princípio é o mesmo em todos os aplicativos.

Para Transferir Conteúdos Usando as Funções “Copiar › Colar”:

1 Localize e selecione com o mouse o texto ou objeto que deseja transferir.

2 Copie esse conteúdo usando o comando Copy (Copiar) ou o atalho z + C, no Menu Edit
(Editar).

3 Marque com o mouse o local onde deseja afixar o conteúdo, em outra janela de
documento do mesmo programa de origem ou na janela de documento de outro programa.

4 Cole o conteúdo usando o comando Paste (Colar) do Menu Edit, ou o atalho z + V.

Procedendo dessa forma você transfere o conteúdo preservando o arquivo original. No final
do processo, você tem em seu computador dois arquivos com conteúdos semelhantes (por
exemplo, um trabalho de ciências feito no AppleWorks e uma apresentação do Microsoft
PowerPoint com fotos idênticas de Albert Einstein).

Para Transferir Conteúdos Usando as Funções “Recortar › Colar”:

1 Localize e selecione com o mouse o texto ou objeto que deseja transferir.

2 Copie esse conteúdo usando o comando Cut (Recortar) ou o atalho z + X, no Menu Edit
(Editar).

3 Marque com o mouse o local onde deseja afixar o conteúdo, em outra janela de
documento do mesmo programa de origem ou na janela de documento de outro programa.

4 Cole o conteúdo usando o comando Paste (Colar) do Menu Edit, ou o atalho z + V.

Procedendo dessa forma você transfere o conteúdo eliminando-o do arquivo original. No
final do processo, você tem em seu computador apenas um arquivo com o conteúdo transferido
(no caso, a figura de Albert Einstein é eliminada do arquivo do trabalho de ciências feito no
AppleWorks e passa a constar apenas na apresentação do Microsoft PowerPoint).

# A função Cut (recortar) do Menu Edit deve ser utilizada com cuidado, pois elimina o
arquivo original.

4 A função Copy (copiar) apenas transfere o item para área de transferência, preservando
o arquivo de origem.
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Armazenando Conteúdos na Área de Transferência
Quando você copia ou recorta um conteúdo, seja texto, figura, imagem, som etc., ele fica

armazenado no Clipboard ou “Área de Transferência” até que o computador seja reinicializado
ou que você realize outra ação de copiar/recortar e colar.

Para ver o que está guardado na Área de Transferência, solicite Menu Edit › Show
Clipboard. Surge uma janela parecida com esta:

Verificar o que está no Clipboard é bastante útil quando você quer ter a certeza de que o
conteúdo que será colado em seu trabalho é realmente o desejado.

Desfazendo Ações
Caso você queira desfazer uma ação, vá até o Menu Edit e escolha Undo, ou aperte as teclas

z + Z. Voilá! O Macintosh retorna à situação anterior ao seu “erro fatídico”.

O Undo retorna o Finder para a situação antes de seu último comando, nas tarefas de cortar,
copiar e colar do Menu Edit. Isso é particularmente útil quando você renomeia uma pasta ou
objeto, por exemplo, e deseja voltar ao título original, antes de terminar a digitação.

É possível desfazer uma ação ainda usando o menu contextual. Basta clicar em qualquer
ponto da Mesa ou janela pressionando a tecla Control. Surgirá o menu com a opção de desfazer a
ação.

Essa função retorna apenas à sua última ação. Alguns programas permitem diversos undos,
tais como o Microsoft Word (até 100 undos), o Nisus Writer (undos ilimitados), o Macromedia
Dreamweaver, o Adobe® Photoshop® e outros. Mas fique tranqüilo, pois para as tarefas básicas
de transferência de conteúdo e renomeação de arquivos, undos ilimitados não são realmente
necessários. Para ser sincero, nos últimos quatro anos de uso do Macintosh, raramente usei o
undo do Menu Edit do Finder (não posso dizer o mesmo dos undos dos programas de
processamento de texto!).

Outra limitação do Undo é que ele não se aplica a outras tarefas do Finder. Seria
interessante se você pudesse desfazer também outras ações tais como cópias, movimentação de
arquivos, criação de aliases, criação de pastas e coisas assim. Em versões anteriores do Mac OS
alguns desses recursos estavam disponíveis no Undo, mas isso agora não é mais possível.
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A Função Clear
A opção Menu Edit › Clear presta-se, principalmente, à edição de nomes de arquivos.

Um arquivo do Microsoft Word visualizado como botão (acerca de modos de visualização, consulte o
Capítulo 06).

No exemplo acima, note que o arquivo do Microsoft Word está nomeado como “Palestra
Sociologia”. Você pode renomeá-lo pelo Finder, usando o Menu Edit.

Para Renomear Um Arquivo Usando o Menu Edit:

1 Dê um Clique com o mouse no nome do arquivo. Este muda de cor, indicando a seleção.

O arquivo do Microsoft Word após um clique simples.

2 Vá até o Menu Edit e escolha a opção Clear. O nome do arquivo simplesmente é
eliminado, surgindo um ponto de inserção no lugar.

Após o comando Menu Edit › Clear, o nome original do arquivo desaparece, gerando espaço para a
digitação de um novo nome.

3 Digite o novo nome do arquivo. No caso, simplesmente “Sociologia”.

O novo nome é digitado, sem complicações.

Caso deseje voltar a ação, proceda como indicado na seção acima, utilizando a opção Menu
Edit › Undo, o atalho z + U ou o menu contextual.
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Alterando Preferências do Finder
Selecionando Menu Edit › Preferences, surge a janela de alteração das preferências do

Finder.

Guia General
A guia General define três aspectos básicos

do Finder, quais sejam, Finder Simplificado, Pastas
Automáticas e Espaçamento de Grade.

Finder Simplificado

A caixa de seleção Simple Finder aciona o
“Finder Simplificado”, indicado para usuários
iniciantes que não utilizam ainda todos os recursos
do Sistema. Desta forma, menos comandos de
menu ficam disponíveis.

O Menu Edit no Simple Finder. Observe que Somente os comandos
essenciais estão presentes (as opções Undo, Clear e Show Clipboard
deixam de constar no menu).

O Simple Finder elimina também as Janelas Pop-up. Isso quer dizer que, se de um lado esta
opção parece facilitar a vida do usuário, por outro, impede o acesso a recursos importantes do
Sistema. É por isso que eu prefiro o Finder padrão.

Pastas Automáticas

A caixa de seleção Spring-Loaded Folders aciona as Pastas Automáticas, já explicadas  no
Capítulo 01. Se você não deseja este recurso, desmarque-o agora mesmo.

Grid Spacing

Próximo ao rodapé da janela você encontra os modos de configuração de espaçamento de
grade do Finder. Botões de rádio oferecem duas opções. A primeira é “Tight” ou espaçamento
justo, que possibilita colocar mais itens em um menor espaço. Apesar do ganho de espaço ela
gera um resultado visual não muito agradável.

A segunda opção, padrão do Mac OS, é “Wide” ou espaçamento largo, e define um Finder
mais elegante, com ícones mais espaçados.

Guia Views
A guia Views padroniza os tipos de visualização do Finder.

Um menu pop-up possibilita definir como o Mac OS vai mostrar os conteúdos da Mesa ou
das janelas nos modos listas, ícones e botões (veja mais informações sobre estes três tipos de
organização do Finder no Capítulo 06).
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Standard View Options for List
Esta seleção do menu pop-up define o padrão para visualização de janelas por lista. Duas

colunas dispõem uma série de caixas de seleção, nas quais você pode marcar as configurações de
acordo com as suas preferências:

Defina aqui padrões de visualização por lista.

" Use relative date: Ao invés de mostrar datas absolutas, o Finder usa as palavras “hoje”
(today) e “ontem” (yesterday), tanto para os registros de criação como de modificação de
arquivos.

" Calculate folders sizes: Quando marcado em conjunto com a opção Size, mostra o
tamanho das pastas da janela.

" Date Modified: Mostra a data de modificação dos arquivos.

" Date Created: Mostra a data de criação dos arquivos.

" Size: Mostra o tamanho dos arquivos.

" Kind: Mostra o tipo de arquivo (uma planilha do Excel, um documento do processador
de texto do AppleWorks etc.).

" Label: Mostra os atributos da cores das etiquetas.

" Comments: Mostra os comentários dos arquivos. Falei sobre comentários no Capítulo
04, na seção “Get Info de Pastas”.

" Version: Mostra a versão dos programas aplicativos listados.

Três botões de rádio, situados no canto inferior esquerdo da janela, definem os tamanhos
dos ícones a serem mostrados na lista.

Standard View Option for Icons

Esta seleção do menu pop-up define o padrão para visualização de janelas (ou da Mesa) por
ícones. Três botões de rádio permitem definir critérios de arranjo dos ícones.

Defina aqui padrões de visualização por ícones.
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" Botão None: Com essa opção marcada os ícones podem ser movidos livremente. É a
forma padronizada do Mac OS mostrar a Mesa.

" Botão Always snap to grid: Alinha os itens à grade, forçando um alinhamento.

" Botão Keep arranged: Ativa um menu pop-up através do qual você define os critérios de
organização: por nome, datas de modificação e criação, tamanho, tipo de arquivo e
etiquetas.

O menu pop-up acionado pela seleção do botão de rádio Keep arranged: várias opções de organização.

Dois botões de rádio permitem a definição de tamanho dos ícones.

Standard View Options for Buttons

Esta seleção do menu pop-up define o padrão para visualização de janelas (ou da Mesa) por
botões. Existem muitas possibilidades de configuração, exatamente iguais à visualização por
ícones.

Os critérios definidos na guia Views são aplicados a todas as janelas-padrão do Finder,
gerando uma interface consistente. É claro que sempre existe a possibilidade de você organizar
uma janela em particular de acordo com padrões bem específicos, diferentes de todas as outras
janelas do Finder. Você verá como fazer isso no Capítulo 06.

Guia Labels
A guia Labels mostra a sete cores das Etiquetas de organização do Mac OS, tendo diante

delas caixas de texto que podem ser alteradas de acordo com as suas necessidades. Clique em
uma caixa de texto, apague o título anterior e digite um novo título. Obtenha mais informações
sobre organização de itens usando Labels nos Capítulos 04 e 12.

Selecionar Tudo
Por último, o Menu Edit disponibiliza o recurso de selecionar todos os itens da Mesa ou de

uma janela. No Capítulo 01 você já aprendeu que pode selecionar todo o conteúdo de uma janela
simplesmente arrastando ou shift-clicando com o mouse. Selecionando Menu Edit › Select All
(ou usando o atalho z + A), todo o conteúdo da Mesa é selecionado. Clicando numa janela e
dando um Select All, todos os seus itens são selecionados.

O comando Select All encontra-se em quase todos os programas aplicativos existentes. Ele
pode ser usado para selecionar todo o texto de um documento de processador de textos, todas as
células de uma planilha de cálculos ou todas as camadas de um desenho no AppleWorks.

Aqui terminamos nossa exploração do Menu Edit. O próximo capítulo é cheio de novidades,
revelando os segredos do Menu View.
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06
Conhecendo o Menu View

o capítulo anterior você aprendeu, através do Menu Edit, a alterar preferências do Finder.
Isso inclui o estabelecimento de padrões de visualização por ícones, botões e listas.
Lembre-se que o Mac OS oferece a possibilidade de visualizar as janelas de modo

consistente, ou seja, você vê todas as coisas em sua tela organizadas segundo critérios
semelhantes, de acordo com suas necessidades especificadas na Guia Views, da janela de
alteração de preferências do Finder (Menu Edit › Preferences › Guia Views).

Agora é hora de conhecer o Menu View. Com ele você diz ao Macintosh como deseja
visualizar a Mesa ou janelas específicas, aciona e desativa Janelas Pop-Up, limpa e organiza
Mesa e janelas. Você entenderá também como as colunas das janelas visualizadas como lista
podem ser arrumadas utilizando o recurso de clicar, arrastar e soltar do Mac OS.

Na barra de menus, escolha Menu Views (Visualizar).

Todas as janelas do seu computador podem ser vistas como ícones, botões ou listas (os itens
da Mesa ou Desktop podem ser visualizados como ícones ou botões). Como já foi dito no
Capítulo 01, a partir do Mac OS X, o modo de visualização por botões será substituído pela
visualização por Colunas. Não existe uma forma correta ou padrão único de visualização dos
arquivos do Mac. Isso é algo muito pessoal. Faça como quiser e seja feliz.

Usando o Menu Contextual
O Menu View não apresenta atalhos de teclado. No entanto é possível agilizar muitas de

suas tarefas utilizando o menu contextual. Simplesmente control-clique a Mesa ou janela para a
qual você quer atribuir novos critérios de organização. Surgirá o menu contextual
disponibilizando os comandos necessários.

A maioria das tarefas do Menu Views pode ser feita utilizando o menu contextual.

N
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Organizando Janelas
Ao visualizar uma janela como lista, seus itens são arranjados por ordem alfabética (isso

pode ser alterado, como veremos adiante, mas esse é o padrão). Além disso seus arquivos são
dispostos um debaixo do outro, alinhados à esquerda de cada coluna. Isso significa que uma lista
sempre estará “organizada”, pelo menos segundo esse critério mínimo.

Ao visualizar como ícones ou botões, é possível encontrar as coisas mais ou menos assim:

Bagunça total! Note que na Barra de Informações
não há o ícone de organização predefinida. Os
ícones ou botões estão aninhados de modo bastante
confuso.

O Menu View ajuda a por ordem nas
coisas. Isso pode ser feito através de três

recursos básicos: Clean Up, Arrange e View Options.

Clean Up
O recurso Clean Up (limpar) organiza os itens da janela (ou do Desktop) ajustando-os à

grade. Isso já é uma grande ajuda, pois elimina a superposição de ícones ou botões. Os objetos
são colocados lado a lado, de acordo com o distanciamento definido nas preferências do Finder
(eu já falei sobre isso no Capítulo 05).

Para Limpar Itens das Janelas ou Mesa:

1 Com um clique simples, marque a janela ou o Desktop.

2 Selecione Menu Views › Clean Up.

Selecione Clean Up, no Menu Views, para organizar os itens da Mesa ou janelas.

Dê agora uma olhada na janela recém-organizada. Os itens estão arranjados lado a lado,
simplesmente fixados à grade. Eles não estão dispostos segundo nenhum critério de ordenação
(alfabética, datas etc.). Use o Clean Up caso deseje apenas alinhar os elementos da Mesa ou de
uma janela, sem preocupar-se com qualquer outro tipo de organização. Confesso que esse é o
modo que eu mais uso para “ajeitar” os ícones ou botões do meu Desktop.
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A janela organizada utilizando o Clean Up. Os itens
são “fixados” à grade.

Arrange
O recurso Arrange permite aprimorar a

organização dos itens em suas janelas e Mesa,
utilizando critérios tais como data de criação e
modificação, tamanho, tipo de arquivo, etiqueta
(Label) ou comentários.

Para Organizar com o Arrange:

1 Com um clique simples, marque a janela ou o Desktop.

2 Selecione Menu Views › Arrange › Critério de organização (nome, data de criação ou
modificação, tamanho etc.).

Observe como a janela fica diferente quando eu peço ao Mac OS para arranjar os itens por
ordem alfabética (Menu Edit › Arrange › by Name).

A janela organizada usando Arrange › by Name: os itens são arranjados por ordem alfabética.

Depois de organizados por esse critério, basta redimensionar a janela até os ícones ou botões
apresentarem-se como você desejar.
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View Options…
O recurso View Options é usado quando você deseja especificar mais detalhes em sua forma

de ver uma janela ou a Mesa. Ao acionar Menu Views › View Options… é lançada uma caixa de
diálogo parecida com a figura abaixo. Note que as opções de visualização são exatamente as
mesmas da guia Views das preferências do Finder.

Essa caixa de diálogo surge quando você marca a Mesa com o
mouse e depois seleciona Menu View › View Options. Observe o
ícone da Mesa no canto superior esquerdo.

Um detalhe, no entanto, é digno de nota: no canto inferior esquerdo existe o botão Set to
Standard Views. Ele é usado quando você deseja que a Mesa ou janela seja novamente vista de
acordo com os critérios definidos por você nas preferências do Finder. Isso é bastante útil quando
você utiliza uma forma de visualização de uma janela por um determinado tempo — até terminar
uma tarefa, por exemplo — e depois resolve voltar a vê-la da forma padronizada.

Visualizando Como Ícones
Selecionando Menu Views › as Icons, os itens da janela ou Mesa são mostrados como

ícones. Esse modo de visualização facilita a identificação dos arquivos. Lembre-se de que no
Capítulo 01 eu disse que no Macintosh você trabalha com objetos representados por ícones ou
figuras.

Um aplicativo, no caso o AppleWorks, visualizado como ícone. Normalmente será necessário um clique
duplo para lançá-lo.

Em outros Sistemas operacionais você é quase que forçado a identificar os aplicativos por
suas terminações nominais, as chamadas extensões  (.doc, .zip, .exe). No Mac você os identifica
por sua aparência. Daí a funcionalidade de visualização por ícones. De modo geral, aquilo que é
visto como ícone é acionado a partir de um clique duplo do mouse. Existem exceções: mesmo na
visualização como ícones, alguns aplicativos são lançados quando você arrasta algo sobre eles
(veja formas diferentes de lançar aplicativos, no Capítulo 08). Como foi visto no Capítulo 01,
graças ao recurso “Pastas Automáticas” você pode abrir pastas visualizadas como ícones, botões
ou lista, simplesmente arrastando qualquer item sobre elas.

Visualizando Como Botões
Selecionando Menu Views › as Buttons, os itens da janela ou Mesa serão mostrados como

botões.
O aplicativo Microsoft Excel visualizado como botão, podendo ser acionado com um clique
simples.
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Basicamente a única diferença entre a visualização por ícones e botões, é que esses últimos
podem ser acionados com um clique simples. Isso pode parecer um detalhe insignificante, mas o
acesso a qualquer coisa com apenas um clique gera um ganho precioso de tempo no
desenvolvimento das tarefas no Mac.

Visualizando como Lista
Selecionando Menu Views › as List, os itens são mostrados como lista.

Uma janela vista como lista. As setas diante das pastas indicam que elas armazenam outros itens.

Na janela em questão você vê duas colunas (Name e Date Modified). As pastas estão
listadas em ordem alfabética crescente e diante de cada uma delas existe uma seta apontando para
a direita, indicando que cada pasta aloja outros itens (subpastas, se quiser chamar assim,
documentos ou aplicativos). Ao clicar numa seta, esta se volta para baixo ao mesmo tempo em
que é revelado o conteúdo da pasta que está à sua frente.

Ao clicar na seta da Pasta Jogos, são reveladas as pastas dos games guardados dentro dela. Uau!

Os itens de uma lista são acionados mediante um clique duplo, assim como na visualização
como ícones.

Alterando Formas de Ordenação de Colunas
Quando você visualiza uma janela como lista, seus itens são mostrados organizados em

ordem (alfabética, de tamanho ou data) crescente. A coluna Name é sempre a primeira, alinhada à
esquerda da janela.

Uma janela visualizada por lista, de acordo com o padrão do Mac OS: os itens são mostrados por ordem
alfabética crescente e a coluna Name é a primeira, seguida de Size, Date Modified e Kind.
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Crescente ou Decrescente?
A ordenação pode ser alterada de crescente para decrescente. Isso é definido pela posição do

botão com o ícone de uma pequena seta listrada, situado no canto esquerdo da janela, próximo ao
ponto mais alto da barra de rolagem. A seta para cima indica que os itens da janela são listados
em ordem crescente. Ao clicar no botão a seta volta-se para baixo e os itens são listados em
ordem decrescente.

Ao clicar no botão de ordenação, a seta volta-se para baixo e os itens são mostrados em ordem
descendente.

Veja também que a coluna Name está em destaque (sua barra superior assume uma
coloração mais escura que as outras). Isso indica que os itens são listados em ordem ascendente
ou descendente com base nesta coluna. Clicando nos nomes das outras colunas, estas se tornam a
base de ordenação.

Mudando a Posição das Colunas
A coluna Name é sempre a primeira da janela. No entanto, as outras colunas podem ter seu

posicionamento alterado.

Para Mover uma Coluna:

1 Clique no nome da coluna com o mouse e comece a arrastá-la. O cursor se transforma
numa pequena mão.

2 Arraste a coluna para a direita ou para a esquerda até encontrar o lugar onde deseja
posicioná-la.

3 Solte o botão do mouse no lugar desejado. A coluna é reposicionada.

Alterando a Largura das Colunas
Ainda é possível mudar a largura de uma coluna. Para fazer isso, proceda da seguinte forma:
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1 Clique na sua linha divisória. O ícone do cursor se transforma indicando que o Sistema
está pronto para fazer a alteração.

Ao clicar na linha divisora de uma coluna, o ícone do cursor se transforma em um sinal de adição com
setas nas extremidades laterais, indicando que a coluna tanto pode ser estreitada como expandida. O Mac
está pronto para alterar a largura da coluna situada à esquerda do ícone.

2 Para expandir a coluna, movimente o mouse para a direita. Para estreitá-la, arraste para a
esquerda. Ela se retrai seguindo o movimento do mouse.

A coluna estreitada. O ícone do mouse é mais uma vez mudado, agora para uma linha reta e uma seta
apontando para a direita. Isso significa que não há mais espaço para movimentação para a esquerda (a
coluna atingiu seu estreitamento máximo).

Os conteúdos da coluna se adequam à sua largura. Note que a coluna do exemplo acima
mostrava originalmente as datas em formato expandido, revelando inclusive o horário da última
modificação dos arquivos. Ao chegar ao ponto máximo de estreitamento, a coluna passa a
mostrar apenas a data em formato resumido.

Reset Column Positions
O recurso Reset Column Positions é usado para devolver às colunas das janelas suas

posições e tamanhos originais. Para acioná-lo faça o seguinte:

1 Marque a janela com o mouse e solicite Menu Views › Reset Column Positions.

Use esse recurso para que suas colunas voltem às dimensões e posicionamentos de origem.

2 Surge uma caixa de diálogo perguntando se você deseja retornar ao layout original da
janela. Clique em OK. A janela volta ao seu formato de colunas original.
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O quadro de diálogo que surge após o comando Reset Column Positions.

Criando e Desativando Janelas Pop-Up
No Capítulo 01 eu falei sobre as janelas pop-up. Lembre-se que elas ficam instaladas no

rodapé da Mesa do Macintosh, no formato de pequenas abas e se comportam como gavetas que
são acionadas com um clique do mouse. Naquele capítulo eu ensinei como criar e desativar tais
janelas utilizando os recursos de clicar, arrastar e soltar.

Você também pode criar e desativar janelas pop-up utilizando o Menu View.

Para Criar Janelas Pop-Up Através do Menu View:
1 Marque a janela com o mouse.

2 Selecione Menu View › as Pop-up Window. A mesma se transforma numa janela local e
se mostra aberta, já alojada no rodapé de sua Mesa.

Para Desativar Janelas Pop-Up Através do Menu View:

1 Clique na aba da janela pop-up, abrindo-a.

2 Selecione Menu View › as Window. Ela volta a ser uma janela comum do Finder.
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07
Conhecendo Outros Menus

s últimos itens da barra de menus a serem conhecidos são o Menus Special, Help,
Teclados e Aplicativos. Eles complementam a eficácia dos menus iniciais, facilitando a
vida do usuário.

O Menu Special
Use o Menu Special para esvaziar a Lixeira, ejetar e apagar discos, colocar o Mac para

repousar, reinicializar e desligar o computador.

Na barra de menus, escolha Menu Special. A partir do OS 9, está presente a função Logout.

Abaixo a Sujeira!
É necessário que você esvazie a Lixeira periodicamente, por dois motivos. Primeiramente,

um lixo vazio gera um aspecto de limpeza e organização.

Mas não é apenas isso. Itens “esquecidos” dentro da Lixeira são sinônimos de desperdício
de HD, uma vez que continuam ocupando lugar no disco rígido. Ao esvaziar a Lixeira você libera
espaço precioso. Continua válida a afirmação de Langer (1994, p. 47): “Não importa o quão
grande seja o seu arquivo de aço, ele não será suficientemente grande para comportar todos os
seus arquivos”. Por isso o gerenciamento do espaço em disco (e isso inclui o esvaziamento da
Lixeira) é importante. O que você está esperando para jogar fora toda essa sujeira?!

Para esvaziar a Lixeira selecione Menu Special › Empty Trash. Surge uma caixa de diálogo
perguntando se você quer realmente remover permanentemente os arquivos que estão no lixo.

A caixa de diálogo de esvaziamento da Lixeira.

Pressione a tecla Return ou clique em OK. Sua Lixeira será esvaziada.

O

99Mac OS
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No Capítulo 02 eu falei sobre como desativar o aviso acima, jogar fora objetos travados e
retornar itens da Lixeira.

Ejetando Discos
Uma das coisas mais interessantes é observar a reação de usuários de outros tipos de

computadores e sistemas operacionais quando sentam pela primeira vez diante de um Macintosh.
Uma das perguntas mais comuns é “onde estão os botões para ejetar os CDs e os disquetes?” O
que ocorre depois é clássico: você insere um disco ou CD, marca o seu ícone na Mesa com o
mouse e então seleciona Menu Special › Eject ou usa o atalho z + E (uma terceira opção é
arrastar a ícone do disco para a Lixeira). “Milagrosa” e elegantemente, o Mac ejeta o disco ou
CD diante dos olhos esbugalhados de seu amigo! E você, fingindo modéstia, fica pensando no
quanto é bom ter um computador assim…

Apagando Discos
O recurso de apagar discos é usado para limpar e formatar as mídias de armazenamento.

Mesmos os usuários das novas máquinas da Apple — que normalmente são fabricadas sem
drives de disquetes — utilizam unidades externas tais como discos óticos, cartuchos Zip,
SuperDisk, Orb ou até mesmo CD-ROMs graváveis para armazenar seus arquivos. De vez em
quando é necessário apagar esses discos, a fim de gravar novos conteúdos ou mesmo eliminar
arquivos invisíveis insistentes, que teimam em continuar ocupando espaço mesmo depois da
reconstrução da Mesa do disco (leia sobre reconstrução de Desktop e arquivos invisíveis no
Capítulo 11).

É bom frisar que o apagamento de disco elimina irreversivelmente todas as informações
nele contidas. O disco é totalmente limpo e formatado no padrão solicitado (Mac OS padrão,
DOS ou proDOS).

O Macintosh revela o seu poder de compatibilidade ao ler e gravar discos formatados em
padrão DOS. Ao inserir um disquete no drive do computador, surge na Mesa um ícone indicando
seu formato.

Disco formatado no padrão Mac OS.

Disco formatado no padrão DOS, identificado pela inscrição “PC”.

Isso quer dizer que você pode compartilhar arquivos com usuários pecezistas sem
problemas. Grave-os em discos formatados no padrão DOS; assim eles poderão ser abertos em
qualquer computador que utilize MS-DOS ou Windows. Isso é válido para todos os documentos
gerados em aplicativos multiplataforma2.

Discos que não serão compartilhados — principalmente seus backups ou cópias de
segurança — devem ser formatados no padrão Mac OS. Somente assim eles podem ser tratados
com as ferramentas de manutenção de discos do Macintosh ou os aplicativos de otimização de
discos fabricados por outros desenvolvedores de software (falarei sobre eles nos Capítulos 11 e
12).

                                                
2 Multiplataforma significa compatível tanto com a plataforma Mac OS quanto com a plataforma PC.
Alguns programas funcionam de forma idêntica nos dois tipos de Sistemas operacionais, gerando arquivos
que podem ser abertos, lidos e editados em ambos os tipos de computadores. Como exemplos temos os
aplicativos da Adobe, Macromedia e o próprio Microsoft Office.
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Para Apagar e Formatar um Disco:

1 Marque o disco com o mouse.

2 Selecione Menu Special › Erase Disk. Surge uma caixa de diálogo perguntando se você
deseja apagar completamente o disco.

3 No campo de texto Name, digite o nome que você deseja dar ao disco. No menu pop-up
Format, escolha o padrão do formato desejado: Mac OS, DOS ou ProDOS.

A caixa de diálogo através da qual você define os parâmetros de apagamento e formatação de discos.

4 Clique no botão Erase para confirmar a realização da tarefa. O Mac mostra três janelas
informando sobre o andamento da formatação: erasing disk (apagando disco), verifying format
(verificando formato) e creating directory (criando diretório). Depois o ícone do disco surge
novamente no Desktop, formatado e nomeado segundo suas instruções.

Dica: O Mac OS suporta até 31 caracteres para nomes de arquivos e pastas e 27 caracteres
para nomes de discos. Qualquer caractere é aceito para nomeação de arquivos, com exceção do
caractere de dois pontos (:).

Ponha o Mac Para Dormir
Selecionando Menu Special › Sleep você coloca o Sistema em modo de repouso. Ao fazer

isso a tela se escurece e ocorre uma redução na velocidade de rotação do disco rígido.

Selecione Menu Special › Sleep para colocar seu HD para repousar.

Uma vantagem desse procedimento é a diminuição no consumo de energia. Além disso, ao
clicar no botão do mouse ou pressionar uma tecla, sua máquina “acorda” e isso é muito mais
rápido do que a reinicialização do Sistema.

No Capítulo 10 você aprenderá a configurar o Energy Saver, um Painel de Controle que
estipula parâmetros automáticos de repouso.

Reinicializando e Desligando o Macintosh
Ao selecionar Menu Special › Restart o Sistema é reinicializado. Outra forma de fazer isso é

apertando o botão Power e clicando na opção Restart da caixa de diálogo que surge na tela. No
Capítulo 01 eu falei de alguns motivos para a reinicialização. No Capítulo 12, discutirei sobre
alguns problemas que poderão ser solucionados utilizando-se o Restart.
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Quando você seleciona Menu Special › Shut Down, o Mac é desligado. Essa é a melhor
maneira de desativar o Sistema, pois todos os programas abertos são devidamente fechados,
oferecendo a opção de você gravar os seus trabalhos.

Alternando Entre Diversos Usuários
O Mac OS 9 permite múltiplos usuários, cada um deles com níveis

diferentes de acesso e configurações de aparências. No Capítulo 01, você
viu a tela de login de múltiplos usuários, que é acionada a cada
inicialização do computador.

O Menu Special do OS 9, possui a opção Logout (atalho z + Q), que permite a troca de
usuários sem a necessidade de restart.

O Menu Help
Através desse menu você acessa o Help Center e ativa ou desliga os balões de auxílio do

Mac OS.

Na barra de menus, escolha Menu Help. Aparecerá a lista de itens a serem acionados.

Help Center
Ao selecionar Menu Help › Help Center, você lança a Central de Informações do Macintosh.

Trata-se de um guia em HTML, navegável de modo muito semelhante aos sites de informações
da Web e composto de três grandes seções: AppleScript Help, Mac Help e QuickTime Help.

A janela do Help Center: informações sobre AppleScript, Mac OS e QuickTime, ao alcance de uns poucos
cliques do mouse.

99Mac OS
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AppleScript Help

A seção AppleScript Help fornece ajuda para o entendimento e elaboração de scripts, que
são uma linguagem com a qual você automatiza tarefas do computador. Um exemplo disso é o
recurso Automated Tasks, no Menu Maçã, já comentado no Capítulo 03. Como já foi dito na
Introdução, este livro não fornece informações detalhadas sobre scripts.

Mac Help

O Mac Help disponibiliza informações sobre o uso do Sistema Mac OS, divididas em
categorias. Você tira suas dúvidas sobre o trabalho com janelas, discos, monitores, impressão e
muitas outras coisas relevantes.

O Mac OS Help pode ser acessado ainda utilizando-se o atalho z + ? ou selecionando
Menu Help › Mac Help.

QuickTime Help

O QuickTime Help, presente apenas no Help Center do OS 9, auxilia o usuário a utilizar o
QuickTime. Com ele você aprende a tocar músicas, rodar filmes e até mesmo editar, exportar e
comprimir vídeos.

Show Balloons
Os balões são ferramentas informativas do Sistema. Eles funcionam em todas as janelas do

Finder e na maioria dos aplicativos. Seu uso é muito indicado para usuários iniciantes, para que
estes saibam o que estão fazendo à medida em que acionam comandos e desenvolvem tarefas.
Para ativá-los selecione Menu Help › Show Balloons.

Escolha Menu Help › Show Balloons para acionar os balões do Sistema.

Uma vez ligados, os balões vão aparecer o tempo todo em sua tela, dando explicações sobre
qualquer item sobre o qual você colocar o mouse.

Um exemplo dos balões ativos. Explicação instantânea a partir do cursor do mouse. Ótimo recurso para
iniciantes, principalmente se o aplicativo utilizado for em português!

Outra utilidade dos balões é ajudar-nos a saber exatamente quanto cada programa está
utilizando de memória RAM. Selecione Menu Maçã › About This Computer. Na tela do About,
aponte o mouse para a barra do programa que desejar. O balão informa o quanto da memória
RAM separada para aquele aplicativo está sendo verdadeiramente utilizada.

Alguns usuários consideram os balões cansativos, depois de um certo tempo de uso. Para
desativá-los, vá novamente ao Menu Help e selecione Hide Balloons. Os balões deixam de
aparecer em sua tela.
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O aplicativo Aurélio Século XXI tem 4,4 MB de RAM separadas para uso, mas está utilizando apenas 3,5
MB.

Menu de Teclados
Esse menu serve para selecionar um ou mais layouts de teclados, dentre os diversos

existentes no Sistema. O ideal é que essa escolha corresponda às teclas do modelo de teclado
utilizado em seu computador.

Usuários de máquinas mais antigas utilizam normalmente o teclado estendido da Apple, em
padrão norte-americano, optando por layouts como o Brasil/Win ou outros. Existe ainda o teclado
estendido em padrão brasileiro, produzido segundo as regras da ABNT (Associação Brasileira de
Normas Técnicas), que teve poucas unidades produzidas. Tais teclados utilizam em sua maioria o
layout Brazilian, que vem com o Mac OS. Usuários de Powerbooks, iBooks ou iMacs utilizam
teclados diferenciados, normalmente sem a tecla Del (deletar para a frente). Para esses, além dos
layouts padronizados da Apple, têm sido produzidos bons layouts por terceiros (alguns excelentes
podem ser encontrados no site da revista Macmania — www.macmania.com.br).

Os layouts de teclados ficam guardados na pasta System, dentro do System Folder. É
interessante você ir até essa pasta e jogar fora os layouts não utilizados. Eles estão inutilmente
ocupando espaço do HD.

Menu Aplicativos
Esse menu lista todos os programas que estão lançados em seu computador. Você o utiliza

para navegar entre os aplicativos, bem como checar aqueles que estão abertos sem necessidade.

O Menu Aplicativos, listando todos os programas abertos.
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O menu pode ser visto na barra do Finder recolhido (mostrando apenas o ícone do programa
ativo) ou estendido (mostrando o ícone e o nome do programa).

O Menu Aplicativos em forma recolhida.

Ao arrastar a linha pontilhada que fica à esquerda do Menu Aplicativos, é possível movê-la,
ocultando ou revelando o nome do programa ativo.

O Menu Aplicativos estendido. Esta opção de visualização, na qual constam os nomes dos programas, é
disponível apenas a partir do Mac OS 8.5.

Mostrando e Ocultando Programas
As três primeiras opções do Menu Aplicativos são usadas para ocultar ou mostrar o Finder e

os outros programas abertos:

" A opção Hide Finder esconde o Finder, trazendo para a frente o primeiro aplicativo da
lista, que no exemplo acima, seria o Adobe® Photoshop®.

" A opção Hide Others esconde os outros aplicativos abertos, trazendo para a frente o
Finder.

" A opção Show All mostra tanto o Finder como os outros aplicativos. Você trabalha com
todos ao mesmo tempo, navegando entre eles utilizando a parte inferior do Menu
Aplicativos.

Navegando na Lista de Aplicativos
A parte inferior do menu mostra, em ordem alfabética, todos os programas que estão

abertos. Uma marca de checagem (÷ ) indica qual deles está em uso.

Para Alternar Aplicativos:

1 Aponte o mouse para o ícone do menu e, mantendo o botão pressionado, mova-o para
baixo, até o ícone do programa que você deseja utilizar. A cor de fundo é alterada, indicando a
seleção.

2 Libere o botão do mouse. O aplicativo escolhido (ou o Finder) vem para a frente da tela,
pronto para ser usado.

Dica: Quando você tem diversos aplicativos sendo utilizados ao mesmo tempo, e quer
alternar entre eles, sem usar o Menu Aplicativos, faça o seguinte:

1 Pressione as teclas Command (z) + Tab. Surge um quadro no canto superior esquerdo de
sua tela, com a lista dos programas ativos.

2 Navegue entre os programas à medida em que pressiona a tecla Tab. Libere a tecla Tab
quando for destacado o programa desejado. O programa escolhido é colocado em destaque em
sua tela, esperando para ser utilizado.

A Palete Application Switcher
A partir do Mac OS 8.5, foi introduzida uma boa novidade: ao arrastar o Menu Aplicativos

para a Mesa, surge a Application Switcher, uma palete flutuante que pode ser movida para
qualquer ponto da tela. Ela reproduz exatamente a lista de programas abertos, representando-os
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por ícones e nomes. A figura abaixo, por exemplo, mostra a Application Switcher visualizada em
ícones grandes. Para navegar de um aplicativo para outro, é só clicar no botão correspondente.

Para mover a palete, clique em sua Barra de Título e arraste com o mouse. Outra forma de
fazer isso é arrastar pressionando a tecla z. O cursor se transforma em uma pequena mão,
permitindo o arrasto a partir de qualquer ponto da janela.

A palete flutuante Application Switcher. Use-a para navegar pelos programas abertos.

Os Vários Formatos da Application Switcher
A Application Switcher pode ser alterada de várias maneiras, de acordo com o

seu gosto. Ao clicar em sua Caixa de Zoom pressionando algumas teclas, você
determina as suas formas.

" Clique na Caixa de Zoom: A palete mostra ou esconde o nome dos aplicativos.

" Option + Clique na Caixa de Zoom: O tamanho dos ícones é alterado.

" Option + Shift + Clique na Caixa de Zoom: A disposição da palete é alterada de
horizontal para vertical.

A mesma palete acima, com os ícones reduzidos. Ao lado, a palete na horizontal.

Dica: Quando você tem diversos aplicativos sendo utilizados ao mesmo tempo, e quer
alternar entre eles, faça o seguinte:

1 Pressione as teclas Command (z) + Tab. Surge um quadro no canto superior esquerdo de
sua tela, com a lista dos programas ativos.

2 Navegue entre os programas à medida em que pressiona a tecla Tab.

3 Libere a tecla Tab quando for destacado o programa desejado. O programa escolhido é
colocado em destaque na tela, esperando para ser utilizado.
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08
Trabalhando Com Aplicativos

onforme os sapientíssimos Borman e Abs (1997, p. 26), “um programa aplicativo ou
apenas um aplicativo, é um programa criado para fazer um trabalho ou produzir um
resultado. É o software usado pelas pessoas. Já os programas do Sistema são usados

apenas pelo computador”.

Aplicativos são todos os softwares que lhe ajudam a realizar seu trabalho: processadores de
texto, ferramentas de desenho, editores de imagem, navegadores de Internet, clientes de e-mail,
jogos etc.

Com raríssimas exceções, o trabalho com aplicativos resume-se em sete palavras mágicas:
lançar, criar, salvar, editar, imprimir, fechar e assegurar (é claro que essas palavras não se
aplicam a todos os programas).

Lançando Aplicativos
Você pode lançar aplicativos de várias formas diferentes:

1 Marcando o ícone do aplicativo com o mouse e selecionando Menu File › Open.

2 Dando um clique duplo no ícone do aplicativo.

3 Selecionando o aplicativo no Apple Menu ou clicando em sua réplica na Mesa.

4 Duplo-clicando o ícone de um documento.

5 Arrastando um documento sobre o ícone do aplicativo.

6 Utilizando um inicializador — um programa que ajuda você a organizar os aplicativos
mais usados.

Algumas da opções acima já foram comentadas no Capítulo 04. Iremos ver agora o
lançamento de programas através de réplicas no Desktop e de inicializadores.

Réplicas na Mesa
Você pode trabalhar com réplicas na Mesa, basicamente de duas formas: enfileirando-as

como quiser ou criando uma janela lançadora pop-up. A primeira opção atende bem os usuários
que trabalham com poucos aplicativos.

Se você usa muitos aplicativos, em pouco tempo a Mesa estará atulhada de réplicas, gerando
poluição visual que certamente vai atrapalhar o desenvolvimento de suas tarefas. O melhor nesse
caso é criar uma janela lançadora pop-up.

Uma janela lançadora pop-up ocupa pouco espaço na Mesa (apenas um ícone da pasta de
origem) e fornece uma opção rápida de acesso aos aplicativos (você os lança com dois cliques:
um para abrir a janela e outro para acionar o botão do programa).

Para Criar Uma Janela Lançadora Pop-Up:
1 Crie uma nova pasta em sua Mesa e dê a ela um nome significativo, tal como

“Inicializador”.

C
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2 Crie réplicas de seus programas mais usados e coloque-as dentro da nova pasta.

3 Configure a visualização da janela em ordem alfabética e
como botões (assim os aplicativos serão lançados com apenas um
clique do mouse).
Uma janela lançadora pop-up. Aplicativos lançados eficientemente. Você
pode colocar dentro dela a quantidade de réplicas que desejar, sem poluir
o visual da Mesa.

4 Dimensione a janela de modo que todos os botões fiquem
visíveis quando a mesma for aberta. Às vezes é necessário resumir
os nomes dos aplicativos para que os botões se encaixem dentro
das dimensões desejadas por você (por exemplo, Netscape
Communicator™ pode se tornar simplesmente
“Communicator™”).

5 Arraste a janela para o rodapé da Mesa ou selecione Menu
View › as Pop-up Window. Esta se transforma em uma janela pop-up, pronta a ser aberta como
gaveta, a partir de um clique simples.

Utilizando o Launcher
Outra opção para lançamentos de aplicativos é o Launcher, um acessório do próprio Mac

OS. Nele os ícones dos aplicativos aparecem como botões, enfileirados da esquerda para a
direita, em ordem alfabética.

As dimensões dos botões podem ser alteradas. Para fazer isso, clique na janela do Launcher
enquanto pressiona a tecla z. Surge um menu com três opções de tamanho: Small (pequenos),
Medium (médios) e Large (grandes).
As opções de alteração de tamanho dos botões do Launcher.

Onde Está o Launcher?

Talvez o Launcher não esteja aparecendo na Mesa. Isso significa que ele precisa ser
acionado através do Painel de Controle Geral.

Para Ativar o Launcher:

1 Selecione Apple Menu › Control Panels › General Controls.

2 Marque a caixa de seleção Show Launcher at system startup. A figura da Mesa no Painel
de Controle exibirá um ícone reduzido do Launcher, conforme abaixo.

Ao marcar essa caixa de seleção, no painel General Controls, você diz ao Mac que deseja que o Launcher
esteja ativo na Mesa.
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3 Feche a janela do Painel de Controle e reinicialize o computador selecionando Menu
Special › Restart, na barra de menus. A janela do Launcher aparecerá próxima ao rodapé de seu
Desktop.

Alterando Conteúdos do Launcher

Os itens do Launcher são guardados dentro da pasta de Sistema. Você pode incluir ou retirar
o que quiser, de acordo com suas preferências.

Para Incluir Itens no Launcher:

1 Crie réplicas dos aplicativos que você deseja lançar pelo Launcher.

2 Arraste-as para a pasta Launcher Items, que fica dentro do System Folder. Os botões dos
novos aplicativos passam a constar no Launcher.

Outra forma mais simples de adicionar itens é arrastar seus ícones para a janela do
Launcher. Imediatamente estes são anexados ao inicializador.

Para Excluir Itens do Launcher:

1 Abra a pasta Launcher Items, que fica dentro do System Folder.

2 Retire as réplicas dos aplicativos que deseja retirar ao Launcher. Os botões não aparecerão
mais no inicializador.

Outra forma de fazer isso é arrastar os botões do Launcher diretamente para a Lixeira.

Nem todos os usuários do Macintosh usam o Launcher. Talvez porque, diferentemente das
outras janelas do Mac OS, ele não pode ser redimensionado. Isso causa irritação depois de um
certo tempo de uso, principalmente quando é necessário alternar entre diversos aplicativos
abertos e a Mesa. Para desativar o Launcher, desmarque a caixa de seleção do painel General
Controls.

Existem diversos lançadores de Aplicativos criados por terceiros. Consulte os sites de
sharewares e faça uma pesquisa sobre isso (no Site do livro, visite a seção Sites Legais para ver
uma lista de indicações de locais para baixa de arquivos). Você ficará surpreso com a quantidade
de opções disponíveis para downloads.

Criando Documentos
Logo depois de lançar um aplicativo, você vai criar um documento com ele. De modo geral,

você cria documentos selecionando Menu File › New (atalho z + N). Ao fazer isso, o aplicativo
abre uma janela de documento sem nome (untitled), tal como no exemplo abaixo.

Uma nova janela de documento, sem nome, do AppleWorks.
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O próximo passo é gerar conteúdo no documento: uma ilustração num programa de desenho
vetorial, um efeito de distorção num programa de edição de imagens, um layout de página num
programa de editoração ou um texto num programa de processamento de textos. No caso do
exemplo desta seção, digitei uma lista de itens no AppleWorks3.

Acrescente conteúdo ao documento. No
processador de textos do AppleWorks, digite
alguma coisa!

Detalhes quanto a formatação ou modo
de uso dos aplicativos fogem ao escopo
desse livro. O importante é fixar o princípio
de que cada documento é criado com um
conteúdo coerente com os recursos de seu
programa de origem.

Salvando Documentos
Documentos criados em aplicativos desaparecem do disco rígido após a reinicialização do

computador. Isso significa que aquela sua brilhante tese de 200 páginas sobre a “Coloração
Avermelhada das Formigas Saúvas” será perdida, caso ocorra uma oscilação brusca ou queda de
energia.

Para impedir que isso aconteça, é necessário gravar o arquivo do documento no
computador. Na maioria dos aplicativos isso é feito selecionando Menu File (Arquivo) › Save
(Salvar/Gravar) ou o atalho z + S.

Solicitando a gravação do documento de texto.

Ao solicitar a gravação do documento, o Mac OS
exibe uma caixa de Open/Save, possibilitando alguns
ajustes importantes.

A Caixa Open/Save do Mac. Ela pode mudar
dependendo do aplicativo utilizado. No
entanto, suas funções básicas, explicadas
nesse capítulo, estarão sempre presentes.

Eis os componentes da caixa
Open/Save do Mac:

Menu de Localização: Situado
acima da janela de visualização, oferece
a possibilidade de escolha do local onde
você deseja salvar o documento. No
exemplo acima, foi escolhida a pasta
Documents.

                                                
3 As figuras de janelas e menus mostrados neste capítulo são da versão em português do AppleWorks,
quando ainda se chamava ClarisWorks. Apesar da diferença em termos de linguagem, as mesmas são
idênticas em termos de recursos e interface. Enquanto você lê esse livro, é bem possível que já esteja à
disposição, no Brasil, o AppleWorks 6, que traz nova interface e excelentes recursos para os usuários Mac.
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Janela de Visualização: Mostra o que existe no local selecionado no Menu de Localização.
No exemplo acima, note que dentro da pasta Documents estão outras seis pastas, quais sejam,
Cartas, Faculdades, Figuras, Instituto LV, Livros e Minha Casa.

Formato de Gravação: Abaixo da janela de visualização há o menu pop-up entitulado Save
As (ou Salvar Como). Alguns programas possuem o recurso de gravar documentos em diversas
linguagens e formatos. Deixando o menu como está, normalmente o arquivo é gravado no
formato padrão do aplicativo.

Campo de Nome: Uma caixa de texto permite a digitação do nome do documento.

Ícone de Disco: No canto superior direito da janela Open/Save, aparece o ícone com o
nome do disco onde está sendo gravado o documento. Ao clicar nesse ícone, a janela de
visualização altera seu conteúdo, possibilitando a seleção de outros locais para salvamento.

Botão Eject (Ejetar): Usado para ejetar discos.

Botão Desktop (Mesa): Usado para dar acesso rápido à Mesa do Macintosh.

Botão New Folder: Usado para criar uma nova pasta. Ao clicá-lo, uma nova pasta é criada,
pronta para receber o documento.

Botão Cancel (Cancelar): Usado para cancelar a gravação.

Botão Save (Salvar): Clique nele para gravar o documento.

Botões de rádio Document (Documento) e Stationery (Gabarito ou Impresso):
Determinam se o arquivo será gravado como documento comum ou gabarito (falei sobre
gabaritos no Capítulo 04). Junto aos botões, o Sistema mostra os ícones dos arquivos, sempre
definidos de acordo com o aplicativo utilizado.

A versão 8.5 do Sistema introduziu uma nova caixa Open/Save. Os
três botões situados no canto superior direito possibilitam o acesso
rápido aos conteúdos do disco rígido, mesa, rede, pasta Favorites e
últimas pastas visitadas. Além disso, o tamanho da nova caixa pode ser

alterado, o que auxilia muito a navegação por longas listas de arquivos.

À esquerda, a Caixa Open/Save disponível a partir do Mac OS 8.5. Maiores recursos para navegação no
Sistema. À direita, a caixa Open/Save do Mac OS X. Uma das grandes inovações do novo Sistema.

 No Mac OS X, as caixas Open/Save estarão vinculadas às janelas
dos documentos. Elas serão translúcidas e deixarão de ser modais. Isso
quer dizer que você não será mais obrigado a parar tudo para clicar o
botão de Save. Será possível ter vários documentos abertos ao mesmo
tempo e alternar entre diversos aplicativos, sem salvá-los.

8.58.5Mac OS

XXMac OS
Aguarde noAguarde no
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Voltando ao exemplo anterior, decidi dar ao meu sublime texto o nome de “Teste Manual”.
Cliquei em Salvar e o mesmo foi gravado dentro da pasta Documents.

O documento gravado no disco rígido. Ao reinicializar o Macintosh ele estará aqui, pronto para ser aberto,
editado ou impresso.

A Opção Salvar Como…
A maioria dos aplicativos possui também o recurso Save As… (Salvar Como…). Ele existe

para que você possa salvar o mesmo documento com outro nome, no mesmo local onde gravou o
documento original, ou em um local diferente.

Ao abrir um documento já gravado e solicitar Save, provavelmente nada diferente acontece.
Ao solicitar Save As… é aberta uma nova caixa de Open/Save, possibilitando a gravação do
arquivo em outro local, ou no mesmo local com outro nome.

Editando Documentos
Os documentos criados no Mac podem ser novamente abertos e alterados. Isso é feito para

adicionar ou corrigir seus conteúdos. Essas alterações são chamadas de edições. O arquivo desse
livro, por exemplo, teve de ser aberto e alterado algumas vezes. Todos os dias eu tive de reabri-lo
para escrever um pouco mais. Você provavelmente fará o mesmo com os seus trabalhos escolares
ou com aquele projeto que precisa desenvolver para sua empresa.

Editei o arquivo “Teste Manual”, adicionando
uma figura.

Para Editar Um Documento:

1 Abra o documento. Lembre-se que isso pode ser feito de várias formas: clicando sobre o
seu ícone ou botão; arrastando-o sobre o ícone do aplicativo ou selecionando-o em Recent
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Documents no Apple Menu. É possível ainda lançar o aplicativo de origem e selecionar Menu
File (Arquivo) › Open (Abrir) ou utilizar o atalho z + O.

2 Faça as alterações e acréscimos necessários.

3 Grave as alterações, para que elas não se percam após a reinicialização do computador.

Editando Rapidamente com Clippings
O Mac OS oferece a você mais um recurso interessante: a edição de arquivos através de

clippings, que são recortes criados quando você arrasta um texto, imagem ou URL para o
Desktop (textos, figuras ou endereços de Internet são convertidos em pequenos ícones, tais como
os mostrados abaixo).

Exemplos de Clippings (de texto, de imagem e de URL).

A utilidade dos clippings é a simplicidade que eles oferecem para a inclusão de conteúdos
em documentos diversos. Arraste um clipping sobre um documento qualquer e ele será
imediatamente incluído. Para escrever esse livro, por exemplo, eu utilizei clippings de imagens
repetitivas (tais como os avisos Mac OS 8, Mac OS 8.5, Mac OS 9 e Aguarde Mac OS X). Em
cada parágrafo onde eu deveria incluir tais imagens, bastava arrastar o clipping sobre o
documento.

Ao dar um duplo-clique num clipping de URL, é lançado o seu navegador, que busca aquele
endereço na Internet. Essa é uma forma rápida de acessar os seus sites favoritos.

Para Criar um Clipping:

1 Selecione o texto, figura ou URL.

2 Arraste-o para o Desktop.

Para Incluir um Clipping Num Documento:

1 Abra a janela do documento.

2 Arraste o clipping sobre o documento. Ele passa a fazer parte do documento.

Os clippings são ótimos para o compartilhamento de pequenos arquivos entre usuários Mac.
Você pode gravá-los num disquete ou cartucho Zip e passá-lo a um amigo. Este poderá copiá-los
e colá-los em qualquer aplicativo que possua — uma mão na roda.

Imprimindo Documentos
Outra rotina no uso de aplicativos é a impressão de documentos. Apesar de existirem várias

marcas e modelos de impressoras, o modo básico de operação é sempre o mesmo.
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Selecione a Impressora
A primeira coisa a fazer quando se trata de impressão é selecionar a impressora no Chooser

(eu já falei sobre isso no Capítulo 03). Seu Mac precisa saber qual equipamento e porta de
impressão ele deve utilizar para colocar no papel as suas obras de arte.

Configure a Página
Os aplicativos permitem a configuração das páginas que serão impressas. Ao selecionar

Menu File (Arquivo) › Page Setup (Configurar Página), é aberta uma janela permitindo os
diversos ajustes para a impressão.

Na configuração de página é fundamental o acerto do tamanho do papel. A maioria dos
drivers de impressoras para Mac assume como padrão o papel tamanho “Carta” (Letter). O papel
mais usado para impressão no Brasil, no entanto, é de tamanho “A4”, que é um pouco maior
(para obter dados sobre o tamanho do papel que comprou, leia a etiqueta do fabricante na
embalagem da resma). Você precisa informar à sua impressora o tamanho exato do papel em que
você vai imprimir seu documento, para que não haja incorreção no layout do material impresso.

Dica: Você obtém impressões de maior qualidade ao atentar para a gramatura (peso) do
papel. Impressoras ink jet, por exemplo, imprimem melhor em papel de 90g/m2.

Parte da tela de configuração de página de uma impressora Epson. Você terá opções de configuração
semelhantes, seja qual for o equipamento utilizado.

Outra coisa a ser definida na configuração de páginas é a sua orientação. Os documentos
pode ser impressos na posição Portrait (retrato; vertical) ou Landscape (horizontal; paisagem).
Escolha a orientação correta para evitar gasto desnecessário de papel e tinta.

Configure a Impressão
Solicite Print (Imprimir) no Menu File (Arquivo) do aplicativo — atalho z + P. Não se

preocupe; a impressão não acontecerá ainda. Surgirá uma janela na qual você fará a configuração
dos detalhes da impressão.

Informe o número que cópias, as páginas que deseja imprimir, a qualidade e cor de
impressão e o tipo de papel utilizado. No exemplo abaixo, será impressa apenas uma cópia do
documento. Está selecionado o botão de rádio All, indicando que todas as páginas do documento
serão enviadas para a fila de impressão. Quanto ao modo de impressão, ao invés da configuração
automática, eu escolhi a impressão econômica (Economy ou Draft) que é ideal para esboços,
rascunhos e “meu bolso”.

Nessa janela é possível ainda definir se a impressão será em cores ou apenas em preto e se o
papel utilizado é comum ou especial.

Uma tela com possibilidades de configuração dos detalhes da
impressão.



TRABALHANDO COM APLICATIVOS—85

Mande Imprimir
Para encaminhar o documento para impressão, clique no botão OK ou Print da janela de

configuração de sua impressora. O documento é impresso. Para cancelar a impressão, aperte as
teclas z + ponto (.).

O botão Print da janela de configuração de impressão.

Muitos aplicativos possuem um botão de impressão em sua barra de ferramentas (veja
exemplos abaixo).

Botão Print do Microsoft Word.

Botão Print do AppleWorks.

Os botões Print das barras de ferramentas dos aplicativos são úteis para encaminhar
documentos imediatamente para a impressão. Acontece que ao utilizá-los, você faz isso com base
na configuração padrão do documento. Caso você deseje especificar o tipo de papel, cor, páginas
e qualidade de impressão, terá de usar a janela de configuração acionada pelo Menu File › Print.

Dicas de Impressão:

" Assim que iniciar o computador, cheque se a impressora está selecionada no Chooser.

" Antes de imprimir, certifique-se que a configuração da página e o tamanho do papel
estão corretos.

" Imprima seus esboços (material para correção) em modo econômico.

" Imprima os documentos em preto. Use cores somente se isso for estritamente
necessário.

" Limpe e alinhe periodicamente as cabeças de impressão da impressora. Observe no
Manual do fabricante como fazer isso.

Fechando Documentos
Para fechar um documento, clique no botão de fechamento situado no canto superior

esquerdo de sua janela ou selecione Menu File (Arquivo) › Close (Fechar) (atalho z + W). Caso
você não tenha gravado as últimas alterações, surge uma janela perguntando se deseja fazer isso.

Essa janela surge quando você decide fechar um documento com alterações não gravadas, no
AppleWorks. Note os atalhos para Não Salvar, Cancelar e Salvar (eles podem mudar de acordo com cada
aplicativo). Você ganha tempo com eles!

Lembre-se que fechar um documento não significa sair do aplicativo. Este continua aberto,
usando memória RAM e pronto para criar um novo documento. Para sair é necessário usar o
atalho z + Q ou selecionar Menu File (Arquivo) › Quit (Sair).
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Fazendo Backup de Documentos
Um backup (pronuncia-se becape) é uma cópia de segurança de seus arquivos mais

importantes. Problemas internos ou acidentes externos podem destruir os conteúdos do disco
rígido. Daí a necessidade de você armazenar “fora do Mac” todos os trabalhos valiosos.
Particularmente, em cinco anos de uso do Mac OS eu nunca perdi dados em disco. Mas prudência
e caldo de galinha não fazem mal a ninguém.

A Apple está inovando o mercado ao fabricar máquinas sem drives de disquete. O profeta
Steve Jobs prega que os usuários de computadores do início do Século XXI, guardarão seus
arquivos em servidores da Internet. Alguns serviços dessa natureza já podem inclusive ser
encontrados no site da Apple (iTools) ou mesmo em outros cantos da Web. Porém, grande parte
dos usuários (inclusive eu), continua utilizando o método “arcaico” de guardar documentos
importantes em disquetes, discos óticos, cartuchos Zip, SuperDisk, Orb ou CDs. Isso pode ser
feito basicamente de duas formas.

Backup Usando o Recurso Salvar Como…
Essa forma de cópia de segurança grava os arquivos em discos a partir do aplicativo de

origem. Como vimos acima, os programas disponibilizam a opção Salvar Como… (Save As…).
Assim você pode gravar uma cópia de um documento em um local diferente daquele onde
armazenou o documento original.

Para Copiar Arquivos em Discos Externos Utilizando o Save As…:

1 Insira o cartucho ou disco no driver. Seu ícone é montado na Mesa.

O ícone do disco montado na Mesa, pronto para receber um arquivo.

2 Abra o documento no aplicativo e selecione Menu File (Arquivo) › Save As… (Salvar
Como…).

3 Na caixa Open/Save, selecione o disco como local de gravação.

O disquete é selecionado na caixa Open/Save. Note que a Mesa (Desktop) é o local onde o disco se
encontra. O ícone do disquete aparece no canto superior direito da janela.

4 Clique no botão Open (Abrir) ou dê um clique duplo no ícone do disco, na Janela de
Visualização. Você irá para dentro do disco, onde poderá gravar o arquivo.

O Menu de Localização exibe o ícone do disco externo. Você está dentro dele, prestes a gravar o arquivo.

5 Clique em Save (Salvar). O documento é gravado no disco externo, aparecendo na Janela
de Visualização da caixa Open/Save. Outra forma de confirmar a gravação é ir até a Mesa e clicar
no ícone do disco. É aberta uma janela, mostrando o seu conteúdo.
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Eis o documento, gravado no disco externo. Você terminou de fazer um backup!

Backup no Finder
A segunda forma de copiar arquivos para discos externos é utilizando os recursos de arrastar

e soltar do Finder.

Para Copiar Arquivos em Discos Externos Utilizando o Finder:

1 Insira o cartucho ou disco no drive. Seu ícone é montado na Mesa.

2 Abra a pasta onde o documento está guardado e localize-o.

3 Arraste o ícone do documento para o disco. É acionada uma janela que lhe mostra o
andamento da cópia.

Você pode arrastar documentos para discos externos.

A janela de cópia do Finder. O documento está sendo copiado no disco.

Copiando do Disco Para o Mac
Para copiar do disco para o Mac, arraste o item para uma pasta e pronto. Se quiser copiar

diretamente para a Mesa, aperte a tecla Option enquanto arrasta.

Comprima Seus Arquivos
Para guardar mais arquivos no mesmo espaço de disco, comprima os documentos.

Documentos comprimidos podem ser expandidos e reutilizados normalmente.
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Existem diversos utilitários de compressão e expansão disponíveis para a plataforma Mac.
Você os encontra na Internet ou em CD-ROMs de revistas sobre Macintosh.

Os utilitários mais usados são o Stufflt Expander (que expande arquivos nos formatos .sit e
.hqx) e o DropStuff, da Aladdin Systems (que comprime arquivos no formato .sit).

O Expander é freeware (grátis), usado para expandir arquivos. O DropStuff é shareware
(você o usa por um tempo e depois tem que pagar por ele, mas vale a pena o desembolso) e serve
para comprimi-los. Algumas versões do Mac OS disponibilizam esses programas na pasta
Internet Utilities, que fica dentro da pasta Internet. Para baixá-los pela Web, aponte seu
navegador para http://www.aladdinsys.com. Após a instalação desses programas, réplicas dos
mesmos ficam disponíveis na Mesa.

Réplicas do Stufflt Expander e DropStuff.

Para Comprimir Arquivos:
1 Localize o arquivo no disco rígido.

2 Arraste-o para a réplica do DropStuff, na Mesa do Macintosh. Uma janela é lançada,
mostrando o andamento da compressão.

3 Logo depois, surge o ícone do documento comprimido, que pode ser copiado para um
disco externo.

Um ícone de documento comprimido com o DropStuff.

Para expandir arquivos, arraste-os sobre a réplica do Stufflt Expander. Eles voltam ao seu
tamanho original.

O Stufflt trata com arquivos em diversos formatos, inclusive o .zip, muito utilizado por
usuários do Windows. Existem vários outros aplicativos que também comprimem e expandem
em formato “.zip”. Esses utilitários podem ser encontrados em sites da Internet.

 Para comprimir vários arquivos de uma só vez, você pode utilizar o Stufflt Lite™, que é um
produto gratuito — uma espécie de amostra do programa pago, o poderoso StuffIt Deluxe™,
também fabricado pela Aladdin Systems (baixe o Lite no site da Aladdin, citado acima).
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Para Comprimir Vários Arquivos:

1 Lance o aplicativo Stufflt Lite™. Ele mostrará uma tela solicitando seus dados para
registro. Você tem a opção de registrar-se imediatamente (o registro é gratuito, diretamente no
site da Aladdin Systems) ou depois.

2 Crie um novo documento comprimido, selecionando Menu File › New (atalho z + N).
Surge a caixa de Open/Save. Selecione o Desktop como local de destino, digite um nome para o
novo arquivo e clique no botão New.

3 Surge uma janela vazia, para a qual você arrasta todos os arquivos que deseja comprimir.
Uma janela surge indicando o andamento da compressão. Ao término da tarefa, todos os arquivos
passam a constar na janela do aplicativo, devidamente compactados.

4 Feche a janela do Stufflt. O ícone do novo arquivo compactado surge na Mesa, pronto
para ser copiado para uma mídia de armazenamento. Essa também é uma boa forma de preparar
vários documentos para encriptação (eu falei sobre isso no Capítulo 04).

Faça Várias Cópias de Arquivos Importantes
Outra coisa a ser feita é a criação de vários jogos de backups. Armazene os documentos

mais importantes em vários discos e guarde-os em locais diferentes. Assim você tem a certeza de
reaver seus trabalhos, caso ocorra algum acidente ou surja um defeito em um disco. Guarde
também versões normais e compactadas, pois alguns arquivos podem se corromper ao serem
expandidos.

Uma última medida de segurança importante é guardar cópias de arquivos nas várias
partições do disco rígido. Sobre isso falarei no Capítulo 11.
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09
Preparando-se Para a Internet

 mídia mais poderosa do Século XXI se chama Internet. Isso agora pode parecer ridículo
ou utópico para alguns, mas trata-se de uma tendência irreversível. Enquanto estou
digitando esta página, milhares de pessoas em todo o mundo estão se conectando à

grande rede, e esse número não vai diminuir. No Brasil existem 48 milhões de usuários, e o
oferecimento gratuito de acesso e correio eletrônico é apenas o início de um processo, que vai
culminar na popularização do uso da Web. Estar fora da Internet significa alienar-se de uma
imensa fonte de informações, entretenimento e facilidades de consumo.

Algumas Informações Básicas Sobre a Internet
A Internet é uma “rede remota internacional de ampla área geográfica, que proporciona

transferência de arquivos e dados, juntamente com funções de correio eletrônico para milhões de
usuários ao redor do mundo” (Michaelis, 1998, p. 1169).

Milhões de computadores interligados. Isso é a Internet.

A Linguagem da Internet
Para se entenderem, as máquinas ligadas à Internet utilizam uma linguagem comum, o

protocolo TCP/IP (Transmission Control Protocol/Internet Protocol). Os conteúdos enviados são
divididos em vários fragmentos, que seguem seus caminhos até serem reagrupados nas máquinas
receptoras.

Os sites que você visita são escritos em HTML (Linguagem de Marcação de Hipertexto). O
hipertexto permite ir de uma página a outra através de links (ligações), que normalmente
aparecem sublinhados (o cursor do mouse se torna uma pequena mão ao passar sobre um link).

Exemplo de um link.

Apesar do uso cada vez maior de outras linguagens e recursos, o HTML continua sendo a
base da maioria dos sites disponíveis na Web.

Endereços da Internet
Para que ocorra essa troca de dados, o protocolo TCP/IP utiliza endereços numéricos que

são atualizados a cada conexão (alguma coisa como 200.230.249.30) e alfanuméricos, os nomes
de domínio, que são permanentes (http://www.algumacoisa.com.br). Esses endereços são
chamados de URLs (Uniform Resource Locator). Cada URL possui elementos que informam
detalhadamente o tipo e localização do serviço a ser acessado na Internet. Vamos entender isso
analisando o endereço acima.

A
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HTTP (Hyper Text Transfer Protocol) informa que o endereço procurado aloja arquivos em
hipertexto ou HTML (Hyper Text Markup Language).

WWW (World Wide Web): A parte mais popular da Internet, onde você encontra sites
construídos com hipertexto e hipermídia.

algumacoisa: O nome de domínio do site, criado para facilitar a memorização do endereço.

.com: Tipo de domínio. Existem diversos:

.com Sites comerciais. .mil Sites militares dos EUA.

.edu Sites educacionais. .net Sites de organizações de redes.

.gov Sites governamentais não militares. .org Sites das demais organizações.

.int Sites de organizações internacionais.

.br: Indicação geográfica. Eis as mais conhecidas:

au Austrália dk Dinamarca it Itália

at Áustria es Espanha jp Japão

be Bélgica fi Finlândia mx México

br Brasil fr França nl Holanda

ca Canadá ie Irlanda se Suécia

ch Suíça il Israel tw Taiwan

de Alemanha in Índia uk Reino Unido

Serviços da Internet
Os serviços mais utilizados da Internet são os protocolos http (documentos em HTML) e

mailto (e-mail ou correio eletrônico). Além deles, também muito usados são o FTP (File
Transfer Protocol), usado para troca de arquivos; o News, que proporciona acesso a grupos de
discussão e o IRC (Internet Relay Chat), que disponibiliza as famosas salas de conversação on-
line. Telnet, Gopher e Veronica são exemplos de outros serviços também disponíveis.

As trocas de dados na Internet são gerenciadas por servidores, máquinas de empresas
prestadoras de serviço de acesso à rede. Tais empresas são chamadas de “Provedores”. Você
precisa contratar um provedor, que lhe fornecerá uma ou mais contas de correio eletrônico, um
espaço para armazenar seu site pessoal e todos os outros dados necessários para configurar o Mac
para conectar-se à Web.

Os marketeiros da Apple não nos deixam esquecer que qualquer um pode comprar um Mac
e ligar-se rápida e facilmente à Internet. É verdade. Mas isso não significa uso imediato. Para
tirar o máximo proveito da Web, são necessárias as configurações geral (do Sistema), e
específicas, do Remote Access, do Painel Internet, dos Navegadores e dos Clientes de E-mail.

Configurando o Sistema para a Web
O Mac OS possui um assistente que o auxilia, de maneira muito eficiente, a realizar toda a

configuração do computador para a Web.

Para Configurar o Sistema do Mac para a Internet:

1 Lance o assistente de configuração, selecionando Apple Menu › Internet Access › Internet
Setup Assistant. No Mac OS 9, a opção Internet Access não consta no Apple Menu, sendo
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necessário acionar o assistente clicando em seu ícone, que fica guardado na pasta Internet ›
Internet Utilities.

Aqueles que utilizam até a versão 8.6 do Mac OS, podem escolher esta opção do Apple Menu para lançar
o Assistente de Configuração de Internet.

A localização do assistente de configuração no disco rígido: Internet › Internet Utilities › Internet Setup ›
Internet Setup Assistant.

2 Preencha as telas de configuração observando o seguinte:

Tela inicial do Internet Setup Assistant: Clique no botão Yes.

Tela 01: Introduction. Apenas para leitura. Clique na seta next, no canto inferior direito da
janela e vá para a tela 02.

Clique nestas setas próximas ao rodapé das janelas, para prosseguir ou retornar no processo de
configuração.

Tela 02: Configuration name and connection type. Na caixa de texto, dê um nome à
configuração (algo como “Trabalho”, “Casa” etc). Clique no botão de rádio Modem.

Tela 03: Modem Settings: No menu pop-up Modem, escolha o modem instalado em seu
computador. No menu pop-up Port, selecione Modem Port. Marque o botão de rádio Tone se sua
linha telefônica, no momento de discagem, emite sons musicais, e Pulse e ela emitir um ruído
semelhante a uma catraca em movimento.
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Tela 04: Configuration Information: Na primeira caixa de texto digite o número de telefone
fornecido por seu provedor para conexão. Na segunda caixa, digite o seu nome de acesso (login).
Na terceira, digite sua senha.

Telas 05 e 06: Configura scripts PPP e endereços IP. Marque os botões de rádio No, a não
ser que seu provedor requeira um script de conexão ou você possua um endereço IP próprio.

Tela 07: Dados de domínio. No primeiro quadro de texto, digite os números de domínio
fornecidos pelo provedor (DNS primário e secundário). No segundo, digite o nome de domínio.

Tela 08: Informe, no primeiro campo, o seu e-mail. No segundo, digite a sua senha. O
terceiro quadro não precisa ser alterado ou preenchido.

Tela 09:  Preencha o primeiro quadro com o servidor POP (Post Office Protocol) e SMTP
(Simple Mail Transfer Protocol).
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Tela 10: Informe qual o seu servidor de grupo de notícias (opcional).

Tela 11:  Marque o botão de rádio No, a não ser que você tenha de acessar a Web por um
servidor Proxy.

Tela 12: Conclusão. Marque a caixa de seleção Connect when finished se desejar conectar-
se após o fechamento da janela. Clique no botão Go Ahead para sair do assistente de
configuração.

A partir desse ponto você já pode conectar-se na Internet, bastando clicar nos ícones Browse
the Internet e Mail, normalmente dispostos na Mesa do Mac. Mas eu recomendo algumas outras
configurações.

Esses ícones, dispostos na Mesa, são usados para navegação e troca de e-mails na Internet.

Configure o Remote Access
Linhas telefônicas ocupadas são inconvenientes e irritantes para todos os que navegam na

Web. Alguns provedores fornecem a seus clientes programas discadores automáticos, que ficam
tentando “encontrar” uma linha disponível, discando para vários números alternadamente, até
conseguir uma conexão. O Mac OS possui um discador automático, e ele se chama Remote
Access.

O Remote Access é um Painel de Controle que não apenas efetua o
acesso, mas gerencia outros processos do mesmo, inclusive o registro do
tempo de conexão.

Para Ativar o Discador Automático do Remote Access:

1 No Control Strip, abra o módulo do Remote Access. Você pode
fazer isso também selecionando Apple Menu › Control Panels › Remote

Access.

2 Na janela aberta do Remote
Access, note que no campo Number
consta o número de telefone fornecido
por seu provedor de acesso, configurado
na Tela 04 do Internet Setup Assistant.
Clique no botão Options... e selecione a
guia Redialing.
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3 No menu pop-up Redial selecione Redial main and alternate numbers. Em Redial times
especifique quantas vezes você quer que seja tentada a rediscagem. Em Time between retries,
especifique o tempo em segundos entre uma e outra discagem. Em Alternate number, liste o
outro telefone de acesso.

4 Clique em OK e feche a janela. Surge uma caixa de diálogo perguntando se você deseja
salvar suas alterações. Clique em OK ou pressione a tecla Return.

Configure o Painel Internet
Ao instalar o Mac OS (ou quando você o tira da caixa, após a compra) e preencher as telas

do Internet Setup Assistant, as informações básicas de configuração ficam cadastradas no Painel
de Controle Internet. No entanto, vale à pena fazer alguns poucos ajustes finos nesse Painel, com
o objetivo de maximizar o uso de sua máquina na rede.

Para Configurar o Painel de Controle Internet:

1 Selecione Apple Menu › Control Panels › Internet.

2 No Painel Internet, clique na seta Edit Sets e na guia E-mail. Selecione o seu programa de
e-mail no menu Default E-mail Application. Esse é o programa lançado quando você clica no
ícone Mail, na Mesa do Mac.

3 Vá até a guia Web. Nos campos de texto Home Page e Search Page, apague as URLs
listadas e clique nos botões de rádio None. Se você não fizer isso, todas as vezes em que lançar o
seu navegador ele irá procurar automaticamente as páginas listadas. Isso é legal nas primeiras
vezes, mas chateia bastante quando você precisa fazer “aquela” conexão para pesquisa rápida
sobre “Salamandras” e tem que esperar o carregamento de uma página que não tem nada a ver
com a sua necessidade.

Outra coisa a fazer é escolher o seu navegador predileto no menu pop-up Default Web
Browser, situado no rodapé da guia. Caso você tenha instalado outro programa, como o Netscape
Communicator™ ou o iCab, selecione-o agora. Todas as vezes em que você clicar no ícone
Browse the Internet, será lançado esse software de navegação.

Configure os Navegadores
Para o usuário, os modos de funcionamento dos navegadores atuais são muito semelhantes.

Portanto, as dicas aqui compartilhadas servem tanto para o Netscape Communicator™ quanto
para o Microsoft Internet Explorer, nas suas versões mais recentes. É preciso esclarecer que meu
objetivo não é explicar detalhes de configurações desses programas. Para isso você precisa
adquirir manuais específicos, sobre cada um dos aplicativos.
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Elimine Páginas Iniciais Automáticas
Ao configurar o Painel Internet, você já solicitou ao Sistema para não procurar páginas

automaticamente. No entanto, aqui vale o famoso (e feio) ditado do universo jurídico: “o que
abunda não prejudica”.

Netscape Communicator™:

1 No Netscape, selecione Menu Edit › Preferences e clique na seta Navigator.

A janela de preferências do Communicator™.

2 Em Navigator starts with, clique no botão de rádio Blank page. O Netscape, ao ser
lançado, exibirá uma página em branco, aguardando uma URL para navegação.

3 A caixa de texto Home page location deve ser deixada em branco.

Microsoft Internet Explorer:

1 No Explorer, selecione Menu Edit › Preferences e clique no bullet Home/Search.

A janela de configuração de preferências do Explorer.

2 Verifique se todos os campos de texto estão em branco. Desmarque a caixa de seleção de
abertura automática de Home Page (Automatically go…).

Use o Recurso de Preenchimento
Automático

O Netscape Communicator™ não possui esse
recurso, pelo menos por enquanto. No Microsoft
Internet Explorer, ele está disponível a partir da
versão 4.5. Trata-se de algo muito útil quando
precisamos preencher formulários de sites. Ao
ativá-lo, o navegador preenche alguns campos
automaticamente.
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Para Ativar o Preenchimento Automático:

1 No Explorer, selecione Menu Edit › Preferences e clique no bullet AutoFill Profile.

2 Preencha os campos da janela AutoFill Profile com seu nome, telefones, endereço de e-
mail e endereço residencial.

Configure Bookmarks ou Favorites
URLs são difíceis de memorizar. Você até consegue fazer isso com umas poucas, mas não

irá muito longe com dez ou vinte endereços parecidos com http://www.pindamonhangaba.com.br
/artigos/carafeiapramimefome/index2/framedoido. Isso dá nó em qualquer cérebro. É por isso que
os navegadores oferecem a possibilidade de você criar uma lista dos endereços mais visitados.
No Netscape Communicator™ ela é chamada de Bookmarks. No Microsoft Internet Explorer ela
é chamada de Favorites.

Visitando um site e desejando adicioná-lo à sua lista, selecione Menu Bookmarks
(Netscape) ou Menu Favorites (Explorer) › Add Bookmark ou Add Page to Favorites. Isso ainda
pode ser feito, nos dois navegadores, utilizando o atalho z + D.

O Menu Bookmarks, do Netscape Communicator™.

Se você quiser, pode cadastrar um site em Bookmarks ou Favorites sem estar conectado à
Internet. Os procedimentos são um pouco diferentes, No Netscape e no Explorer.

Netscape Communicator™:

1 Selecione Menu Bookmarks › Edit Bookmarks (atalho z + B).

2 Surge a janela de Bookmarks. Selecione Menu File › New Bookmark…

3 Preencha os campos da janela New Bookmark.

Na janela New Bookmark você pode escrever comentários, que o auxiliam na identificação posterior do
site.

Microsoft Internet Explorer:

1 No Explorer, selecione Menu Favorites › New Favorite (atalho z + K).



PREPARANDO-SE PARA A INTERNET— 99

2 Os recursos de configuração dos Favorites do Explorer são extensos. Para cadastrar
apenas as informações básicas, permaneça na guia Info. Preencha os três campos de texto com o
título do site, seu endereço e comentários pertinentes.

Os sites registrados em sua lista podem ser acessados nos próprios Menus (Bookmark ou
Favorites) dos aplicativos de navegação.

A janela de informações de um site em Favorites, do Explorer.

Configure as Barras de Ferramentas
Agilize as navegações criando barras de ferramentas personalizadas. Com elas você acessa

aos seus sites prediletos com apenas um duplo clique do mouse.
Uma janela do Explorer com a Barra de Ferramentas personalizada. Sites acessíveis com um clique duplo.

Para Configurar as Barras de Ferramentas:

1 Solicite Menu Bookmarks › Edit Bookmarks (Netscape — atalho z + B) ou Organize
Favorites (atalho z + J, no Explorer). Será aberta a janela com a lista de sites.

2 No Netscape, os Bookmarks criados por você estão na pasta Personal Bookmarks (no
exemplo você vê o site Manual…). Os sites da Barra de Ferramentas estão na Personal Toolbar
Folder. Arraste o ícone do site da primeira para a segunda pasta e ele fará parte da Barra de
Ferramentas do navegador.

O site Manual… passa a fazer parte da Barra de Ferramentas, quando arrastado para a Personal Toolbar
Folder. À esquerda, a Barra de Ferramentas do Netscape Communicator™, após a inserção do site.

No Microsoft Internet Explorer o processo é idêntico, sendo que a pasta onde ficam
agrupados os sites da Barra de Ferramentas é denominada Toolbar Favorites. Uma peculiaridade
do Explorer é que, ao navegar e encontrar um site desejável para a Barra de Ferramentas, você
pode anexá-lo imediatamente selecionando Menu Favorites › Add Page to Toolbar Favorites.
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É claro que as dicas acima não esgotam as possibilidades de otimização dos programas de
navegação. São apenas pequenos detalhes que ajudam os usuários Mac em sua exploração
cotidiana da Internet.

O navegador Internet Explorer 5 com a Barra de Ferramentas Personalizada. Sites ao alcance de um
clique.

Configure os Programas de E-mail
A maioria dos novos usuários Mac utiliza como programas de troca de e-mails, o Microsoft

Outlook Express e o Netscape Messenger, sendo que o primeiro, a partir de sua versão 5, é
configurado automaticamente na instalação, utilizando os parâmetros informados no Internet
Setup Assistant. Quanto ao Messenger, deve ser configurado manualmente.

Para Configurar o Netscape Messenger:
1 Lance o Netscape Communicator™ e selecione Menu Edit › Preferences.

2 Selecione a janela Identity. Caso deseje utilizar os parâmetros de configuração do Internet
Setup Assistant, clique primeiro na caixa de seleção Use Internet Config e depois no botão OK.
Se você deseja uma configuração diferente, deixe a caixa Use Internet Config desmarcada e
preencha os campos de texto. No campo Your name, informe seu nome completo. No próximo
campo, digite seu endereço de e-mail. O campo Reply-to address deve ser preenchido apenas se
você deseja que as respostas sejam enviadas para outra caixa de correspondência. O
preenchimento do campo Organization é opcional

3 Selecione a janela Mail Servers. Clique no botão Add… para digitar o servidor POP.
Informe também o servidor SMTP e seu nome de acesso (login).

Os aplicativos de e-mail proporcionam ainda diversas outras possibilidades de ajustes. Para
conhecer mais detalhes, consulte seus manuais, arquivos leia-me e a ajuda on-line. Fique de olho
também na revista Macmania, impressa pela Editora Bookmakers, uma publicação que sempre
fornece dicas excelentes sobre Navegadores e Clientes de E-mail, para deleite dos internautas
macmaníacos.

Com essas configurações, o Mac está pronto para a Internet. Clique nos botões Browse the
Internet ou Mail e tire o máximo proveito da grande rede.
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10
Painéis de Controle e Extensões
do Macintosh

o trabalhar com o Macintosh, sem que você perceba, dezenas (e em certos momentos até
milhares) de tarefas são processadas pelo computador. O modo como a imagem na tela é
mostrada, a forma como o mouse responde aos comandos, o processamento simultâneo

de diversos arquivos (alguns até invisíveis), a organização das pastas, com seus diversos
conteúdos — tudo isso acontece ao mesmo tempo em que você se concentra naquela ordem das
palavras, naquele parágrafo fundamental para a conclusão de sua monografia.

Você já aprendeu, no Capítulo 01, que toda essa movimentação é gerenciada pelo Sistema.
E a maioria dessas realizações depende dos Painéis de Controle e das Extensões. Os primeiros
servem para personalizar e controlar recursos do Mac OS e de aplicativos. As últimas também
são instrumentos de controle, mas não são configuráveis. Depois de instaladas, começam a
funcionar e pronto. Caso você não deseje que alguma delas continue agindo, deve transferi-la
para a pasta de Extensões Desabilitadas (Extensions Disabled) ou jogá-la na Lixeira.

Nessas pastas, encontra-se parte vital do Sistema Mac OS.

A dificuldade em lidar com Painéis e Extensões é a sua multiplicidade. Alguns deles são
universais — utilizados em todas as máquinas da Apple. Outros são peculiares a cada versão do
Mac OS ou cada modelo do hardware. Isso quer dizer que um Apple Performa 6200 possui
Painéis e Extensões só dele, diferentes de um iMac ou iBook, mesmo que seja utilizada a mesma
versão do Sistema!

E para complicar ainda mais as coisas, ao instalar um aplicativo no Mac, alguns Painéis e
Extensões daquele programa provavelmente são também instaladas. No final das contas, as
pastas Control Panels e Extensions ficam abarrotadas de elementos muitas vezes conflitantes, que
você nem sabe para que servem, e que podem causar problemas bem chatos, tais como
congelamentos.

Várias Extensões instaladas, da esquerda para a direita: Norton AntiVirus Auto-Protect; Apple CD/DVD
Driver; Apple Guide; Control Strip Extension; EPSON Stylus(EX) e QuickTime™.

Mas nem tudo está perdido. Há esperança para os macmaníacos. Na verdade, tomando
alguns cuidados básicos, você consegue administrar bem as Extensões e Painéis de Controle.
Fique de olho nas dicas abaixo e tire o máximo proveito do Macintosh.

Informações Preliminares
Ao ligar o computador, os Painéis de Controle e Extensões surgem no rodapé da tela de

boas vindas, carregando-se da esquerda para a direita e de baixo para cima. Quanto mais Painéis
e Extensões, mais demorada fica a inicialização. E mais “pesado” fica o Sistema como um todo.

Você não vai utilizar todos eles. Alguns podem ser desligados ou até mesmo ser jogados na
Lixeira. Procure manter o Mac “enxuto”, com o mínimo de Painéis e Extensões ativados, pois
isso o mantém ágil e livre de travamentos. Mas tome cuidado: algumas coisas são fundamentais e

A
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desabilitá-las ou jogá-las fora pode fazer com que o computador deixe de funcionar
adequadamente.

As Extensões são, basicamente, de três tipos:

" Extensões de Sistema, dentre as quais estão aquelas desenvolvidas pela Apple, que
capacitam o Mac a desenvolver tarefas no Finder.

" Bibliotecas (libraries), criadas por desenvolvedores de aplicativos. São trechos de
código, carregados na RAM apenas quando certos programas são ligados, tais como o
Office da Microsoft, por exemplo.

" Extensões Chooser, os drivers de impressoras, scanners e tudo o mais que possa ser
selecionado no Chooser (você encontra mais informações sobre o Chooser no Capítulo
03).

Alguns Painéis Importantes
É hora de dar uma olhada em alguns Painéis de Controle fundamentais. É interessante

observar que aqueles marcados com um asterisco, funcionam mesmo quando estão desativados
— isso quer dizer que os recursos ficam à disposição sem que os Painéis “ocupem espaço” no
Sistema:

" Appearance (*). Painel utilizado para personalizar a interface do computador. Você
aprenderá a fazer isso no Capítulo 11.

" Apple Menu Options. Aciona os submenus e define os perfis das pastas de
documentos e aplicativos recentes. Leia sobre isso no Capítulo 03.

" Apple Talk. Utilizado para conexões com outro computador, via rede.

" Color Sync . Regula as cores nos diversos dispositivos (monitores, impressoras etc.).
Útil para quem trabalha com editoração eletrônica profissional.

" Control Strip. Define padrões do Control Strip (Barra de Controle).

" Date & Time. Permite estabelecer diversos padrões de localização, data e hora do
Macintosh, inclusive o formato do relógio na barra de menus do Finder.

" Dial Assist. Um assistente de ligações, que permite a configuração de diversos
números telefônicos.

" Energy Saver. Painel que administra as inicializações e desligamentos automáticos,
bem como o descanso do computador.

" Extensions Manager. Um dos mais importantes, permite criar e controlar diversas
definições (sets) de Painéis e Extensões (falarei sobre ele mais adiante, neste mesmo
capítulo).

" File Exchange. Permite vincular extensões de arquivos de PC com os aplicativos do
Mac OS. Através dele você define quais os aplicativos que abrirão certos tipos de
documentos (por exemplo, arquivos .xls serão sempre abertos pelo Microsoft Excel).

" File Sharing. Usado para habilitar a troca de arquivos numa rede.

" General Controls (*). Define a habilitação do Launcher no Desktop, os avisos
automáticos em caso de desligamento indevido, os trancamentos das pastas de Sistema
e Applications, a velocidade do piscar do ponto de inserção do mouse, o piscar dos
itens dos menus e o local de gravação de documentos.

" Internet. Usado para configurar diversos perfis de usuários de Internet.

" Keyboard (*). Seleciona os layouts de teclados que ficam ativos no Menu de
Teclados do Finder.
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" Launcher. Configura o inicializador do Mac OS, já comentado no Capítulo 08.

" Location Manager. Permite trocar preferências relacionadas a mudanças do
computador, tais como tipo de rede, prefixo de telefone etc.

" Memory (*). Configura a memória do Macintosh.

" Modem. Habilita o funcionamento e definição do modem.

" Monitors. Regula cores e resolução do monitor. No Mac OS 8 a 8.5, agrega também
os controles de som, denominando-se Monitors & Sound.

" Mouse (*). Configura velocidade e espaçamento dos cliques do mouse.

" Multiple Users. Somente disponível a partir do Mac OS 9. Permite cadastrar vários
usuários com níveis de acesso diferentes. Veja como fazer isso mais à frente, neste
mesmo capítulo.

" Numbers (*). Registra os padrões numéricos do computador.

" QuickTime™ Settings (*). Altera configurações do QuickTime™, inclusive
gravação do número de registro.

" Remote Access. Fundamental para uso da Internet. Escrevi sobre ele no Capítulo 09.

" Software Update. Disponível a partir do Mac OS 9, permite a atualização automática
do Sistema, via Internet.

" Sound. Configura os sons de alerta, microfones, qualidade de som, balanço etc. Nas
versões de Sistema até OS 8.5, as configurações de som estão juntas com as de
monitor, no Painel Monitors & Sound.

" Speech. Juntamente com a extensão Speech Manager, seleciona opções de voz para
que o Mac leia textos e quadros de diálogo.

" Startup Disk (*). Define o disco de inicialização desejado. Muito usado para boots a
partir de CDs ou troca de sistemas em diferentes unidades de disco rígido.

" TCP/IP. Configura o modo de conexão e os domínios do seu servidor de Internet.

" Text (*). Estabelece recursos de texto para sistemas que utilizam scripts de texto
instalados.

" Web Sharing. Permite que você transforme seu Mac num servidor. Exige que você
tenha IP e nome de host fixos. Talvez você nunca precise utilizar esse recurso.

Algumas Extensões Importantes
Os nomes das Extensões muitas vezes informam sobre suas utilidades, sendo desnecessária

uma explicação detalhada. De modo geral, observe o seguinte:

" Extensões Guide. Permitem o funcionamento dos Helps do Mac OS e dos diversos
aplicativos.

" Extensões Script. Definem o trabalho com Apple Scripts do Sistema e dos
aplicativos.

" Extensões QD3D, QuickDraw™ 3D, OpenGL e DrawSprocketLib. Responsáveis
pelo desenho das janelas do Finder e execução de alguns jogos e aplicativos em 3D.

" Extensões ATI. Vinculados a aceleração do Mac. Importantes para jogos e outros
aplicativos em 2D, 3D, além de auxiliar o QuickTime™.

" Extensões Share, Ethernet, Network, SLPPlugin, Users & Groups, Modem
Scripts, Network e Open Transport. Necessárias para a ligação do Mac em rede e
Internet. Mesmo que você não esteja conectado a uma rede, é melhor deixar tudo
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ligado, pois as conexões via rede local e Internet são governadas pelo mesmo pacote de
extensões.

" Apple Photo Access, Foreign File Access e ISO 9660 File Access. Graças a tais
extensões, seu Mac pode ler CDs no formato Kodak PhotoCD, áudio, ISO 9660 (CDs
de PC) e High Sierra.

" Apple CD/DVD Driver, Audio CD Access, Indeo Video, Intel Raw Video,
Macintalk 3 e Pro, QuickTime™, Sound Manager e Speech Manager. Permitem a
leitura de CDs de áudio e DVDs, bem como a execução de multimídia, conversão de
som, memória de vídeo e leitura de documentos.

" Carbon Lib . Permite ao Mac OS 9 rodar aplicativos híbridos, baseados em Carbon,
que funcionam tanto no Mac OS 9 quando no Mac OS X.

" Color Picker. Permite aos programas utilizar diversas formas de escolher cores:
RGB, hexadecimais etc.

" Desktop Printer Spooler, Desktop PrintMonitor, Printer Share, PrintingLib,
PrintMonitor, LaserWriter 8. Utilizadas para a impressão, juntamente com o driver
de sua impressora. Não desabilite nenhuma delas. O driver LaserWriter 8 é importante
para a geração de arquivos PDF através do Acrobat Distiller. Você pode jogar fora, ou
guardar numa pasta, os drivers de impressoras que você não utiliza.

" Extensões Security. Responsáveis pelo gerenciamento dos recursos de segurança do
Apple File Security, no Mac OS 9. Eu falei sobre isso quando tratei da encriptação de
arquivos, no Capítulo 04.

" Voice Verification. Disponível a partir do Mac OS 9, aciona o Voiceprint Password,
um sistema de autenticação de usuário por reconhecimento de voz.

Configurando Alguns Painéis
Nos capítulos anteriores eu disse que ia ensinar como configurar os Painéis de Controle

Energy Saver e Multiple Users. Vou aproveitar também para falar sobre o Keychain Access e o
Software Update.

O Painel Energy Saver
O Energy Saver é utilizado para definir os parâmetros de descanso, ligação e desligamento

automático do Macintosh. Como vimos no Capítulo 03, para que a indexação programada do
Sherlock funcione, é preciso que este Painel esteja configurado para ligar o Mac no horário
determinado. Além disso, aqueles que usam o computador num escritório podem definir períodos
de descanso do equipamento, poupando energia e conservando suas máquinas.

Para Configurar o Descanso do Macintosh:

1 Selecione Apple Menu › Control
Panels › Energy Saver.

2 Na janela do Painel, clique sobre o
botão Sleep Setup.

3 Na barra deslizante, defina uma
quantidade de minutos (de 30 a 60, ou a
opção never — nunca). Após esse tempo, o
computador entra no modo de descanso.

É possível ainda marcar a caixa de seleção Shut down instead of sleeping. Ao fazer isso,
você informa ao Mac OS que, ao final dos minutos estipulados, o computador deve ser desligado.
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Para Agendar Ligações e Desligamentos Automáticos:

1 Clique no botão Schedule.

2 Marque a caixa de seleção Start up the computer, caso deseje estabelecer um dia e horário
para ligação do Macintosh.

3 No menu pop-up, selecione o dia da semana (no meu caso, eu preciso que meu Mac ligue
todas as quintas-feiras).

4 No menu drop-down, situado logo abaixo do dia da semana, digite ou selecione o horário
em que sua máquina será ligada. Minha opção é sempre às 00:55, pois o Sherlock começa a
indexar meu disco exatamente à 1h (veja o Capítulo 03).

5 Marque a caixa de seleção Shut down the computer, caso deseje estabelecer um dia e
horário para desligamento do Macintosh.

6 No menu pop-up, selecione o dia da semana (no meu caso, eu quero que isso aconteça
também nas quintas-feiras, logo após a indexação dos discos).

7 No menu drop-down, situado logo abaixo do dia da semana, digite ou selecione o horário
em que sua máquina será desligada. Minha opção é sempre às 07:00, quando o Sherlock
normalmente já terminou a atualização da indexação.

O Painel Multiple Users
O Mac OS 9 aceita até quarenta usuários por computador. O

cadastramento e definição dos níveis de acesso de cada usuário são feitos
pelo Painel Multiple Users.

Ao selecionar Apple Menu › Control Panels › Multiple Users, surge a janela Multiple Users.
À esquerda constam os nomes e figuras representando os usuários registrados no Sistema. Os
primeiro quatro botões à direita possibilitam criar novo usuário, abrir, duplicar ou deletar um
usuário existente. O botão Options serve para alterar as diversas configurações de acesso a
CDs/DVDs e informações de login. Próximo ao rodapé da janela, dois botões de rádio permitem
que você ligue ou desligue o Painel Multiple Users.
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Utilizando a Senha de Voz

O botão Options dá acesso à janela Global Multiple User Options. Marcando a caixa de
seleção Allow Alternate Password e o menu pop-up Voice Verification, é acionado o Voiceprint
Password — a senha de voz. Com essa opção ativada, a cada inicialização, ao invés da senha
digitada, o Macintosh solicita que o usuário diga uma frase previamente configurada.

O funcionamento correto desse recurso, no entanto, depende da qualidade do microfone e da
capacidade do usuário gravar a senha na mesma entonação de voz que utilizará ao “abrir” o
computador, todas as manhãs. Além disso, qualquer barulho no ambiente gera um novo registro
de som, que é percebido pelo software, resultando na rejeição da senha.

Para Gravar a Senha de Voz:
1 Na janela Global Multiple User Options, selecione a guia Login e marque a caixa de

seleção Allow Alternate Password › Menu pop-up Voice Verification. Depois, clique no botão
Save.

2 Vá até a janela Multiple Users e clique no nome do usuário cuja voz será gravada.

3 Selecione Menu File › Open (atalho z + O). Surge a janela Edit, com o nome do usuário.

4 Na janela Edit, clique no botão Create Voiceprint….

5 Surge a janela Enter Password. Após digitar sua senha, clique em OK.

6 Surge a janela Voice Setup for (nome do usuário). Note que a senha-padrão é “My voice
is my password”. Você pode deixar isso como está, gravando esta mesma senha, ou pode mudar
o texto. Para fazer a alteração, clique no botão Change Phrase… situado no canto inferior
esquerdo da janela.

7 Na caixa de texto da janela Change Phrase, digite a nova senha. Clique no botão OK.

8 Surge a primeira janela Voiceprint Setup for (nome do usuário). Clique no botão
Continue.
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9 Na segunda janela Voiceprint Setup for (nome do usuário), você verá quatro caixas de
seleção, que serão marcadas automaticamente, à medida em que forem completadas as gravações
da senha de voz. Clique no botão Record First…, no canto inferior direito da janela.

10 É acionada a primeira janela de gravação. No campo Record the phrase consta a nova
frase, definida no passo 7. Coloque-se a uma distância normal do computador. Clique no botão
Record e fale a senha. Utilize um timbre de voz normal, sem afetações. Lembre-se que você terá
de falar do mesmo modo todas as vezes em que a senha for solicitada. Ao final de sua fala, clique
no botão Stop.

Uma janela de gravação de senha de voz (no caso, a
quarta — fourth — gravação). A janela escura registra
os diversos timbres da voz do usuário. Para ouvir a
gravação, clique no botão Play.

11 Caso a gravação seja aceita, surge a segunda janela Voiceprint Setup for (nome do
usuário), com a primeira caixa de seleção marcada. Clique no botão Record Second…, no canto
inferior direito da janela e repita o procedimento até que se completem as quatro gravações.

Dica: Quando a gravação não é aceita, você recebe um aviso através de caixas de diálogo
(talvez sua voz esteja muito alta, ou as frases estão sendo ditas muito rapidamente). Corrija o
problema a tente novamente, até conseguir as quatro gravações. Esse processo às vezes é um
pouco demorado. Exercite sua paciência e perseverança.

12 Ao terminar as gravações você deve testar a senha de voz. Se a mesma não for aceita,
uma caixa de diálogo lhe dá a oportunidade de tentar novamente ou cancelar. Ao ser aceita, surge
um aviso de que sua voz foi devidamente reconhecida. Clique em OK.

Cadastrando um Novo Usuário

Para Criar um Novo Usuário:
1 Selecione Apple Menu › Control Panels › Multiple Users. Surge a janela Multiple Users.

2 Clique no botão New User. Na janela Edit “New User”, digite, nos campos User Name e
Password, o nome e senha do novo usuário.

3 Na opção Kind of User Account cadastre o tipo de conta do usuário. Você pode optar por
Normal, Limited ou Panels. Clique no botão correspondente, observando o seguinte:

" Normal. É o usuário com total acesso ao computador.

" Limited. É o usuário que usa o Macintosh com restrições de acesso a alguns
aplicativos e partes do Sistema.

" Panels. É o usuário que utiliza a máquina com pouquíssimo conhecimento do Mac
OS. Esta opção é bastante indicada para crianças, pois faz com que todos os aplicativos
e documentos disponíveis para aquele usuário sejam mostradas em grandes painéis
coloridos.
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O Desktop de um usuário Panels.
Simplicidade e segurança. Ideal para
aquele seu irmãozinho pokaprática.

4 Clique na seta Show Setup Details. Surgem quatro guias, dependendo do tipo de usuário
escolhido no passo anterior. Na Guia User Info, selecione a figura que representará o usuário,
utilizando o menu drop-down da opção User Picture. Diversas imagens estão disponíveis, mas é
possível ainda “colar” qualquer figura diretamente da área de transferência do Macintosh (você
aprendeu a “copiar” e “colar” no Capítulo 05).

5 Configure diversas informações relacionadas ao nível de acesso do usuário e feche a
janela clicando no botão de fechamento. Para alterar qualquer configuração, selecione o usuário
na Janela Multiple Users e clique no botão Open.

A Janela Edit “New User”. Defina aqui o nível de acesso dos usuários.

O Painel Keychain Access
O Keychain, também incluído a partir do Mac OS 9, é um chaveiro

que guarda todas as suas senhas — acesso a Internet, e-mails, bancos,
listas de discussão etc. Ao invés de ter tudo isso anotado em lugares
obscuros, você só precisa lembrar da senha do Keychain.

Para Criar o Seu Chaveiro:

1 Selecione Apple Menu › Control Panels › Keychain Access.

2 Uma caixa de diálogo fornece a opção de destrancar um Keychain existente ou criar um
novo. Clique no botão Create.
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3 Surge uma nova janela com três caixas de texto vazias. Na primeira delas, Keychain
Name, digite uma nome para o chaveiro. Na segunda e terceira caixas, digite a senha de acesso e
clique no botão Create.

4 É lançada a janela do Keychain, vazia, aguardando o cadastramento das senhas dos
diversos serviços. O botão à direita permite trancar o chaveiro. O melhor é deixá-lo trancado;
assim, somente você poderá abri-lo quando precisar.

Para que o Keychain funcione, é necessário que os navegadores de Web e outros programas
sejam compatíveis com ele. Enquanto escrevo este livro, somente alguns aplicativos de FTP e o
Eudora, cliente de e-mail atendem a esta exigência. E isso ainda é muito pouco. Parece que temos
de esperar algum tempo para utilizarmos todo o potencial desse recurso.

Apesar desse pequeno inconveniente, já é possível guardar suas senhas prediletas, de uma
forma menos automática que o ideal, utilizando uma dica fornecida pelo Sérgio Miranda, na
Macmania nº 71:

Para Gravar Manualmente Uma Senha no Keychain:

1 Crie um documento qualquer no Simple Text.

2 Grave o documento com o nome do serviço que você quer guardar a senha (Banco do
Brasil, por exemplo).

3 Encripte o documento (Menu File › Encrypt — no Capítulo 08 você aprendeu a encriptar
arquivos). Coloque como senha o login e a senha do serviço (por exemplo, Misael/93n59m4b).

No momento da encriptação, marque o quadro de
seleção Add to Keychain. Após a encriptação, pode
jogar o arquivo original na Lixeira.

4 A senha passa a fazer parte do Keychain. Para
acessá-la, marque-a com o mouse e clique no botão
Get Info, situado no canto inferior esquerdo da janela.

5 Na janela Get Info do Keychain, clique em
View Password. Você terá de digitar a sua senha geral,
e então lhe será mostrada a senha solicitada.
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O Painel Software Update
O Painel Software Update permite atualizar o Sistema diretamente a

partir dos servidores da Apple. Isso pode ser feito clicando no botão
Update Now (isso aciona a atualização imediata). O computador é
conectado à Internet, e os arquivos são transferidos em seguida.

O Painel Software Update. Da esquerda para a direita: Janela Principal e Janela Set Schedule…, para
automatização de atualizações do Sistema.

Outra possibilidade é configurar a atualização automática, marcando a caixa de seleção
Update software automatically. Isso faz com que sua máquina esteja “aberta” às atualizações
cada vez que você navega pela Internet.

Clicando no botão Set Schedule…, disponível somente com a opção Update software
automatically ativada, surge a janela Set Schedule, através da qual você configura datas e
horários de atualização.

Painéis e Extensões Diferentes
Como foi dito, é bem possível que sua máquina possua outros Painéis de Controle e

Extensões, diferentes dos citados acima. Fique tranqüilo. Observando alguns princípios e usando
o bom senso, você conseguirá administrar muito bem estes componentes do Sistema. Ainda nesse
capítulo você aprenderá a fazer isso criando definições, utilizando o Gerenciador de Extensões.

Os Conflitos de Extensões
Às vezes os Painéis de Controle e Extensões não se relacionam muito bem. Eles podem

competir ao mesmo tempo pela atenção do Macintosh, causando os chamados “conflitos em
recursos INIT” (Langer, 1994, p. 322). Tais conflitos geram congelamentos, mensagens de erros
ou comportamentos estranhos como distorções de imagens do monitor e outras esquisitices.

A cada nova versão de Sistema, tais problemas são reduzidos. No entanto, os
desenvolvedores de softwares são criativos o suficiente para continuamente criar novas extensões
e painéis que acabam gerando novos conflitos. No Capítulo 12 você descobrirá como lidar com
um congelamento ou queda de aplicativo decorrente desse problema.
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Trabalhando com Definições
As definições, ou sets, são conjuntos de Painéis de Controle e Extensões que você habilita

através do Extensions Manager (Gerenciador de Extensões, no OS 9 em português). Criar boas
definições é o segredo de um Mac enxuto, virtualmente imune aos conflitos de Extensões.

Uma pequena quantidade de Painéis de Controle e Extensões instalados é sinônimo de
limitação de recursos. Um Sistema “entupido” deles é um convite a problemas freqüentes
Diversas definições podem ser criadas, com o objetivo de atender a muitas finalidades.
Escritores, por exemplo, podem criar um set para produção de texto simples, uma vez que
precisam apenas dos recursos básicos de um processador de textos. Eles podem desligar, por
exemplo, todas os Painéis e Extensões relacionados a tratamento de imagens e aceleração de
vídeo. Uma máquina antiga, com pouca RAM e poder de processamento, agradecerá se for criado
um set “Textos” (nome sugestivo, não?) e responderá com maior velocidade na digitação e
impressão das preciosas obras literárias.

Alguém que gosta muito de jogos pode criar uma definição de jogos, ligando somente os
Painéis e Extensões relevantes (QuickTime, QuickDraw 3D e VR, ATI, OpenGl etc.). Isso gera
pontos na renderização e velocidade dos games.

Como criar definições? Utilizando o Painel de Controle Extensions Manager.

O Painel Extensions Manager
Para trabalhar definições,

escolha Apple Menu › Control Panels
› Extensions Manager. A janela do
Gerenciador de Extensões é aberta.

O interior da janela possui uma
série de pequenas caixas de seleção,
à frente de ícones de Painéis de
Controle e Extensões. À direita dos
ícones você encontra seus nomes,
tamanho, versão e tipo de arquivo.
As caixas de seleção marcadas

indicam quais são os Painéis e Extensões que estão ativos em cada set.

Três botões, alinhados próximos ao rodapé da janela, disponibilizam as opções de
reinicializar, reverter (marcar todos os itens) e duplicar definição. Abaixo dos botões, no canto
esquerdo, uma pequena seta possibilita mostrar (show) ou ocultar (hide) as informações dos itens
selecionados.

O menu pop-up Selected Set, logo acima na janela, permite a seleção dos sets de Painéis e
Extensões. Utilize-a para alternar entre os diversos sets disponíveis.
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Este menu sempre fornece as opções-padrão, que normalmente são Mac OS All e Mac OS
Base. O modo como essas opções são mostradas diferem, dependendo da versão do Sistema e da
máquina utilizada (no iMac, pode exemplo, você tem iMac All e iMac Base).

A opção Mac OS All habilita todos os Painéis de Controle e Extensões do Sistema, ligando
tudo o que é necessário para o funcionamento pleno de todos os recursos do Mac OS.

A opção Mac OS Base habilita somente aquilo que é fundamental para o funcionamento do
Sistema. Extensões de aceleração de vídeo (necessárias para jogos) ou mesmo de Internet serão
desabilitadas.

Criando Novas Definições
Para Criar Uma Nova Definição:
1 Abra o Painel Extensions Manager (Apple Menu › Control Panels › Extensions Manager).

2 Selecione Menu File › New Set (atalho z + N). Na caixa de texto, digite o nome da nova
definição e clique no botão OK.

3 Uma nova janela do Extensions Manager é aberta, com todas os Painéis de Controle e
Extensões ligados. Navegue pela janela, desmarque tudo o que é desnecessário no novo set e
clique no botão restart. O computador reinicializa com as novas definições.

Alterando Nomes de Definições
Além de criar dezenas de definições, é possível alterar seus nomes. No exemplo acima,

existem sets com os seguintes nomes: Internet, Primeira Alteração e Uso Geral.

Para Alterar o Nome de um Set:

1 Selecione File › Rename Set…

2 Na nova janela que surge, digite o novo nome e clique em OK.

Lembre-se que qualquer definição pode ser editada. Para fazer isso selecione-a no menu
pop-up Selected Set, no Painel Extensions Manager e altere as marcações, reinicializando o
Macintosh em seguida.
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Alguns Cuidados Necessários
Muitos usuários de Macintosh tremem quando se fala em Painéis de Controle e Extensões.

O segredo de um computador ágil e virtualmente imune a conflitos é uma administração do
Sistema sensata, equilibrada e eficiente.

Gostaria de terminar este capítulo fornecendo algumas dicas de gerenciamento que, pelo
menos no meu caso, têm sido muito úteis:

" Evite os excessos de programas instalados. Coloque no Mac aquilo que você vai
usar. Instalar todos os programas “daquele novo” CD de revista, pode gerar uma boa
dose de problemas relacionados a Painéis de Controle e Extensões.

" Cuidado com Programas em Versão Beta. Diversos desenvolvedores distribuem
versões beta de programas. Isso quer dizer que os mesmos ainda não estão
devidamente terminados e sua máquina será a “cobaia” de tais aplicativos. Se você não
é programador, espere um pouco mais e adquira a versão final, devidamente corrigida.

" Leia os arquivos “Read Me” e os Manuais de Instruções dos
Aplicativos. Tais arquivos muitas vezes contêm informações valiosas sobre
possíveis conflitos de Extensões e formas de solucioná-los. Boa leitura e
canja de galinha não fazem mal a ninguém.

" Devagar com a Lixeira. Não jogue fora Painéis de Controle e Extensões a menos que
você tenha absoluta certeza de que eles são descartáveis. Em caso de dúvida, não
ultrapasse.

" Cuidado ao Desabilitar. No Extensions Manager, evite desabilitar Painéis e
Extensões que você não conhece. Lembre-se que os documentos library, só ocupam
espaço de memória RAM quando os aplicativos de origem são lançados. Deixe-as
quietinhas lá, pelo amor de Deus.
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11
Outras Coisas Úteis

hegou o momento de compartilhar algumas dicas que eu fui aprendendo ao longo de
minha caminhada com o Macintosh. Nada grandioso ou sofisticado. Os usuários
avançados poderão até bocejar diante deste capítulo. No entanto, você, caro pokaprática,

aprenderá coisas muito úteis.

Instalando e Desinstalando Programas
Instalar software no Macintosh é fácil. Principalmente para aqueles que já sofreram tentando

fazer isso em outros sistemas operacionais. Nada de comandos complicados. Basta ler as
instruções e ir clicando com o mouse. Certos programas são instalados simplesmente copiando
suas pastas para o disco rígido e depois clicando em seus ícones. Outras vezes, após determinada
instalação, você precisará reinicializar o computador. Isso será avisado pelo instalador, que
colocará à sua disposição um botão com a opção do restart. Simples, simples. Coisas de Mac.

Exemplo de Instalação no Mac OS:

1 Selecione o ícone do instalador. No caso, o Macromedia Flash 4. Dê um duplo clique no
ícone. Isso iniciará a instalação.

2 Caso você possua o Norton ou outro programa antivirus, este emitirá um aviso,
perguntando se você deseja desativá-lo durante a instalação. Clique em OK e prossiga.

3 Na janela do instalador do aplicativo, clique no botão Continue.

4 A maioria dos instaladores mostra uma janela na qual consta o contrato de uso do
software. Você pode imprimi-lo ou salvá-lo no disco rígido. Após ler o contrato, clique no botão
Accept, caso concorde com suas cláusulas ou Decline, caso discorde dos termos. Se você
discordar do contrato, o instalador será fechado.

5 O próximo passo é configurar a instalação. Na janela de configuração, selecione o tipo de
instalação no menu pop-up situado no canto superior esquerdo. Normalmente as opções são Easy
Install, que é completa, ou Custom Install, na qual você define os itens que deseja instalar. Uma
terceira opção é a desinstalação do aplicativo. No campo Install Location consta o lugar no disco

C
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rígido onde o programa será instalado. Clicando no botão Select Folder, você pode escolher o
disco ou a pasta de destino do novo software. Com tudo devidamente acertado, clique no botão
Install.

6 A instalação é iniciada. Normalmente surge uma barra de status mostrando o andamento
do processo. Determinados programas lançam caixas de diálogo perguntando por outros detalhes,
mas isso sempre de maneira muito intuitiva.

7 Quando tudo termina, surge uma janela avisando que a instalação foi bem sucedida.
Clique no botão Quit. Se o programa exigir que o Macintosh seja reinicializado, isso significa
que algumas Extensões ou Painéis de Controle foram instalados no Sistema. Clique no botão
restart e, após o startup, passe a usar o novo software.

Ao decidir desinstalar o aplicativo, você pode optar pela desinstalação automática ou
manual.

Para Desinstalar Automaticamente um Aplicativo:

Coloque o CD de instalação. Inicie o processo e, ao chegar na tela de configuração,
selecione o opção Uninstall e clique no botão OK.

Dica: Caso a opção Uninstall não esteja disponível, tente acioná-la selecionando Easy
Install, no menu pop-up, enquanto aperta as teclas Option ou z.

Para Desinstalar Manualmente um Aplicativo:

1 Faça uma busca, utilizando o Find File ou o Sherlock, utilizando como critérios o nome do
aplicativo e seu criador (creator).

2 Jogue todos os arquivos encontrados na Lixeira.

Fotografando o Macintosh
Este livro está cheio de fotografias da Mesa ou janelas do Macintosh. Isso foi possível

porque o Mac OS providencia um recurso simples mas poderoso de captura de imagens.

" Para Capturar a Tela Inteira: Pressione as teclas z + Shift + 3.
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" Para Capturar uma Área Selecionada:. Nesse caso, o cursor muda de formato,
permitindo que você selecione a parte da imagem que deseja fotografar. Pressione as
teclas z + Shift + 4.

" Para Capturar uma Janela: Pressione as teclas z + Shift + Caps Lock + 4.

" Para Capturar a Tela Diretamente Para a Área de Transferência: Pressione z +
Shift + Control + 3.

Em todos esses casos, o Mac emite um som de clique de máquina fotográfica, indicando a
captura da imagem. Com exceção da última opção, as fotografias são automaticamente
arquivadas no disco rígido do Sistema, nomeadas como Picture 1, Picture 2 etc. e podem ser
abertas pelo Simple Text ou qualquer outro programa de edição de imagens.

Formatando o Disco Rígido
A formatação de disco é necessária em casos crônicos, quando as ferramentas de disco não

conseguem solucionar os problemas detectados (você conhecerá alguns desses problemas no
Capítulo 12).

Para Formatar o HD:
1 Faça um backup completo dos arquivos importantes. A formatação apaga todos os dados

do computador.

2 Coloque o CD do Sistema no Macintosh. Restarte a máquina (Menu Special › Restart)
apertando a tecla C. O Mac reinicia diretamente pelo CD.

3 No Cd do Sistema, localize a ferramenta de disco Drive Setup, guardada dentro da pasta
Utilities. Com um clique duplo, lance o utilitário.

4 Na janela do Drive Setup, são listados todos os discos e periféricos externos ligados ao
Mac. Selecione Menu Functions › Inicialization Options e cheque as caixas de seleção Low Level
e Zero All Data.

5 Marque o disco que deseja inicializar, clique no botão Initialize e selecione Custom Setup.

6 Defina as partições do disco — para cada uma delas, é possível configurar os formatos em
HFS ou HFS Extended — e clique em OK.

O ícone do disco rígido é apagado e surge um novo ícone, denominado Untitled. Você pode
renomeá-lo, conforme foi visto no Capítulo 02. Existem ainda algumas opções de formatação que
precisam ser bem entendidas:

" HFS ou HFS Extended: Se o Macintosh roda com um chip PowerPC, formate o
disco como HFS +. Esse último formato reduz o tamanho dos arquivos, bem como
acelera o desempenho do disco.

" Partições de Disco: Eu recomendo que você particione o HD, deixando uma pedaço
maior para o Mac OS. Isso será melhor explicado logo abaixo.

Limpar completamente o disco rígido, pelo menos semestralmente, é um bom hábito. Itens
desnecessários, esquecidos em pastas obscuras, são finalmente apagados. Você é forçado a fazer
aquele backup completo dos seus arquivos importantes, adiado há vários meses. Diversos
probleminhas simplesmente desaparecem após uma formatação de HD e sua máquina agradece
com melhoria (às vezes significativa) de performance.
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Particionando o Disco Rígido
Particionar o disco rígido é, literalmente, dividi-lo em pedaços — as chamadas partições.

Cada um desses pedaços funciona de modo virtualmente independente e pode ter um tamanho,
bem como um formato de arquivos diferente (HFS ou HFS +). Isso pode ser notado ao copiar um
arquivo de uma partição para outra. O Mac trata a mudança de endereço como uma transferência
entre unidades diferentes, exibindo a barra de status de cópia de arquivo, como se estivesse
gravando em um disco ou mídia de armazenamento externa.

A Mesa de um Macintosh, com o disco rígido particionado em 04 unidades. Ao lado, uma janela de status
indicando o andamento de uma cópia do Desktop para uma das partições de disco.

Eis algumas vantagens desse procedimento:

" Ganho de Espaço. Como o tamanho mínimo de pastas é menor em discos menores,
seu Macintosh fica com mais espaço.

" Proteção Contra Vírus. Se um vírus atacar uma partição, as outras ficam isentas da
“infecção”.

" Arquivos Protegidos. Além do backup em mídias de armazenamento externas, copie
seus arquivos nas diversas partições. Será ainda possível tentar resgatá-los intactos,
mesmo que surjam defeitos em outros pedaços do HD.

" Vários Sistemas. Instale em cada partição uma versão compacta do Mac OS, bem
como cópias de ferramentas de reparação de disco. Pode parecer neurose, mas em caso
de problemas, você poderá rodar o Norton ou outro utilitário de reparação a partir de
qualquer partição. Isso é uma mão na roda nos momentos de apertos (você lerá sobre
isso no Capítulo 12).

" Velocidade. Particionar o disco deixa o Mac mais ágil, pois as pastas são acessadas
mais rapidamente.

Personalizando o Macintosh
Através do Painel de Controle Appearance, você altera diversos itens de interface do Mac,

tais como imagens de fundo, fontes, cores de seleção, conjuntos de sons aplicados a ações,
comportamento das barras de rolagem e recolhimento das janelas. Sem abrir mão de
determinados aspectos de sua aparência — um Macintosh sempre terá “cara” de Macintosh,
lembre-se disso — o Mac OS permite, através desse recurso, uma certa personalização da
máquina.



OUTRAS COISAS ÚTEIS — 119

O Painel Appearance é composto das guias Themes, Appearance, Fonts, Desktop, Sound e
Options.

A guia Themes fornece vários temas predefinidos. Um tema é um conjunto de
especificações de fundo de Mesa, fontes, sons, funcionamento de janelas e cores de seleção. É
possível criar seu próprio padrão de aparência e salvá-lo como tema, para retornar a ele sempre
que desejar.

A guia Appearance permite a alteração de cores de menus e seleção de texto, conforme os
exemplos abaixo:

A guia Fonts é usada para selecionar as fontes do Sistema — grandes, usadas em menus e
cabeçalhos; pequenas, usadas em janelas e caixas de diálogo e Views Fonts, usadas em ícones e
itens de janelas. A caixa de seleção Smooth all fonts on screen permite ativar a suavização de
fontes para caracteres maiores que 12 pontos.

Dica: Deixe sempre marcada a suavização de fontes. Isso melhora a visualização dos textos
– principalmente em janelas de processadores de texto e programas de editoração e desenho –
eliminando serrilhados.

Através da Guia Desktop, você altera os
fundos de Mesa utilizando imagens (em formato
PICT ou GIF) ou fotografias (em formato JPEG).

Para Alterar as Imagens do Desktop:

1 Selecione Apple Menu › Control Panels ›
Appearance › Guia Desktop.

2 Utilizando o mouse ou as teclas de
navegação, escolha a imagem no menu Patterns.

3 Clique no botão Set Desktop.
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Para Colocar uma Fotografia no Desktop:

1 Selecione Apple Menu › Control Panels › Appearance › Guia Desktop.

2 Clique no botão Place Picture.

3 Utilizando o mouse ou as teclas de navegação, selecione, na janela Open, a fotografia
desejada, que estará dentro de uma das várias pastas temáticas sugeridas pelo Mac OS (plantas,
paisagens, objetos etc.). Clique no botão Open.

4 A foto aparece numa miniatura da Mesa, no canto esquerdo da janela. Configure o modo
como você deseja posicioná-la: Position Automatically (a mais indicada), Fill Screen (tela cheia,
mesmo que seja alterado o tamanho original), Scale to Screen (preenche todo o espaço horizontal,
alterando o tamanho original), Center on Screen (foto centralizada, preservando o tamanho
original) e Tile on Screen (imagens lado a lado).

5 Clique no botão Set Desktop. Observe que, para remover a foto, é só clicar no botão
Remove Picture.

Dica: Para obter mais fotos e imagens para a Mesa, copie para o disco rígido a pasta
Additional Desktop Pictures, que se encontra na pasta Apple Extras, do CD de Sistema do Mac.

A guia Sound serve para selecionar sets de sons que acompanham diversas ações do
Macintosh, tais como abertura de menus, movimentos em janelas e ações no Finder. Como
padrão, o Mac OS fornece apenas um conjunto de sons — Platinum Sounds. Mas você pode
encontrar outros sets no site Mac OS Themes (http://themes.hellyeah.com). Para torná-los
acessíveis, guarde-os na pasta Sound Sets, localizada em System Folder › Appearance.

A guia Options habilita as barras de rolagem proporcionais e o recolhimento de janelas com
um clique duplo.

O Shareware Kaleidoscope
Com a chegada do Mac OS X, a interface do Macintosh será radicalmente alterada.

Usuários das versões 8 e 9, no entanto, podem personalizar suas máquinas com temas inovadores,
utilizando o Kaleidoscope, um shareware encontrado na Internet (http://www.kaleidoscope.net/).
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O Kaleidoscope, a partir de sua versão 2.2.2, tem se mostrado bastante estável, podendo ser
utilizado sem medo — se bem que vale a lei do bom senso: em caso de travamentos, não custa
nada, antes de qualquer outra coisa, desabilitar o Painel de Controle e a Extensão do
Kaleidoscope, para ver se o problema é resolvido.

Exemplos de temas do Kaleidoscope: Mudanças incríveis no Desktop, para felicidade dos maqueiros
radicais.

Usuários do Mac OS 8 personalizam imagens e fotografias
utilizando os Painéis de Controle Appearance e Desktop Pictures, que
oferecem recursos semelhantes aos explicados acima, com exceção da
suavização de fontes e das barras de rolagem proporcionais. A partir da
versão 8.5, a Apple passou a implementar tais funções num único Painel.

Reconstruindo o Desktop
Cada volume de disco ou mídia externa possui dois arquivos invisíveis, o Desktop DB e o

Desktop DF — chamados unicamente de Desktop ou Mesa, que são usados pelo Finder para
guardar informações dos arquivos, como por exemplo, seus ícones.

À medida em que você cria ou joga algo na Lixeira, o Desktop vai perdendo a sua
eficiência, gerando lentidão e falhas de desempenho. Um defeito comum é a perda dos registros
dos ícones originais de documentos e aplicativos. Ao ligar o Macintosh, os itens são mostrados
tal como o exemplo abaixo.

Para evitar esse problema é necessário reconstruir periodicamente o Desktop (eu faço isso a
cada mês), uma tarefa que além de simples, não exige muito tempo.

Para Reconstruir o Desktop:

1 Inicialize o Mac segurando as teclas Option e z.

2. Surge uma caixa de diálogo perguntando se você deseja reconstruir o Desktop do disco.
Clique em OK.

3 Uma janela de status mostra o andamento da reconstrução. No final da reconstrução a
Mesa estará novinha em folha. Os ícones ressurgirão todos em seus devidos lugares e as tarefas
do Finder serão realizadas com maior rapidez.

Esse recurso deve também ser utilizado em discos de armazenamento. Além dos benefícios
citados acima, ao reconstruir o Desktop de disquetes e outras mídias, você ganha espaço.

88Mac OS
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Usuários de máquinas com drives de disquete ficam felizes ao ganhar alguns kilobytes a mais
para guardar seus tesouros digitais.

Para reconstruir o Desktop de discos de armazenamento, insira-os no drive e, enquanto são
inicializados, segure as teclas Option e z.

Se após a reconstrução o problema persistir, será necessário jogar fora o arquivo Desktop
DB. Para fazer isso, faça uma busca utilizando o Find File (Mac OS 8) ou o Sherlock (Mac OS
8.5 e 9), definindo como critério “arquivos invisíveis” (Advanced Options › is invisible).

O arquivo Desktop DB deve ser arrastado para a Lixeira e depois o Macintosh precisa ser
reinicializado por duas vezes. Um novo Desktop DB é criado após a segunda reinicialização.
Tome cuidado: Esvazie a Lixeira somente após a criação do novo arquivo.

Lançamentos Automáticos
As pastas Startup Items e Shutdown Items, localizadas no System Folder, são utilizadas para

o lançamento automático de aplicativos, documentos ou sons.

Arraste para a pasta Startup Items as réplicas de sons, documentos ou aplicativos que você
deseja que sejam lançados na inicialização. Se em alguma situação você quiser desabilitar os
itens desta pasta, segure a tecla Shift logo após o início do carregamento das extensões.

Arraste para a pasta Shutdown Items as réplicas de sons, documentos ou aplicativos que
você deseja que sejam lançados no momento do desligamento do Macintosh.
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12
Alguns Problemas e Soluções

eria muito bom se o mundo dos computadores fosse perfeito. No entanto, mesmo um
Macintosh, desenvolvido a partir de tecnologias apuradas, apresenta falhas de
funcionamento. Defeitos de hardware (equipamento) e software (programas) perturbam a

vida dos usuários de qualquer plataforma ou sistema operacional. A diferença é que, no Mac, essa
perturbação é menor.

Alguns problemas só são solucionados com a troca de componentes. Quem tem uma
máquina há muitos anos precisa preparar-se para, inevitavelmente, investir alguns recursos, por
exemplo, em um novo disco rígido. Como disse o sábio Salomão, “tudo é vaidade”, nada é
eterno.

Mas você não precisa levar seu computador à assistência autorizada, ou solicitar uma visita
de um técnico, a cada momento em que surge algum defeito. Felizmente, na maioria das
situações, tudo pode ser resolvido pelo próprio usuário — com calma, conhecimento de algumas
dicas e a ajuda de “São Steve Jobs”. Neste capítulo, você vai conhecer alguns desses problemas e
suas possíveis soluções.

Consertando Réplicas
Como vimos no Capítulo 01, as réplicas são atalhos que levam rapidamente o usuário aos

arquivos originais. Quando estes últimos são movidos para outro lugar do disco rígido, as
réplicas ficam danificadas. Ao clicar sobre elas, surge uma caixa de diálogo informando que os
itens não puderam ser encontrados. Clicando no botão OK, a tarefa é cancelada. Caso você deseje
apagar a réplica, clique no botão Delete Alias.

Para Consertar Réplicas:

1 Após receber a mensagem de erro, na caixa de diálogo, clique no botão Fix Alias…

2 É aberta uma janela de Open/Save, possibilitando a navegação no disco rígido. Localize o
arquivo em seu novo endereço e clique no botão Choose.

S
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Erros de Aplicativos
Você está digitando aquele seu maravilhoso trabalho de química, quando o processador de

textos simplesmente some da tela. Sem mais nem menos. Depois surge uma caixa de diálogo
informando que o programa fechou inexplicavelmente (grande novidade!), devendo restartar o
Mac em seguida.

A causa dessa tragédia pode ser estrangulamento de memória, corrupção dos arquivos de
preferências, conflito de extensões ou danificação do aplicativo.

Mais Memória, Por Favor!
A primeira coisa a fazer, depois de restartar o Macintosh, é alocar mais memória para o

programa. Siga as instruções do Capítulo 04, seção “Personalizando a Memória dos Programas”.
Na maioria das vezes, isso normaliza a situação.

Preferências Corrompidas
Se após a alocação de memória a dificuldade persiste, verifique os arquivos de preferências

do aplicativo:

Para Substituir os Arquivos de Preferências:

1 Crie uma nova pasta na Mesa. Se quiser, dê a ela o nome “Teste de Preferências”.

2 Vá até a pasta Preferences, no System Folder e localize as preferências do programa
desejado, arrastando-as para a pasta recém-criada no Desktop e reinicializando o Macintosh.

3 Após a reinicialização, lance o aplicativo. Se tudo funcionar bem, você pode jogar a pasta
“Teste de Preferências” na Lixeira. Se o problema continuar, retorne as preferências antigas para
o System Folder e passe para a etapa seguinte.

Verifique Se Há Conflitos de Extensões
No Capítulo 10 eu expliquei rapidamente o que são os conflitos de Extensões. Se um

aplicativo insiste em fechar inesperadamente mesmo depois dos passos anteriores, tente corrigir o
problema criando uma nova definição (set) de Painéis de Controle e Extensões.

Para Criar Uma Nova Definição:

1 Selecione Apple Menu › Control Panels › Extensions Manager.

2 Na janela do Extensions Manager selecione, no menu pop-up Selected Set, Mac OS All ou
Mac OS Base.

3 Escolha Menu File › Duplicate Set. Na caixa de texto Name duplicate set, digite o nome
da nova definição e clique no botão OK.
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4 No interior da janela do Extensions Manager, habilite as Extensões e Painéis necessários
ao funcionamento do programa que está com problemas e clique no botão Restart.

5 Após o startup, teste novamente o aplicativo. Ele deverá funcionar sem apresentar novas
quedas. Agora o Mac tem uma definição de Extensões e Painéis específica para aquele seu
utilitário, que pode ser mantida como set independente.

A questão é que dificilmente alguém trabalha com um software isolado dos outros.
Enquanto escrevo este capítulo, por exemplo, mantenho ligados um processador de textos, um
dicionário eletrônico, um programa avançado de captura de telas, dois editores de imagens e as
ferramentas de busca e navegação na Internet. Isso quer dizer que todos os Painéis de Controle e
Extensões referentes a tais aplicativos devem estar ativados no Extensions Manager.

6 Defina quais os programas básicos que você precisa utilizar, habilite suas Extensões e
reinicialize o computador. Se o problema voltar a aparecer, você saberá qual o Painel ou
Extensão que está gerando o conflito.

O Quê Fazer Com Painéis e Extensões Conflitantes

Você descobriu, por exemplo, que as Extensões do seu processador de textos favorito não
trabalham bem com as Extensões e Painéis do software de captura de tela. O quê fazer? Veja
algumas possibilidades:

" Leia os arquivos Help ou Read Me dos aplicativos. Às vezes eles já prevêem tais
conflitos e oferecem soluções.

" Instale updates dos softwares. Essas atualizações normalmente poder ser baixadas pela
Internet.

" Reinstale os programas (é possível que algum Painel ou Extensão de um aplicativo
esteja danificado).

" Retire os programas que não sejam prioritários. Essa é uma decisão difícil, que exige
certa maturidade. Mas você entenderá que muitas vezes é necessário desinstalar aquele
seu maravilhoso protetor de telas com imagens da Gisele Bündchen, para devolver
estabilidade ao Macintosh.

A última opção é a mais radical, mas você pode ficar tranquilo: em quase cinco anos de uso
do Mac, nunca vi incompatibilidade irreparável entre programas essenciais. Os problemas mais
sérios acontecem, na maioria das vezes, com sharewares descartáveis, principalmente utilitários
relacionados a mudança de interface ou descansos de tela.

Identifique os Painéis e Extensões Utilizando Cores

Os conflitos de Extensões acontecem, muitas vezes, após a instalação de um novo
programa. Uma maneira prática de detectar Extensões e Painéis problemáticos é organizando-os
por cores, utilizando o recurso de Labels (Menu File do Finder).

Para Organizar Extensões e Painéis Por Cores:

1 Antes de qualquer instalação, dê uma cor específica a todos os itens das pastas Control
Panels e Extensions. Você pode designar uma cor com um nome sugestivo, tal como “Extensões
Antigas”. Veja como fazer isso no Capítulo 04, seção “Organizando Objetos Por Cores”.

2 Instale o novo software. No caso do exemplo abaixo, eu instalei o Norton AntiVirus.

3 Abra as pastas Extensions e Control Panels. Veja que o instalador colocou uma nova
Extensão, denominada “Norton AntiVirus Auto-Protect”. Eu posso identificá-la facilmente, pois
é a única na pasta que não está pintada de vermelho.
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Note que somente a Extensão Norton AntiVirus Auto-Protect aparece em uma cor diferente. Usando cores,
fica fácil detectar Extensões e Painéis recentemente instalados e possivelmente causadores de problemas
no Sistema.

O resultado prático desse procedimento é que eu posso testar o programa, verificando se o
mesmo não gera congelamentos ou outros comportamentos estranhos. Caso surja algum defeito,
eu já saberei sua possível origem.

Aplicativos Defeituosos
Se o problema persiste mesmo após a checagem nos Painéis e Extensões, tente reinstalar o

aplicativo. Se não adiantar, procure o suporte técnico oferecido pelo fabricante (essa é uma das
inúmeras vantagens de adquirir software registrado) ou entre em contato com a Apple Brasil,
através do serviço Apple Line — fones (0—11) 5503-0090 ou 0800-1-27753.

Congelamentos de Tela
Talvez uma das coisas mais frustrantes que pode acontecer com o usuário do Mac OS seja

um congelamento de tela (para quem utilizou o Sistema 7, eram as horripilantes mensagens de
bombas). Você está no meio daquela tarefa urgentíssima quando o computador trava e os ícones
do reloginho ou do círculo ficam imóveis.

Nesse caso, todo o Sistema está paralisado e isso pode acontecer em diversos níveis.
Existem soluções diferentes, aplicadas dependendo do grau da complicação.

Cancele a Tarefa
" Cancele o serviço pressionando as teclas z + “.” (ponto).

" Se não funcionar, tente pressionar a tecla Esc.

" Se não funcionar, tente um Quit forçado, pressionando simultaneamente as teclas z +
Option + Esc.

Ao atender a qualquer desses comandos, o Mac fecha o programa problemático e retorna
para o Finder. É bom reinicializar o computador antes de voltar a utilizar qualquer outro
aplicativo.

Force a Reinicialização
Quando o computador não aceita os comandos de cancelamento da tarefa, o jeito é forçar

um restart. Isso pode ser feito de diversas maneiras, dependendo do equipamento utilizado.

" Macs Bege: Pressione as teclas z + Control + Power.

" iMacs Revision “A”: Enfie um clipe no buraquinho lateral da máquina.
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" iMacs Revision “B” e “C”: Aperte o botão Power, na frente do gabinete.

" iBooks: Aceitam o restart forçado através das teclas z + Control + Power. É possível
ainda utilizar o buraquinho que fica na lateral direita, perto da alça. Esse último
recurso, porém, retorna a data da máquina para 1904, exigindo uma reconfiguração do
Painel Date & Time.

" PowerBooks: Aperte os botões z + Option + Control + Power.

Se nenhum dos comandos acima funcionar, como diz o mineiro, “o trem está feio”. Retire o
Macintosh da tomada e, depois de pelo menos trinta segundos, ligue-o novamente.

Antes da reinicialização, o Sistema (a partir da versão 8.5) aciona automaticamente o reparo
de disco. O melhor é aguardar até que a tarefa seja completada. Uma boa coisa a fazer depois é
reconstruir o Desktop, para corrigir quaisquer problemas que porventura existam nos arquivos
invisíveis da Mesa (você viu com  o fazer isso no Capítulo 11).

Desligue os Painéis de Controle e Extensões
Se após o restart forçado o Mac volta a congelar, possivelmente você está às voltas com um

conflito de Extensões. É necessário reinicializar o computador com os Painéis e Extensões
desligados.

Para Desligar os Painéis e Extensões:

1 Reinicialize o Mac apertando a tecla Shift até surgir a mensagem Extensions Off, na
janela de boas vindas.

2 Vá ao Painel Extensions Manager e ative as Extensões necessárias, conforme explicado na
seção “Conflitos de Extensões”, neste mesmo capítulo, bem como no Capítulo 10.

Outra opção interessante é pressionar a barra de espaço durante o startup. Isso lança o
Extensions Manager e você pode ir ligando e desligando as extensões desejadas antes do Mac
inicializar.

Zapeie a PRAM
Tudo foi tentado e o problema continua enchendo a sua paciência? Antes de pensar em pular

da janela ou incendiar o quarto, zapeie a PRAM. A PRAM, ou Parameter Random Access
Memory é uma memória de acesso aleatório que armazena diversas informações básicas do
Macintosh tais como configurações do Chooser, preferências de data e hora, mouse, som
memória RAM etc.

Algumas vezes, estas configurações poluem a PRAM, gerando comportamentos estranhos,
lentidão ou congelamentos. Para fazer as coisas “voltarem ao normal”, reinicialize a máquina
apertando simultaneamente as teclas z + Option + P + R até ouvir por duas vezes o som do
startup. Esse procedimento é chamado de Zap na PRAM (pronuncia-se zap na pi-rã) e apaga
todos os dados da PRAM, exigindo que depois você reconfigure os Painéis de Controle General
Controls, Date & Time, Monitors & Sound, Energy Saver e Memory.

Use Um Reparador de Discos
O problema persiste? Vá até a pasta Utilities e localize o Disk First Aid (ele já foi usado

anteriormente, quando você deu o restart forçado, mas vale a pena lançá-lo outra vez).

Clique duas vezes no ícone do utilitário para acioná-lo. É possível encontrar
defeitos em partes do disco rígido que exigem consertos urgentes.

Mesmo depois disso, é recomendável checar o HD com um outro programa
de reparo de discos. Existem diversas opções no mercado, mas o único que oferece suporte
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técnico no Brasil, pelo menos até o momento em que escrevo este livro, é o Norton Utilities, da
Symantec.

Lance o Norton Disk Doctor e solicite o exame e conserto do disco. À medida em que ele
encontra defeitos, vai mostrando janelas de diálogo, perguntando se você deseja fazer as
reparações. Clique nos botões Fix ou Fix All até o final da tarefa.

Se o problema do Macintosh estiver sério ao ponto de ele não aceitar nem mesmo a
inicialização, será necessário rodar o Disk First Aid ou o Norton a partir de seus respectivos CDs.
Para fazer isso, coloque o CD no drive e restart o Mac segurando a tecla “C”.

Tente novamente utilizar o computador. Não funcionou? A opção que resta é reinstalar o
Sistema.

Reinstale o Mac OS
Eis o último recurso. O próprio Finder pode estar com defeito (isso é muito raro, mas

acontece). Nesse caso, reinstale o Mac OS, tomando o cuidado de solicitar uma Instalação Limpa
(Clean Install) — essa opção gera um novo System Folder.

Se for possível, formate o HD antes de gravar o novo Sistema — para isso você, como bom
macmaníaco, deve ter um backup completo dos arquivos importantes.

Leve o Macintosh a Uma Assistência Autorizada
Se todos os procedimentos acima são frustrados, leve sua máquina a uma assistência técnica

autorizada. E torça para a despesa ser pequena.

Leia os Manuais
Os manuais que acompanham seu computador e outros periféricos possuem seções

relatando erros e possíveis soluções. Leia essas informações. Elas serão preciosas nos momentos
de apertos.
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13
Breve Vocabulário

 objetivo deste último capítulo é fornecer uma lista de termos comumente utilizados em
informática. É claro que você não precisa memorizar todos eles. No entanto, conhecê-los
pode ser útil para a compreensão de certos assuntos relacionados ao Macintosh. Sem falar

que seus amigos ficarão muito impressionados.

Lista de Termos Relevantes
ADB. Apple Desktop Bus, o padrão de conexão do teclado dos Macs bege.

Alias. Atalho para localização rápida de arquivos de aplicativos, pastas e documentos. O mesmo
que réplica, no sistema em português.

BinHex. Padrão de conversão dos arquivos do Macintosh para transmissão pela Internet.

Bit. Unidade mínima de informação em um Sistema Operacional.

BMP. Formato de imagem padrão do Windows.

Bookmark. Uma lista de endereços de sites preferidos, no Netscape Communicator.

Browser. Programa que permite a navegação pelos sites da Internet.

Byte. Unidade de informação correspondente a 8 bits.

Cache. Memória temporária que permite o acesso rápido a informações.

Cliente de e-mail. Programa utilizado para receber e enviar correio eletrônico pela Internet.

Control Panels. Programas que permitem a execução e configuração de diversas tarefas no
Macintosh.

Desktop. Mesa de trabalho do Macintosh. Leia mais sobre ela no Capítulo 02.

Download. A transferência, através da Internet, de arquivos de uma unidade remota para o seu
computador.

DRAM. Dynamic Random Access Memory. Um tipo de memória RAM, aceita por alguns
modelos de Macs.

Drive. Aparelho que lê e escreve informações em discos ou CDs.

Driver. Software que controla periféricos ligados ao computador (impressoras, scanners etc.).

Extensions (Extensões). Programas que permitem a execução de diversas tarefas em aplicativos
e no Sistema.

Favorites. Uma lista de endereços de sites preferidos, no Internet Explorer.

Finder. O coração do Mac OS, responsável pelo funcionamento da maioria das tarefas do
Macintosh.

Fontes. Conjunto de caracteres tipográficos — os tipos de letras instalados no computador.

Freeware. Programa utilitário desenvolvido por alguém que ama computação, distribuído
gratuitamente através da Internet.

Gabinete. Compartimento onde são alojadas a placa-mãe, o modem, os drives e as diversas
portas do computador.

O
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Gigabyte (GB). Unidade de medida de informação, correspondente a 1.073.741.824 bytes.

Hardware. A parte física do computador, normalmente composta de gabinete, monitor, teclado e
mouse.

HFS +. Hierarchical File System Extended. Sistema de arquivos do Macintosh que otimiza o
desempenho da máquina e economiza espaço no disco rígido.

Hipertexto. Forma de apresentação de informações que possibilita a navegação rápida entre
páginas e documentos diferentes, através de ligações (links). É o sistema usado na WWW (World
Wide Web).

HTML. HyperText Markup Language, linguagem de marcação usada para escrever sites para a
Internet, que permite o uso de imagens, hipermídia e navegação através de hipertexto.

Internet. Rede mundial de computadores.

Linux. Sistema Operacional multitarefa aberto, desenvolvido por Linus Torvald, baseado no
UNIX. Atualmente, um sério concorrente para o Windows da Microsoft.

Login. Abertura de sessão num sistema protegido, que normalmente envolve a digitação do nome
e senha do usuário.

Kilobyte. Unidade de informação, simbolizada pelas letras KB, correspondente a 1024 bytes.

MacBinary. Formato de transferência de arquivos Mac pela Internet.

Mac OS. Macintosh Operational System. O nosso, o único, o melhor…

Megabyte (MB). Unidade de medida de informação, correspondente a 1.048.576 bytes.

Memória. A quantidade de RAM instalada no computador ou o espaço total existente no disco
rígido para gravação de arquivos.

Memória Virtual. Um recurso enganador do Sistema, através do qual um pedaço do disco rígido
é usado como memória RAM.

Mesa. Veja Desktop.

Modem. Modulador demodulador, aparelho que permite a comunicação e troca de arquivos
através de linha telefônica.

Navegador. Veja Browser.

OCR. Optical Character Recognition. Tecnologia que permite que um programa transforme um
documento escaneado em documento de texto.

Painéis de Controle. Veja Control Panels.

Password. Senha de acesso.

PC. Tudo quanto é computador que não seja Mac — para azar de seus usuários.

PDF. Formato híbrido de arquivo, criado pela Adobe, para leitura, pesquisa e impressão de
documentos. Documentos em formato PDF podem ser lidos em qualquer computador, de
qualquer plataforma, utilizando-se o aplicativo Acrobat Reader, distribuído gratuitamente pela
Adobe.

PICT. Padrão de imagens do Mac OS.

Pixel. Picture Elements”, é a menor unidade gráfica de uma imagem. Nos monitores de
computadores, quanto mais pixels, maior é a resolução.

Placa-mãe. Parte do computador onde estão alojados os slots de memória, processador etc.

POP. Post Office Protocol (protocolo da agência de correio); endereço no servidor onde as
mensagens ficam armazenadas, até serem acessadas pelos usuários de e-mails.
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Porta. Os pontos de acesso externo ao Macintosh através de cabos ou plugs macho e fêmea.

PRAM. Parameter Random Access Memory. Memória aleatória usada para armazenar dados de
configurações de alguns Painéis e da memória RAM do Macintosh.

Processador. “Chip que interpreta as instruções do software e interpreta outros componentes do
computador” (Langer, 1994, p. 352). No Macintosh  são utilizados, basicamente, os seguintes
tipos de processadores: 68K, substituídos em meados nos anos 90 pelos novos PowerPC. Power
PC, utilizados até alguns dos últimos modelos de Macs bege. G3, usados nos últimos modelos
bege e nos novíssimos iMacs, iBooks e PowerBooks. G4, instalados nos computadores de
gabinetes translúcidos em formato de torre.

Programa. Produto escrito em linguagem de programação, destinado a auxiliar na realização de
tarefas em computadores tais como processamento de textos, planilhas eletrônicas, editoração de
imagens etc.

RAM. Random Access Memory. Memória utilizada pelo computador para rodar o Sistema e
outros aplicativos.

Réplica. Veja Alias.

Restart. Comando que faz com que o Macintosh seja desligado e ligado novamente, limpando
toda a memória RAM.

Shareware. Programa utilitário criado por um pequeno desenvolvedor, distribuído pela Internet a
um preço acessível.

Site. Local onde são encontradas páginas de HTML na Internet.

Slot. Local dentro do gabinete do computador, para encaixe de memória ou outros acessórios.

SMTP. Simple Mail Transfer Protocol; protocolo usado para enviar mensagens de correio
eletrônico.

Software. Veja Programa.

UNIX. Sistema Operacional multitarefa, muito utilizado em aplicações gráficas e ambientes de
rede (servidores de Internet).

Upload. O envio de arquivos do seu computador a outra estação remota.

URL. Uniform Resource Locator. O endereço dos sites da Internet.

USB. Padrão de conexão do teclado e outros periféricos dos novos computadores Macintosh.

Utilitário. Programa criado para melhorar o modo como o Macintosh trabalha.

Vírus. Programa criado por alguém que passa a noite pensando em como atormentar a vida dos
outros. Os vírus penetram em sistemas operacionais e podem destruir todos os dados.

Volume. Nome dados a discos rígidos e outras mídias de armazenamento.

WWW. World Wide Web. A parte da Internet onde encontramos sites construídos com
hipertexto e hipermídia.

ZIP. Formato de compressão muito utilizado pelos usuários Windows.
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